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Shana Corporation has made every effort to make Informed Designer as easy and s
forward to use as possible. However, there are times when a feature or function doe
seem to perform as it is meant to. Don’t despair! Technical Support is available.

If you have not already faxed, e-mailed, or mailed your registration form to us, please
the following information ready (or include it with your fax/e-mail) when you contact 
Technical Support for the first time:

■   full name

■   company name (if there is one)

■   full address, including office/apt. number, street, city, state/province, country,  and
postal code

■   phone and fax numbers

■   e-mail address (if available)

Also, whenever contacting Technical Support, please make sure you have (or includ
following information about your computer and software:

■   serial number of the Informed product you are using (this can always be found b
selecting the ‘About Informed Designer…’ command under the Help (Windows) o
Apple (Mac OS) menu when the application is the active

■   type and version of the operating system your computer is using (Win95, Win3.1
Macintosh System 7.5, and so on)

■   type and version of computer you are using (486-100, Macintosh Quadra 610, an
on)

Note Please note that technical support is available only to registered users of Informed
software.
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■   a clear and concise understanding of the problem you are having. Nothing is harder to dia
and fix than a question like “ My form doesn’t look right!.” Please have all of the details of y
question understood, such as the commands you are using and the desired task that you
seeking to accomplish. If possible, please be sitting in front of your computer so that the 
port technician can talk you through the solution.

Before you phone Shana Corporation’s Support Team…

RTM (Read The Manuals)

We know that at times it is a chore to pour through the documentation, trying to understand s
thing that is relevant to your needs, but most of the time, the answer you need is in the manu
sure you are consulting the correct manuals for the application you are using.

Check the indices to see if you are looking in all the right places. If you still can’t find the ans
you are looking for...

Check our Home Page on the Internet

We are constantly upgrading and adding to our web-based technical support services. Point 
browser (URL) location to http://www.shana.com and click on the section marked “Technical 
Support.” Here you will find many sub-sections covering things like functions and calculations
mail enabling, tips and tricks, and many examples of how to set up common forms and settin
well, there are many forms and examples you can download and try out yourself.

Send us an E-mail

You can e-mail us directly at support@shana.com. Upon receipt of your e-mail support question
we will reply with a message indicating the support technician assigned to your question, as w
a Support Call Number, which you can use to reference your call in the future. The amount o
it will take our support technicians to satisfactorily answer your question will vary with the num
of calls in progress at any one time, so please be patient with us if it seems to be taking a lon
to get back to you. If your question concerns a particular form you are working on, please inc
the form as an attachment or enclosure to your e-mail message. This will allow us to actually
to your form as we are working on the problem. Please note that all forms/information receiv
support is automatically considered private and confidential. 

Fax us Your Form and Question

You can fax us your form and associated question any time of the day or night at (403) 437- 4381. 
Please make sure to indicate on your fax that it is intended for Technical Support. Again, you
be contacted on receipt of your fax by either phone or fax, with an indication of the Support Te
cian assigned to your question, as well as a Support Call Number. Again, please note that al
information received by support is automatically considered private and confidential.
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Mail (or Courier) us your Form/Problem

Yes, we still do receive snail-mail. If you have no other means of contacting us, please feel fr
drop us a letter. Please mail to:

Shana Corporation
Technical Support
9744-45th Avenue
Edmonton, AB  Canada
T6E 5C5

Please include all the pertinent information about your computer, operating system, and soft
involved. If your question or problem relates to a specific form you have created, please be s
include the form on a diskette.

Phone Us!

Picking up the phone and actually calling us is the most expensive means (both in terms of t
phone call itself and the support credits required) of contacting Technical Support. We encou
you to try and use one or all of the above methods before you place a phone call to us. Tech
support can be reached at (403) 433-3690, ext. 242. Technical Support is available during the hour
of 8:30 am - 5:00 pm, Monday to Friday, Mountain Standard Time. Before you call us, please 
sure you have registered your software by one of the above methods.

If the lines are busy when you call,  please leave us a message on our voice mail system, wi
serial number, return phone number, and a brief description of the problem. We will call you b
ASAP. Calls will be returned in the order in which they are received.

Support Credits Policy

1. Technical support for Informed products is available to registered users only.

2. Registration of an Informed product entitles you to a specified number of free Informed S
port Credits.Please refer to your Informed Licence Certificate for details on credits includ
with every Informed product.

3. Support credits can be purchased from Shana Corporation at 1-800-386-7244. 

4. Informed Support Credits are permanently linked to a registered serial number.

Note We can only return support calls in North America. For those of you living, working, and usi
Informed Designer outside of North America, if you cannot reach our support staff immedi-
ately, please try one of the other means of reaching us noted above. For the purposes of t
document, North America is defined as Canada and the US, including Alaska and Hawaii.
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5. Informed Support Credits will NOT be used when you call:

- about known problems inherent in the software
- to tell us about a reproducible bug (if it really is a bug)
- to replace bad disks (hey, it happens)

6. Support Credits are applied to Tech Support Inquiries as follows:

1 Credit - E-mail, Fax, Postal Mail
2 Credits - Phone calls

Terms & Conditions

Below is a summary of the terms and conditions which govern technical support services for
Informed products.

1. Technical Support for Informed products will be provided as described in this document.

2. Access to Technical Support for Informed products is limited to registered users of Inform
products only.

3. Informed Technical Support Credits supplied free with Informed products have no redeem
cash value.

4. Purchased Informed Technical Support Credits are valid for two (2) years from date of p
chase. Credits cannot be refunded or exchanged at any time.

5. Informed Technical Support Credits are not transferable by you to anyone.

6. All prices and other terms and conditions contained in this document are subject to chan
Shana Corporation without notice at any time prior to your purchasing additional Informe
Technical Support Credits.

7. Access to Informed Technical Support using additional credits shall start when your paym
for the credits is received by Shana Corporation.

8. Your access to Informed Technical Support shall terminate in the event that you transfer
Informed product(s), or the end user license included with your Informed product(s) is ot
wise terminated. Your access to Informed Technical Support may also be terminated at S
Corporation’s discretion whereby your sole and exclusive remedy shall be to receive a re
for your purchased unused Informed Technical Support Credits which have not yet expire
other Informed Technical Support Credits are not redeemable for cash.

9. Shana Corporation shall use reasonable commercial efforts to provide technical support
professional manner, but cannot guarantee that every question raised by you will be reso
Nothing in this document shall be construed as expanding or adding to the warranty for y
Informed product contained in the end user license agreement included with your Inform
product(s). Except for this express limited warranty, Shana Corporation makes and you re
no warranties or conditions of any kind, express, implied or statutory, related to or arising
any way out of the provision of Informed Technical Support, and Shana Corporation spec
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cally disclaims any implied warranty of merchantability, fitness for a particular purpose an
noninfringement of third parties.

10. Shana Corporation’s liability relating to the provision of Informed Technical Support is lim
to the amounts paid by you for the services ordered by you. In no event shall Shana Cor
tion have any liability for any special, indirect, or consequential damages including, witho
limitation, damages for lost profits, loss of data, or interruption of business, arising in any
out of the provision of Informed Technical Support under any theory of liability, whether or
Shana Corporation has been advised of the possibility of such damages.

For even more help with Informed…

Training on Informed products

Shana Corporation also offers training on Informed products through Russ Associates, the O
Informed Trainer. Further information can be obtained by contacting Russ Associates at:

Russ Associates
1016 Kirkcrest Lane,
Alamo, CA
94507

Phone: (510) 820-7967
Fax: (510) 820-2288
Internet: training@shana.com
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Introduction

         
In this chapter:

■   Informed Designer   I-2

■   The Informed Designer Manual Set   I-2

■   About This Manual   I-3

■   Conventions Used in This Manual   I-4
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Introduction
With the advancement of computer technology and forms software, electronic forms offer an
cient, intelligent, and secure alternative to the traditional paper based forms systems used in
organizations. Shana Corporation offers a complete cross-platform electronic forms solution 
each step in the paper forms process—from the design stage to “fill, sign, and send.” 

Informed Designer and Informed Filler together provide everything you need to design, distri
fill, route, approve, submit, and track electronic forms.

Informed Designer
Informed Designer gives you flexible tools to draw professional quality forms quickly and eas
With advanced drawing tools, powerful graphics manipulation commands, and precision con
you have all you need to produce appealing, picture perfect forms on your computer. Since f
are stored electronically, you now have more freedom to change your forms as your needs c
It’s as simple as “point and click” to move a line or change a heading.

If you want to design paper forms to be filled out by hand or with a typewriter, then Informed 
Designer is all you need. You can design forms for in-house printing, or you can prepare cam
ready artwork for your commercial printer.

When you’re ready to move from paper forms to an electronic forms solution, Informed Desig
provides all the features you need to design intelligent form templates, ready to be filled out 
tronically with Informed Filler. Use Informed Designer’s powerful tools and functions to make
your forms automatically calculate, format, lookup, and check information for the person usin
Informed Filler. You can also configure forms for electronic signing by using digital signatures

Although Informed Filler is required to fill out and save forms electronically, you can test your
forms using Informed Designer’s Test mode. This allows you to make sure that your formattin
calculations, and other intelligent features work properly without having to switch to a differen
application.

The Informed Designer Manual Set
The Informed Designer manual set is designed to provide you with a complete reference to t
tures and capabilities of Informed Designer. The manuals combine text and graphics to thoro
document every aspect of the software. In addition to your Informed Designer Design and Gra
manual, the set also contains the following:

Informed Designer

The Informed Designer Manual Set
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■   The Informed Designer Getting Started Guide provides you with information on installing and
registering Informed Designer, and also describes the minimum hardware and software c
urations required to use the Informed Designer application.

■   The Informed Designer Forms Automation manual provides a detailed reference to Informed
Designer’s forms automation features. You’ll learn about the data handling capabilities of
Informed. You’ll also learn about using digital signatures, linking forms to other data sourc
using formulas and functions, and how to configure form templates for tracking. This man
also discusses Informed’s AppleScript scripting capabilities, and provides guidelines for d
tributing both new templates and new revisions of templates in an organization.

About This Manual
This manual includes a complete reference to Informed Designer’s design and graphics feat
General topics are organized in the following chapters:

■   Chapter 1, “Overview,” provides an introduction to the concept of electronic forms. It desc
the Informed products and explains how each application works and integrates with the o
to provide a complete electronic forms solution. The flexible nature of Informed’s architec
and how it can be customized to fit your organization’s environment is discussed, and gu
lines are provided for designing form templates for multiple platforms.

■   Chapter 2, “Manipulating Documents,” teaches you about the different types of Informed 
ments. Instructions are provided on how to open, close, and save form template docume
You’ll also learn how to change a document’s password.

■   Chapter 3, “Setting Up a Form,” shows you how to lay out a form on the printed page. Yo
learn how to choose a paper size and the size of a form.

■   Chapter 4, “Pages of a Form,” describes the different pages of a form, how to add and re
pages, and how to move from one page to another.

■   Chapter 5, “Drawing Environment,” presents information about the drawing window and i
visual attributes, as well as the various drawing aids including rulers, the grid, guide lines
the view scale.

■   Chapter 6, “Drawing Tools,” describes Informed Designer’s drawing tools and how to use 
to draw and manipulate objects. You’ll learn about the different types of objects and the va
options that control their appearance.

■   Chapter 7, “Changing an Object’s Appearance,” explains how to change an object’s visua
attributes by using a variety of Informed Designer’s commands.

■   Chapter 8, “Manipulating Objects,” shows you how to select, resize, and reposition objects
the Pointer tool. You’ll also learn how to move objects between the pages of your templat
from one template to another.

About This Manual
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■   Chapter 9, “Using Graphics,” describes how you can use Informed Designer’s Import com

to add artwork created in other applications to your template. The publish and subscribe 
OS only), and drag and drop features are also discussed.

■   Chapter 10, “Spell Checking,” explains how to use Informed Designer’s spell checking fea
to ensure the accuracy of text on your form templates.

■   Chapter 11, “Printing Forms,” describes how to print form templates with Informed Design
You’ll learn about various print options and how to set Informed Designer’s printing prefer
ences.

■   Chapter 12, “Mailing Forms,” provides information on how to mail form templates with 
Informed Designer. You’ll learn how to use the Send command and the Mail panel of the 
erences dialog box.

Conventions Used in This Manual
This section describes the conventions used in this manual to ensure that you can easily find
understand the information you need to perform specific tasks with Informed Designer.

Finding Information

In addition to the table of contents at the beginning of this manual, you’ll also find a table of c
tents at the beginning of each chapter, listing the main sections in that chapter. The example
shows the table of contents for Chapter 12, “Mailing Forms.”

■   Choosing Your Mail System   12-2

■   The Send Command   12-3

Inside each chapter, the main topics are highlighted in a gray bar like the one at the beginnin
this section, making it easy for you to quickly scan a page to find the topic of your choice. Su
tions for each topic are highlighted with a large, bold font.

Notes

Throughout this manual, you’ll see paragraphs of text highlighted in gray boxes with the labe
“Note” in the left margin. These notes contain important information such as warnings, remin
and specific conditions to be aware of. The example below shows a typical note.

Conventions Used in This Manual

Note Important information about Informed Designer appears in highlighted gray boxes like this o
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Commands and Control Names

When specific instructions on how to perform a certain task are given in this manual, comman
shown in a different typeface from the rest of the text. The name of the menu where the comm
found is also given in each instance. For example, when learning how to use Informed Desig
spell check feature, you’ll read the following text:

“To spell check your current template, choose Check Template... from the Spelling submenu under
Edit.”

The names of controls such as buttons and settings on dialog boxes are always shown in sin
quotes. For lengthy control names, this helps to differentiate the control name from the text th
rounds it. For example:

“When setting preferences for Informed Designer’s spell checking feature, you can select the
‘Always provide alternative spellings’ checkbox.”

Cross-platform Notes

Although this manual has tried to be platform neutral, the cross-platform nature of Informed 
requires special attention when learning about certain features of Informed Designer.

Throughout this manual you’ll see screens of dialog boxes and windows. Some of the screen
Windows dialog boxes and windows, others are from the Mac OS. In cases where a dialog b
window is substantially different between the two platforms, both versions are shown.

When a specific feature of Informed Designer is only applicable to one platform (Windows or
OS), an icon depicting either the Windows or Mac OS platform is displayed in the left margin
to the description of the feature as shown below.

The Windows Metafile format is not supported on the Mac OS.
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Overview

                     
In this chapter:

■   Designing a Form Template   1-2

■   Informed Plug-ins   1-3

■   Distributing Form Templates   1-4

■   The Templates Folder   1-5

■   Filling Out Forms   1-7

■   Form Tracking   1-8

■   Form Numbering   1-8

■   Where Everything Goes   1-9

■   Moving Folders   1-11

■   Designing For Multiple Platforms   1-14
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1Overview
Like many software products, Informed Designer and Informed Filler consist of different com
nents, including applications, documents, preference files, and special files and folders that s
special purposes. The organization of these components is flexible, allowing for custom confi
tions to better suit your specific needs.

This chapter describes the different components of Informed Designer and Informed Filler. E
though Informed Filler comes with its own manual set, an overview of its use is included here
make you are aware of issues that can help you better plan the design and deployment of ele
forms in your organization.

Designing a Form Template
The design of a form is called a form template. A form template is created using Informed Des
and stored in a form template document. You draw a form template much like you would usin
other graphics applications: by typing text and drawing graphical objects—like lines, boxes, a
shaded areas—using a variety of drawing tools. You can use Informed Designer’s built-in spe
checking features to check the spelling of the text on your template.

Included on Informed Designer’s tool palette are the Field tool and Table tool. Like other draw
tools, these tools draw objects that have a visual appearance. However, they also contain ce
cell is the part of a field or table that accepts information—that is, the areas on a blank form 
which information is entered.

To aid the Informed Filler user when entering information, cells can be configured to use a va
of “intelligent” features. These include automatic formatting, calculations, error checking, look
choice lists, on-line help, and other features that make it faster and more accurate to enter in
tion.

The design of a form template also involves linking the template to other services or systems
in your organization. For example, you might link a template to an Oracle database so that c
pleted forms can be electronically “submitted,” therefore eliminating the need to rekey the for
information into other systems. The use of other services such as electronic mail for sending 
and security services for signing forms with digital signatures can also be configured.

Designing a Form Template

Field cell Table cells
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In addition to the appearance of the form template itself, and its “intelligence” features and lin
other systems, you can also customize the menus that the Informed Filler user sees. By custo
menus, you can add custom menu commands with names that are more meaningful to the u
example, you might change the “Add Record” command to “Add New Order” for a purchase o
form. You can also simplify Informed Filler for the user by removing menu commands that ar
relevant given the particular use of a form template. The electronic form begins looking more 
custom application rather than a custom form.

For forms that carry sensitive information, Informed provides many security features. First, yo
protect any form template by assigning it a password. This prevents any other Informed Des
user from opening your templates and changing their appearance or logic. In addition, Inform
Designer provides commands to authorize and verify templates using sophisticated public ke
encryption services. By authorizing a template, you are affixing your electronic stamp of app
to indicate that the template is valid for use within your organization. The Informed Filler use
verify a template at any time to check it authenticity.

Informed Plug-ins
Many of the services that Informed can link to are accessed via Informed plug-ins. An Inform
plug-in is a file that contains the code that interacts with a particular service. For example, in
to mail a form template (with Informed Designer) or completed form (with Informed Filler) usin
particular e-mail system, you must have the Informed mail plug-in for that e-mail system insta
Informed Designer and Informed Filler come with a variety of plug-ins for accessing e-mail sy
tems, databases, signing services, and other services.

The table below lists the different types of plug-ins that Informed Designer and Informed Fille
take advantage of. Most plug-ins are used by Informed Designer for configuration purposes a
Informed Filler for providing the features themselves.

Informed Plug-ins

Informed Plug-ins

Plug-in Type Uses

Template translation

Mail

Data access

Signing

Data translation

Convert a form template to a different format.

Send form templates or completed forms using electronic mail.

Look up information from a database or data source.
Submit completed forms to a database or data destination.
Obtain unique form numbers from a database or data source.
Track forms with a database or data source.

Authorize and verify form templates using Informed Designer.
Sign and verify completed forms using Informed Filler.

Import, export, or mail form data in a particular data format.
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Informed Plug-ins (continued)

Informed plug-ins must be installed in a folder named “Plug-ins.” The plug-ins folder must be
located in your Informed folder.

By using plug-ins, Shana can more easily support new types of services as they become ava
For example, if a new electronic mail system were developed, Shana could easily enable the
ing of form templates and completed forms using that mail system by simply developing a ne
mail plug-in.

Distributing Form Templates
Once you’ve designed a form template, you need to make it available to the Informed Filler us
your organization. The way you do this depends on many things, including the size of your o
zation, the details of your networking environment, and the mobility of Informed Filler users.

In order to fill out a form of a particular type, Informed Filler must have access to the appropr
form template. There are two basic models for the distribution and storage of form templates.
templates can be stored in a distributed manner—that is, distributed to, and stored locally on
Informed Filler user’s computer, or they can be stored centrally on a file server and shared a
all Informed Filler users.

If you distribute your form templates to each Informed Filler user’s computer, these users hav
freedom to take their computers anywhere and still have access to the templates they need. 
work connection is not necessary to access templates. Furthermore, each time a user acces
template, it is not at the expense of network bandwidth.

Plug-in Type Uses

Distribution

Spelling

Distribute form templates via a particular type of distribution center.

Check the spelling of text on your template or the text entered on a co
pleted form using an alternate spell checking system.

Distributing Form Templates



 

Overview 1-5

 .
 .

 .

 

es 
hat 
tly up 
ach 
in the 

orm 
ers 
lates 
lates 
nt 

nd 
n 

istri-
ia 
 doc-

 users 
er will 
le. 

he dis-
ati-

  

lly on 

.” On 
fault, 

 

.

Centralized storage of form templates has converse advantages. Although access to templat
requires a network connection, the distribution of a new revision of a template requires only t
you replace the single template on the network file server. All Informed Filler users are instan
to date since they all share the same form template. If form templates are stored locally on e
Informed Filler user’s computer, the distribution of a new revision requires that each user obta
new version.

If you do not have the networking infrastructure or an available file server on which to make f
templates available, or if many of the Informed Filler users in your organization are mobile us
(that is, they are often disconnected from your network), you might consider storing form temp
locally on each Informed Filler user’s computer. That way, users will have access to the temp
they need anytime, anywhere. If, on the other hand, your Informed Filler users have persiste
access to a network file server, you might consider storing your templates there instead.

If you distribute your templates to each Informed Filler user’s computer, you can rely on 
Informed’s built-in forms distribution features to automate the distribution of new templates a
revisions of existing templates. With Informed Designer, you configure one or more distributio
centers. A “distribution center” is a place where you make your form templates available. A d
bution center can be a file server or an FTP server. Since distribution centers are accessed v
Informed distribution plug-ins, other types of distribution centers might be supported after this
umentation is published.

Once you’ve configured a distribution center and added your templates there, Informed Filler
can then access the distribution center and obtain any template. From then on, Informed Fill
automatically check periodically for the user to see if a new revision of the template is availab
When you need to change a template, you do so using Informed Designer and then update t
tributed templates available at any of the distribution centers. Informed Filler users are autom
cally notified and the new revision replaces the previous version.

The Templates Folder
Regardless of whether Informed Filler users access templates on a shared file server or loca
their own computers, Informed Filler needs to know where the templates are located.

Templates are located in the templates folder. On Windows, this folder is named “TEMPLATE
Mac OS, the folder is named “Templates.” Regardless of platform, the templates folder, by de
is located in the Informed folder.

The Templates Folder



 

1-6 Overview

 .
 .

 .

 

om-
ving 

mplate 
For 
in a 

order 
iller 

al pref-
is rea-

te 

 for 
ide the 
.

Informed Filler users can change the location of the templates folder using the Preferences c
mand. This preference is also accessible using Informed Designer. For information about mo
the templates folder, see “Moving Folders” later in this chapter.

In addition to the templates themselves, information about templates is stored in separate te
preferences files. These files contain information that is personal to the Informed Filler user. 
example, Informed Filler allows the user to list the information of multiple forms—or records—
list format by displaying the Record List window.

The Informed Filler user can change which information is included on the Record List and its 
and format according to specific needs and personal preferences. Each different Informed F
user might want to format the Record List differently.

Since templates can be shared among many Informed Filler users, it is important that person
erences, like the format of the Record List, be stored separate from the template itself. For th
son, Informed Filler maintains a separate preferences file for each template.

Template preferences files are stored in a folder named “TMPLPRFS” (Windows) or “Templa
Preferences” (Mac OS). This folder is found along with other items in another folder named 
“PREFS” (Windows) or “Preferences” (Mac OS). Like the templates folder, the default location
the preferences folder (that is, the folder that contains the template preferences folder) is ins
Informed folder.
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The preferences folder contains other items in addition to the template preferences folder. Th
Informed Filler user can store the preferences folder at its default location or at any other loc
For information about the other items found in the preferences folder, see “Where Everything
Goes” later in this chapter. For information about moving the preferences folder, see “Moving
ers.”

Filling Out Forms
While using Informed Designer, you can store form template documents anywhere you like. 
ever, when you distribute templates to Informed Filler users, they must be stored in the temp
folder. To the Informed Filler user, form templates are like hidden files that need not be mani
lated directly. Instead, Informed Filler automatically locates and opens templates when need
the user fills out new forms and opens previously filled out forms.

The information entered to fill out a form is stored in a form data document. When the user re
a new data document, Informed Filler presents a list of available templates to choose from. Th
selects a template and is presented with a blank form, ready for filling. A form data documen
store the information for one completed form, or many completed forms. A single completed 
is called a record. For casual users who fill out very few forms, it is easiest to store one reco
each data document. For users who fill out many forms, storing all records for a particular typ
form in one data document allows the user to take advantage of Informed Filler’s powerful dat
features.

While filling out forms, the Informed Filler user benefits from the powerful data entry and “inte
gence” features that you configure while designing the form template. Features like automat
matting, calculations, error checking, lookups, choice lists, and on-line help make it faster and
accurate to enter information.

The entire processing of a form is automated using Informed Filler, from the initiation of a ne
form, to the approval and submission of the completed form. After entering information, the u
signs the form electronically using a digital signature. A digital signature provides a means o
verifying the identity of the person who signed the form and the integrity of the signed data.

If approval of the form is necessary, the user sends the completed form to the appropriate pe
place using electronic mail. The process of entering and signing information, sending the for
other people, and, if necessary, approving the form continues, until the form is complete and
approved. The completed form is then submitted electronically or printed.

The flexible nature of Informed makes it ideal for automating both simple and complex forms
cesses. With the ability to easily exchange information between different forms and different 
cations, you can design a comprehensive “forms system” that combines and integrates man
different types of forms and different applications.

Filling Out Forms
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Form Tracking
For many types of forms, processing involves routing the form from person to person for app
purposes. Informed’s built-in form tracking capabilities make it easy for the Informed Filler us
find out where a particular form is in the routing process.

Whenever the user sends a form, Informed Filler connects to a central tracking database and
records information, including the sender and recipient names, the form identification numbe
(that is, the type of form and a unique number, such as an invoice number or purchase order
ber), and the date and time that the form was sent. You can customize a form template to trac
information as well.

At any time, the user can request the tracking status for any completed form. Informed Filler 
nects to the tracking database and retrieves the tracking information for the particular form. T
information is displayed in a dialog box for the user to view.

Informed Filler can track forms using a variety of databases. That way you can take advanta
the existing database services that are already available in your organization. However, if an
priate database is not available and you use Mac OS compatible computers in your organiza
you can use Informed Tracker, the form tracking server that comes with Informed Designer.

Form Numbering
Many forms require unique identification for tracking and audit purposes. For example, invoic
contain invoice numbers and purchase orders contain PO numbers.

The assignment of form numbers must be controlled to ensure that two different forms do no
tain the same number. Informed provides a special feature for this purpose. Any cell can be c
ured to generate a new number at the user’s request, or automatically whenever a new blank
created. Form numbers can be obtained from within the form template itself, or from another
base or data source.

Like form tracking, lookups, and form submission, Informed Filler can access a variety of dat
bases for purposes of generating form numbers. If the appropriate database services are alr
available in your organization, you might take advantage of these services for form number g
tion.

If the Informed Filler users in your organization use Mac OS compatible computers, you can 
link form number cells to Informed Number Server, a Mac OS application designed specifical
generating form numbers. Informed Number Server is included with Informed Designer. Infor

Form Tracking

Form Numbering
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Filler uses Apple events, the IAC (Inter-Application Communications) capabilities of the Mac 
to communicate with Informed Number Server.

Where Everything Goes
When you install Informed Designer or Informed Filler, you are asked to specify a location fo
“Informed” folder. The Informed folder contains the Informed Designer and Informed Filler ap
cations, as well as other important components. The contents of the Informed folder followin
installation is pictured below.

The Informed folder is a special folder. It contains certain items that are required in order for 
Informed Designer and Informed Filler to work properly. Some of the items in the Informed fo
can be moved to different locations. The following sections describe the purpose of each item
the possible storage locations. For information about moving the Informed folder to a differen
location, please see “Moving Folders” later in this chapter.

Applications

On Windows, the Informed Designer and Informed Filler applications are each comprised of 
executable files (“DESIGNER.EXE” and “FILLER.EXE”) and other associated files. These file
are found in the “DESIGNER” and “FILLER” folders. On the Mac OS, these applications are 
gle files and are named “Informed Designer®” and “Informed Filler™”.

The DESIGNER and FILLER folders (Windows) and Informed Designer® and Informed Fille
applications (Mac OS) can be moved to any location you like. You can store the applications lo
on your computer, or you can access them from a file server or applications server.

Where Everything Goes
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Plug-ins

The plug-ins folder contains Informed plug-ins and associated files. Informed plug-ins provid
access to external services such as electronic mail systems and databases. The plug-ins fold
be located inside your Informed folder. See “Informed Plug-ins” earlier in this chapter for mor
information about plug-ins.

Templates Folder

The templates folder (“TEMPLATE” on Windows, “Templates” on Mac OS) contains the templ
available for use with Informed Filler. The location of the templates folder can be changed us
Informed Designer or Informed Filler’s Preferences command. For more information, see “Th
Templates Folder” earlier in this chapter.

Preferences Folder

The preferences folder (“PREFS” on Windows, “Preferences” on Mac OS) contains the items
tured below.

The template catalog (“TMPLCAT.DAT” on Windows, “Template Catalog” on Mac OS) is a file
that is maintained by Informed Filler. It contains a list of all of the templates contained in the 
plates folder. Informed Filler uses the template catalog to quickly find the appropriate templa
when the user opens a data or package document.

The template preferences folder (“TMPLPRFS” on Windows, “Template Preferences” on Mac
contains template preferences files. Template preferences files are maintained by Informed F
Each file contains user-specific preferences for the template of the same name. The purpose
plate preferences is described earlier in “The Templates Folder.”

The Informed defaults file (“DEFAULTS.DAT” on Windows, “Informed Defaults” on Mac OS) i
also maintained by Informed Filler. Like template preferences files, the Informed defaults file
tains user-specific information that is associated with one or more templates. As explained in
ter 3, “Filling Out Forms”, of your Informed Filler User’s Manual, the Informed Filler user can 
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memorize a cell value so that the value is automatically entered each time a new blank form
ated. The memorized value is stored in the Informed defaults file.

The distribution centers folder (“DISTCTRS” on Windows, “Distribution Centers” on Mac OS)
contains the distribution center profiles needed to access the distribution centers in your orga
tion. You create distribution center profiles using Informed Designer. For detailed information
about distribution center profiles and Informed’s built-in forms distribution capabilities, please
Chapter 8, “Form Template Distribution and Revision,” in your Informed Designer Forms Automa
tion manual.

The preferences folder can be located anywhere you like. For information about moving the 
ences folder to a different location, please see “Moving Folders” later in this chapter.

On-line Help

If you choose to install on-line help, installation will include the necessary help files. On Wind
the help files are installed in the DESIGNER and FILLER folders. On Mac OS, you’ll find a fo
named “Help” inside the Informed folder. The help files must remain in these locations.

Spell Checking

If you choose to install Informed Designer’s spell checking option, you’ll see a folder named 
“Spelling” in your Informed folder. The spelling folder contains the spell checking dictionary a
related files. The spelling folder must remain in the Informed folder.

Informed Preferences

In addition to the items installed in the Informed folder, installation will also place a preferenc
file among your system related files. On Windows, this file is named “INFORMED.INI” and is
found in your Windows folder. On the Mac OS, the file is named “Informed Preferences” and
found in your system’s Preferences folder.

The Informed preferences file contains information necessary for Informed Designer and Info
Filler to find items such as the Informed folder, the templates folder, and the preferences fold
Other preferences associated with either application are also stored in the Informed preferen

Moving Folders
When you install Informed Designer or Informed Filler, the Informed preferences file is autom
cally updated with the locations of your Informed folder, templates folder, and preferences fo
When you run the Informed Designer or Informed Filler applications, they read these location
from your Informed preferences file in order to locate the appropriate files.

Moving Folders
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You can move the Informed folder, templates folder, or preferences folder to any location. Ho
ever, when doing so, you must specify the new location using Informed Designer or Informed
Filler’s Preferences command. Choose Preferences... from the Edit menu and click the Folders 
icon to display the Folders preferences panel.

The location of the Informed folder is specified in the ‘Informed folder location’ text box. The l
tion of the templates folder and preferences folder is assumed to be inside the Informed fold
unless otherwise specified in the ‘Alternate templates folder location’ and ‘Alternate preferenc
folder location’ text boxes. That is, if these text boxes are blank, Informed Filler will look for th
folders inside the Informed folder. If you want to move either of these folders to a different loc
tion, enter the new location in the corresponding text box.

You can enter a new location by typing in a text box or by clicking the adjacent ‘Browse’ butto
Clicking ‘Browse’ displays a dialog box allowing you to navigate through the different folders 
directories of any available volumes to select the desired location.

If you’re using a Windows compatible computer, clicking ‘Browse’ displays the following dialo
box:
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Select a folder in the scrolling list, then click ‘Select.’

If you’re using a Mac OS compatible computer, you’ll see the dialog box shown below.

Locate a folder in the scrolling list, then click the ‘Select’ button.

While using Informed Designer or Informed Filler, if any of the Informed, templates, or prefer
ences folders cannot be found at their expected locations, you’ll see a dialog message indica
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You can look for the missing folder or cancel the operation. If you click ‘Look,’ a dialog box 
appears allowing selection of the folder in its new location. This dialog box is the same one t
appears when you click any of the ‘Browse’ buttons on the Preferences dialog box (see earlie

Designing for Multiple Platforms
Informed Designer and Informed Filler are designed for seamless inter-operation across the 
dows and Mac OS platforms. Both the design of form templates, and, most importantly, the d
bution, filling, routing, approving, submitting, and tracking of forms can occur on either platfo
Forms can be filled on Windows and Mac OS computers regardless of the platform that was u
design the form template.

Informed Designer and Informed Filler create and manipulate documents of different types. 
Informed Designer creates form template documents whereas Informed Filler creates form da
package documents. These different types of documents are platform neutral. This means th
document is created using Informed Designer or Informed Filler on one platform, that same d
ment can be transferred to the other platform and opened directly. No translation is necessary
it necessary to have two versions of a form template, one for each platform.

Since Windows and Mac OS are two different operating systems, the details of how certain fe
and capabilities work may differ. These differences, in some cases, result in special consider
or guidelines that should be followed when designing form templates for use on both platform
The remaining sections of this chapter detail these guidelines. If you intend to design form te
plates for use on both Windows and Mac OS computers, you should read these sections.

File and Folder Names

One of the biggest differences between the Windows and Mac OS operating systems is the f
of file and folder names. (The term “folder” is used in place of the DOS term “directory.”)

For Windows version 3.11 and earlier, a filename is made up of a name and an extension. A 
consists of a name only. A file or folder name cannot exceed eight characters. The extension 
three character long and often identifies the type of file or document. On the Mac OS, a filen
can be up to 31 characters long and a file’s type is not specified as part of the filename itself

Designing for Multiple Platforms
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This difference in file and folder naming conventions means that special files and folders are n
differently on the different platforms. For example, the Informed preferences folder is named
“PREFS” on Windows and “Preferences” on the Mac OS.

If you save and name a new template document using a Mac OS computer, and you intend t
tribute that template to both Mac OS and Windows users, be sure to name the file according
Windows file naming conventions. That is, use the format filename.ext where filename is the
of the template (and should not exceed eight characters in length), and ext is “ITP,” the file e
sion for template documents.

Fonts and Type Styles

Different computers can have different fonts installed. When drawing a form template, be sur
use only those fonts that are installed on all Informed Filler users’ computer’s, both Windows
Mac OS. Furthermore, use fonts that are named exactly the same on both platforms, and wh
possible, use TrueType fonts or fonts that are based on the same font technology on both pla

Even when you use a font that’s available on both platforms, you may occasionally notice sli
differences in the size and spacing of text. These slight differences can cause text to wrap di
ently on the two platforms.

To minimize word wrap differences, you should try to leave some space between the end of t
and the right edge of the object.

After drawing a form template, and before distributing it to Informed Filler users, you should v
it on both platforms to check for font consistency.

Informed Designer allows you to modify the appearance of text by selecting different type sty
such as bold, underline, and italic. Certain type styles are available only on the Mac OS. The
include: outline, shadow, condensed, and extended. If you draw text with one of these styles
Informed Designer on the Mac OS, the unsupported style will be ignored when the text is disp
by Informed Designer or Informed Filler on a Windows computer.

Text can wrap differently between...

Mac OS... ...and Windows

Mac OS Windows

Leaving enough space between the end
of the text and the right edge of the
object eliminates the wrap difference.
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Importing Graphics

To include graphics created with other applications on your templates, Informed Designer all
you to import graphics using its Import command. Informed Designer can read graphics in fil
the following formats:

■   Windows bitmap

■   Windows metafile

■   Macintosh PICT

■   Encapsulated Postscript (EPS)

All formats with the exception of Windows metafile can be imported using Informed Designer
either platform. Windows metafile can be imported, viewed, and printed only on Windows com
ers. If your templates will be used by Informed Filler users with Mac OS computers, you shou
import graphics in the Windows metafile format. Use a different format instead.

Links to Other Systems

Many of Informed’s capabilities rely on services provided by the operating system or other pr
ucts or systems. The use of these capabilities often requires configuration using Informed De

The following capabilities rely on external services:

■   lookups to other databases or data sources

■   form submission to other databases or data destinations

■   obtaining form numbers from other databases or data sources

■   form tracking with other databases or data sources

■   authorizing templates and signing forms with digital signatures

■   suggested routes for sending forms with electronic mail

■   distribution of form templates via different types of distribution centers

Most of these services are available on both the Windows and Mac OS platforms. However, 
details of accessing a service from each of the platforms might be different. For example, su
that you’re linking a lookup to an Oracle database. For Mac OS users, you might be accessin
Oracle database using the Mac OS Oracle client software (SQL*NET), whereas on Windows
might be using ODBC instead. The specific parameters needed to connect to the database, 
fore, might be different depending on which platform the Informed Filler user is using.

Informed Designer automatically knows when a feature requires separate configuration on e
platform. The Lookup dialog box, for example, contains a drop-down list with the items ‘This 
form’ and ‘All platforms.’
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For each different type of database or data source that you can link to, Informed Designer kn
the configuration details are the same or different for the two platforms. If they’re the same, th
platforms’ option will be available and the lookup you configure on one platform will function 
both.

If the configuration details are different for each platform, ‘This platform’ will be the only choic
available in the drop-down list. For accessing these types of databases, you have to configur
lookup on one platform, then move the form template to the other platform and repeat the co
ration. Informed Designer stores the configuration for both platforms. Informed Filler uses the
figuration that corresponds to the user’s platform.

Although certain features require that configuration be done twice, once on each platform, th
resulting form template document is still a platform neutral document. That is, a single versio
the template will work with Informed Filler on both platforms. Informed Filler automatically us
the configuration information that’s appropriate for the user’s platform.

Scripting

Chapter 12 of your Informed Designer Forms Automation manual provides an overview of 
Informed’s AppleScript scripting capabilities and describes in detail how you can customize f
using AppleScript. AppleScript is a Mac OS scripting system and is therefore not available on
dows. Any AppleScript scripts that you attach to a template will not be available to Windows 
Informed Filler users.
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Manipulating Documents

                 
In this chapter:

■   Informed Documents   2-2

■   Creating a New Template   2-3

■   Template Information   2-3

■   Changing the Password   2-5

■   Opening a Template   2-6

■   Closing a Template   2-9

■   Saving a Template   2-11

■   Saving Copies of a Template   2-12
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2Manipulating Documents
This chapter presents information about Informed documents and how they are manipulated.
learn about Informed document types and password security, as well as how to create, open
and save form template documents.

Informed Documents
The term document refers to a file that contains information. An Informed document is a file tha
contains information about a form. There are four types of Informed documents: form templa
documents, form data documents, package documents, and interchange documents.

Form Template Documents (.ITP)

A form template document contains a form template. A form template is the layout or framewo
a form that you create using Informed Designer. It contains all the intelligent features of the fo
well as its graphic elements. The Informed Filler user fills out a form by entering values in the
on the template. In order to use a template with Informed Filler, the user must place the temp
his or her templates folder.

Form Data Documents (.IFM)

A form data document contains only a form’s data. When the Informed Filler user fills out form
the information entered is stored in a form data document. A single form data document can
one or more completed forms. Each completed form is stored as a record. Each form data do
also contains a template ID. The template ID identifies which template is needed to display a
manipulate the form data.

Package Documents (.IPK)

A package document combines a form template and its associated data. It is created using In
Filler and is used primarily when a user mails a form to someone who doesn’t have the corre
ing template. When the Informed Filler user opens a package using Informed Filler’s Open c
mand, the data document and template (if needed) are extracted. If the user’s templates fold
not already contain the template, the one extracted from the package is copied there and op
The data document is opened as an untitled document that can later be saved in a new file.

Interchange Documents (.IIF)

Informed Interchange documents contain all the data for one or more completed forms (or records), 
and are used primarily for transferring information between different applications, and differe
versions of Informed. They are created and read using Informed Filler, and store all types of 
mation including stylized text values, pictures, signatures, and annotations.

Informed Documents
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Creating a New Template
The New command creates a new form template.

To create a new template, choose New from the File menu. A new untitled window appears.   

You can create as many documents—or open as many existing ones—as you like. You are o
ited by the amount of available RAM (random access memory) in your computer.

Each new document is assigned a set of default settings. These defaults refer to the current 
of the object tools; that is, they determine what new objects will look like. For example, the de
font for the text tool is Arial (Windows) or Helvetica (Mac OS). Similarly, the line tool has a def
width of one point. See Appendix A for a complete list of default settings.

Template Information
Since templates and data documents are separate files, there needs to be a way to identify w
template is used for a particular data document. Informed Designer’s Template Information c
mand allows you to enter information that identifies a particular template. This information 
includes a template name, template ID, and revision number.

Creating a New Template

Template Information
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To enter or view template information, choose Template Information... from the Form menu. The 
Template Information dialog box appears.

Type a name for the template in the ‘Template name’ text box. The name that you enter can b
descriptive than the filename of the template. This can be helpful for templates that are store
accessed using Windows computers where file names are limited to a length of eight charac

The Unique template ID provides a means of linking form data documents to form template d
ments. When the Informed Filler user creates a new data document, in addition to the form d
itself, the template ID of the template used is also stored in the data document. When Inform
Filler opens a data document, the template ID is used to identify and locate the correct temp
use.

To enter a template ID, type a value in the ‘Unique template ID’ text box. It is recommended 
you assign a meaningful ID. For example, if you create an expense form template for claimin
expenses in US dollars, you might assign a template ID of ‘Exp-USD-96,’ whereas a templat
claiming Canadian dollar expenses might be assigned ‘Exp-CDN-96.’ If you don’t specify a te
plate ID, Informed Designer assigns a random number for you the first time you save the tem

The revision number further identifies the template. If you don’t enter a value in the ‘Revision 
ber’ text box, Informed Designer assigns the revision number “1” when you save the template
the first time.

Note The template ID and Revision number provide a means of coordinating the distribution of n
templates and new revisions of existing templates using Informed’s built-in forms distributio
capabilities. For details on these capabilities and the importance of the template ID and rev
number, see Chapter 8 of your Informed Designer Forms Automation manual.
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The Author section of the Template Information dialog box contains two text boxes: ‘Name’ a
‘Organization.’ You can use these text boxes to store information that identifies the designer o
form template.

You can also enter a brief description of the template in the ‘Description’ text box. Entering a
description of the template can be helpful to both the Informed Filler user and other form des
who might have to revise the template in the future.

Changing the Password
As a security measure, you can use passwords to prevent other users from opening and cha
templates with Informed Designer. If a template has a non-blank password, you’ll be prompte
enter it when you attempt to open the template using Informed Designer’s Open command (s
“Opening a Template” later in this chapter).

To change the password for a template choose Preferences... from the Edit menu. When the Pref-
erences dialog box appears, click the Security icon in the scrolling list. The dialog box chang
show the Security preferences panel.

Click the ‘Set Password’ button to display the Set Password dialog box.

Note Chapter 7 of your Informed Designer Forms Automation manual explains how you can autho-
rize and verify templates to ensure their authenticity. It is important to note that entering yo
name in the Author section of the Template Information dialog box is not the same as auth
ing a template by using the Authorize command.

Changing the Password
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If you haven’t entered a password before, only the ‘New password’ and ‘Confirm password’ te
boxes are available. If a password already exists, the ‘Old password’ text box is also availabl

If a password already exists, you must enter that password in the ‘Old password’ text box. Ty
your new password in the ‘New password’ text box, then press Tab. The insertion point move
the ‘Confirm password’ text box. Type the password again, then click ‘OK.’ Informed Designer
display a message confirming that you have successfully changed the password.

Opening a Template
The Open command opens an existing template.

To open a template, choose Open... from the File menu. If you’re using a Windows compatible 
computer, you’ll see the standard Windows Open dialog box.

If you’re using a Mac OS compatible computer, you’ll see the standard Mac OS Open dialog

Opening a Template
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Select a template to open, then click ‘Open.’

If the template you’ve selected has a non-blank password, you’ll be asked to enter it.

Informed Designer will not open the template until the correct password has been entered.

For information about how to change your password, see “Changing the Password” earlier in
chapter.

While the template is opening, Informed Designer displays progress information at the lower
corner of the drawing window.

Note You can make the Open dialog box appear automatically when you run Informed Designer
holding down the Alt (Windows) or Option (Mac OS) key after double-clicking the applicatio
icon.

Note Passwords are case sensitive. This means that upper and lower case letters are considere
different. Be sure to check whether or not your Caps Lock key is pressed.
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After a template is opened, its name appears in Informed Designer’s Window menu. 

A checkmark appears next to the name of the active template. To make another template the
template, simply click its window, or choose its name from the Window menu.

Missing Fonts

When you open a template, Informed Designer checks to make sure that the fonts used on t
plate are available in your system. Different systems on different computers can have differen
installed. If you draw a template on one computer, then transfer it to different computer, that 
puter might not have the fonts that you originally used to draw the template.

If Informed Designer detects that at least one font is missing from your system, you’ll see the
lowing dialog box.

Any text that uses one of the listed fonts will display using a font that’s available in your syste
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Opening a Locked Template

If the template you choose to open is locked, or resides on a locked disk, Informed Designer
warn you.

If you continue, the template will be opened as usual. However, you won’t be able to save an
changes (the Save command will always be disabled). To save any subsequent changes ma
template, choose Save As... from the File menu to save the template in a new file.

Opening a Template in Use

A template document that is presently in use cannot be opened. Most commonly, if a templa
already in use, you’ve probably already opened it yourself in Informed Designer or Informed F
If you try to open a template already in use, you’ll see a dialog indicating so.

You cannot open a template that resides on a file server and is being used by another user. 
attempt to do so, a dialog appears giving you the options of waiting until the template is avai
for use, or of canceling the Open command.

Closing a Template
The Close command closes the currently active template document—that is, the document th
responds to the front-most drawing window on your screen.

To close the currently active template, choose Close from the File menu, or click the window’s 
close box. Depending on the kind of document that you’re working with and the work that has
done, one of the following situations will arise.

Closing a New Template

If you’re closing a new template that has not been edited, the document is closed immediate

If you’re closing a new template to which changes have been made, Informed Designer will w
you to save the changes:

Closing a Template
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If you’re using a Mac OS compatible computer, the button names on this dialog box will be d
ent. Instead of ‘Yes’, you’ll see ‘Save’, and instead of ‘No’, you’ll see ‘Don’t Save.’ Clicking the
‘Yes’/’Save’ button displays the Save dialog box. If you’re using a Windows compatible comp
you’ll see the standard Windows Save dialog box.

Type the name of the new template and select the location to store it, then click ‘OK.’

If you’re using a Mac OS compatible computer, you’ll see the standard Mac OS Save dialog 

Type the name of the new template and select the location to store it, then click ‘Save.’ Clicki
‘Cancel’ instead cancels the Close command and your template document remains open.
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If a document with the name you specify already exists at the selected location, Informed De
will warn you with options to replace the existing document or cancel the Close command.

Clicking ‘No’/‘Don’t Save’ closes the template without saving any of the work you’ve done. Cl
ing ‘Cancel’ cancels the Close command and your template remains open.

Closing an Existing Template

When you close an existing template (that is, a document that was previously opened), Infor
Designer first checks to see if you’ve made changes to the template. If your template has no
changed since you last opened it, then it’s closed immediately without warning.

However, if you’ve made changes to the template, you’ll be asked if you want to save the cha

If you’re using a Windows compatible computer, the button names on this dialog box will be d
ent. Instead of ‘Save’, you’ll see ‘Yes’, and instead of ‘Don’t Save’, you’ll see ‘No.’ Click ‘Yes’/
‘Save’ to save the changes and close the template. Click ‘No’/‘Don’t Save’ to discard the cha
and close the template. Click ‘Cancel’ to cancel the Close command and continue editing you
plate.

Saving a Template
The Save command saves the currently active template—that is, the document that correspo
the front-most drawing window on your screen. This command is available only when change
have been made to the currently active template.

To save a template, select Save from the File menu. If the template corresponds to an existing d
ument (that is, it has been saved at least once before), it will be saved without warning.

If you’re saving a new template for the first time, you’ll be asked to name the template and sp
the location to store it. Depending on which operating system you’re using, you’ll see either t
standard Windows Save dialog box or the standard Mac OS Save dialog box (see “Closing a
Template” earlier).

Saving a Template
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Type the name of the new template and select the location to store it, then click ‘OK’ or ‘Save
Clicking ‘Cancel’ instead cancels the Save command.

If a document with the name you specify already exists at the selected location, Informed De
will warn you with options to replace the existing document or cancel the Save command.

Saving Copies of a Template
Use the Save As command to save a copy of a template with a different name, or at a differe
tion.

Choose Save As... from the File menu. If you’re using a Windows compatible computer, you’ll s
the standard Windows Save dialog box.

If you’re using a Mac OS compatible computer, you’ll see the following dialog box.

Saving Copies of a Template
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The same options apply as when saving a new document. After saving the new template doc
Informed Designer will automatically close the original template. The new document will rem
open for editing.

Template translation plug-ins allow you to save a template in different formats. If you have an
template translation plug-ins installed in your plug-ins folder, you’ll see those options in the ‘D
ument Type’ drop-down list.
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Setting Up a Form

       
In this chapter:

■   Overview   3-2

■   Page Setup   3-3

■   Drawing Setup   3-5
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3Setting Up a Form
In this chapter, you’ll learn how to lay out a form on the printed page. You’ll learn how to choo
paper size and the size of a form. As well, you’ll also learn how to replicate a form many time
across a single page.

Informed Designer also supports multiple page and multiple part forms. For information abou
these and other page related features, see Chapter 4, “Pages of a Form.”

Overview
When setting up your form template, you need to specify the paper size that your form will pri
as well as the size of the form itself. The size of a form is called the drawing size or the drawing 
area size and it’s specified independently of the paper size. This allows you to create and prin
forms of any size (up to a maximum of 17" by 17") regardless of the paper sizes available on
printer that you’re using.

The minimum and maximum drawing sizes are 0.5 and 17 inches square, respectively. The a
able paper sizes vary from printer to printer.

When the drawing area size exceeds the printable area of the selected paper size, Informed
Designer will automatically tile the form onto multiple sheets of paper as necessary. This proc
illustrated below.

Overview

Tabloid drawing area
(11" by 17")

Four 8.5" by 11" sheets
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The dashed lines on the above tabloid form divide it into four sections, each of which will prin
the printable area of one 8.5" by 11" page. Four 8.5" by 11" pages are required to print the e
tabloid form.

Tiling gives you the ability to print large forms on printers that don’t support large paper sizes
tiling, either automatically or manually, you can print the entire form or only parts of it onto sm
sheets.

The following sections explain the Page Setup and Drawing Setup commands. You use thes
mands to choose the paper size and drawing size. As well, they allow you to control various p
options.

Page setup
The Page Setup command sets the standard page options supported by your printer. Use it to
the paper size and to control printing related options such as page orientation.

Before setting the page options, make sure that your printer is properly set up and connecte
your computer. Also make sure that it’s the currently chosen or active printer for your comput
Then choose Page Setup... from the File menu. You’ll see the Page Setup dialog box associate
with your printer.

If you’re using an HP LaserJet (or compatible) printer, you’ll see a dialog box similar to the o
shown below.

If you’re using an Apple LaserWriter printer (or a printer that uses Apple’s LaserWriter driver)
you’ll see a dialog box similar to this: 

Page Setup

Note If the form you’re designing will be used on both Windows and Mac OS computers, you mu
select your Page Setup settings once on each platform. Changing the Page Setup (the ori
tion, for example) of a form on one platform (Windows or Mac OS) does not change it also
the other platform (Mac OS or Windows).
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If your drawing size is larger than your paper size, then Informed Designer will tile your form 
multiple sheets when it prints your form. You also have the option to manually tile only a partic
area of your form. Both the drawing window and the Drawing Setup dialog box visually indica
the currently selected paper size. See “The Drawing Window” and “Drawing Setup” for more i
mation.

If you’re using an Apple ImageWriter printer, choosing the Page Setup command will show a
log box similar to this:

When using an ImageWriter printer you can specify custom paper sizes. This is necessary w
you print onto pre-printed forms or labels of non-standard sizes. Setting the custom paper siz
ensure that the proper length of paper is fed through the printer each time a form is printed.

If you choose the ‘Use standard settings’ option, the paper size is determined by your selectio
standard size (top of the dialog box). If you want to use a non-standard size, click the ‘Use c
settings below’ choice, then enter the custom width and height in the text boxes provided. Th
ues that you enter are expressed in the current ruler units and are independent of whether y
choose landscape or portrait printing. That is, even if you select landscape printing, you still 
the width and height of the physical sheet that exits the printer.
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The size of a pixel (one dot) on the Mac OS screen is slightly wider than the size of a pixel o
ImageWriter printer. As a result, the width of a printed object appears slightly narrower than it
responding size on the computer screen. For example, a horizontal line that measures 8 inch
the screen will be approximately 7.5 inches long when it’s printed.

The Tall Adjusted option on the ImageWriter Page Setup dialog box adjusts the size of the p
pixel so that an object’s printed size matches exactly with its corresponding size on the scree
Click the ‘Tall Adjusted’ checkbox on the ImageWriter Page Setup dialog box to turn this opti
on.

Drawing Setup
The Drawing Setup command controls the size and options of the drawing area. The drawing area 
is the area that appears in the drawing window. It’s where you draw and manipulate the desi
your form.

To set the drawing size of a document, choose Drawing Setup... from the Layout menu. The Draw-
ing Setup dialog box appears.

The left side of the Drawing Setup dialog box illustrates the drawing setup. It shows a scaled
version of the drawing area and the page (or pages) that the drawing area is printed on. The
and orientation always reflect their current dimensions and placement relative to each other.

Drawing Setup

Drawing area rectangle

Print margin

These control the
position of the
drawing area on
the printed page.

These control the
number of repeated
drawing areas.
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On the right of the Drawing Setup dialog box are the current measurements of the drawing si
the offsets. Also, you can see how many times the drawing area is repeated in the drawing s
You can type in any of the text boxes or click any of the controls to change the associated di
sions or options of the drawing setup.

When you type in the text boxes to change the drawing area size or offsets, or to repeat the d
area over the page, the drawing setup on the dialog box will be updated when you leave the 
box. You leave the text box by pressing Tab or Shift-Tab, or by clicking a different text box or 
trol.

Drawing Size

The white rectangle on the illustrated drawing setup is called the drawing area rectangle. It repre-
sents the drawing area and visually shows the size of the drawing area relative to the page it
printed on.

The measurements of the drawing size are expressed in the current ruler units and are indic
the ‘Width’ and ‘Height’ text boxes. A document’s minimum drawing size is 0.5 inches square.
maximum drawing size is 17 inches square.

Changing the Drawing Size
You can change the drawing size in one of two ways.

■   Click and drag the handle at the bottom-right corner of the drawing area rectangle.

■   Type directly in the ‘Width’ and ‘Height’ text boxes.

Click and drag this handle
to change the drawing size.

Type in the text boxes to
change the drawing size.
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You can enter a new dimension in any units you like (inches, centimeters, points, or picas); 
Informed Designer performs the appropriate unit conversion for you. After entering a new dim
sion, press Tab (or Shift-Tab) to update the illustrated drawing setup.

When you change the drawing size, Informed Designer will always ensure that the new draw
size is not less than the minimum drawing size and not greater than the maximum drawing s
you type an invalid value in a text box, Informed Designer will alert you (with a beep) and high
the incorrect value when you Tab to or click another text box or control on the dialog box. As 
Informed Designer will always make sure that your drawing size remains large enough to ho
existing objects on your form. This means that objects cannot be accidentally dropped off the draw
ing area when you change the drawing size.

If you want to make the drawing area fit completely over the full area of a single page (based 
current paper size and page options), simply double-click anywhere in the drawing area rect

Page Size

The lightly shaded gray area under the drawing area rectangle represents the paper size; it r
sents the page on which the drawing area is printed and it corresponds to the currently selec
paper size. The red dotted line that appears on the drawing area near the edge of the paper i
the edges of the printable area of the page.

If the drawing size is set larger than the current paper size, additional sheets of paper are us
print a page of the form. The illustrated drawing setup below shows the four sheets of paper 
will be required to print one page of a form. Green lines are drawn to indicate where the pag
breaks will occur. The figure below shows the drawing setup for a tabloid drawing area (11" by
using the standard letter paper size (8.5" by 11").
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You can’t change the page size using the Drawing Setup command. Use the Page Setup com
instead. See “Page Setup” for more information.

Offsetting the Drawing

In addition to setting the drawing size, you can also change the position of the drawing area r
to the page (or pages) that it’s printed on. This is useful if you want the top or left edge of the
ing area to start at a certain distance from the top or left edge of the page. For example, supp
you want a one inch margin on the left side of your form to allow room for hole punching. Sim
reduce the width of the drawing area, and then enter ‘1’ in the ‘From left’ text box.

The horizontal drawing offset is the distance between the left side of the drawing area and th
edge of the page. The vertical drawing offset is the distance between the top of the drawing ar
the top edge of the page. These values are expressed in the current ruler units and displaye
‘Offset’ text boxes.

You can change the offsets in one of two ways:

■   Click and drag the drawing area rectangle across the page.

Click and drag to
change the offsets.
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■   Type the offsets directly into the ‘Offset’ text boxes.

You can enter a new offset in any measurement unit you like (inches, centimeters, points, or 
Informed Designer performs the appropriate unit conversion for you. After entering a new off
press Tab (or Shift-Tab) to update the drawing setup on the dialog box.

When changing the offset values, Informed Designer will check to make sure that all values a
valid. If you type an invalid offset, Informed Designer will alert you (with a beep) and highlight
incorrect value when you Tab to or click another text box or control on the dialog box.

Repeating the Drawing Area 

If the drawing size is less than half the width or height of the selected paper size, Informed 
Designer allows you to repeat the drawing area. This is useful if you want to print more than 
form on a single page.

For example, labels are often available on sheets for easy printing on laser printers. Suppos
sheet of labels contains two labels across and six down, and that each label is 3 inches wide
inches tall with a gutter of 0.25 inches. The figure below shows a sample drawing setup that 
be appropriate in this situation. Note that the offset values have also been adjusted to ensure
printed labels line up with those on the sheet.

Type in the text boxes
to change the offsets.
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To repeat the drawing area across or down the page, click the horizontal or vertical checkbox
cated by horizontal or vertical arrows), and type the desired number of areas and gutters in t
responding text boxes. If the number of areas you enter exceeds the maximum that will fit on
single page, Informed Designer will ignore those areas that don’t fit.

When you print a form with a repeated drawing area, the form’s layout is replicated across an
down the page according to the parameters on the Drawing Setup dialog box. If you print a f
while in Test mode, the cell values entered automatically appear in each drawing area printe

The real advantage of this feature comes when printing completed records with the Informed
application. When you print a group of completed records, Informed Filler will automatically u
the next record’s data each time a new drawing area is printed. For more information, see yo
Informed Filler User’s Manual.

Crop Marks

Informed Designer can automatically print crop marks. Crop marks act as page edge indicat
they’re used for trimming commercially printed forms.

Crop marks are always positioned relative to the edges of the drawing area. Therefore, if you 
to print these markings, be sure to leave room between the edge of the drawing and the edg
page.

Suppose that you’re creating an 8.5 by 11 inch form. You’re planning to print the form on a hi
resolution printer to prepare your form for commercial printing. However, as you design the f
you’d like to proof it on your laser printer.

Since you want to print crop marks, it’s important that the drawing be offset slightly from the p
edge.

Crop marks
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With a 1 inch offset, there’s enough room between the top and left edges of the drawing area
the corresponding edges on the sheets of paper to allow for crop marks. Printing will occur a
shown below.

Before printing your finished form on the high resolution printer, you would first change the 
selected paper size to a larger size (perhaps 11" by 17") and adjust the orientation of the dra
area.
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Pages of a Form

       
In this chapter:

■   Numbered Pages   4-2

■   The Work Page   4-5

■   The Master Page   4-6
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4Pages of a Form
Each form you create has one or more numbered pages, a work page, and a master page. T
bered pages contain the form’s actual layout (as in the first and second pages of a two page
The work page and master page each have a special purpose. This chapter describes the di
pages of a form as well as the commands used to add and remove pages, and create multipa

This chapter also describes the controls that are used to move from page to page in a form. 
controls are found near the bottom-left corner of the drawing window.

Numbered Pages
The numbered pages of a form are the actual pages that the Informed Filler user fills out. Eac
can have between 1 and 99 numbered pages, with each page having as many as 99 parts (s
tipart pages”).

Adding New Pages

Use the Add Pages command to create new pages and add them to your form template.

To add new pages, use the page controls to move to the page adjacent to where you want to
the new pages (see “Changing pages”). Then choose Add Pages... from the Layout menu. The Add 
Pages dialog box appears:

Numbered Pages

Note The maximum number of pages in an Informed document is 99. If your form contains 99 pa
the Add Pages command will be unavailable, preventing you from adding any more pages
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The Add Pages command allows you to add either a single page, or multiple pages. Type the
ber of pages that you want to add in the ‘Number of pages’ text box. To insert the new pages 
or after the current page, click the appropriate radio button. The diagram to the left of the rad
tons on the dialog box shows the page placement you’ve selected. To add the new pages, clic
or press Return. To cancel the Add Pages command, click ‘Cancel.’ After inserting the new p
Informed Designer will automatically display the first new page.

Removing a Page

Use the Remove Page command to remove a single page and its contents from a form temp

To remove a page, use the page controls to select the page you want to remove (see “Chang
Pages”). Then choose Remove Page... from the Layout menu. If removal of the page is permitte
then the Remove Page dialog box appears:

Click ‘OK’ to remove the page. Click ‘Cancel’ to resume editing your form without removing th
page.

Before you can remove a page, Informed Designer will verify that the page doesn’t contain a
cells that are required by cells on other pages of the form. If a cell on the page being remove
appears in the formula of a cell on a remaining page, Informed Designer will alert you.

Multipart Pages

Each numbered page can have up to 99 parts. When a page is printed, Informed Designer w
matically print one copy for each part.

Multipart pages are used most commonly when multiple copies of a form must be printed an
culated to different individuals or departments within an organization. For example, the bottom
three part single page form might say ‘Customer Copy’ on the first part, ‘Merchant Copy’ on t
second and ‘Accounting Copy’ on the third.

Note Any items on the master page will appear on newly added pages.
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With the Multipart command, you can instruct Informed Designer to print a specified number
copies of a particular page (3 in the above example). Then, using cell calculations, you can c
late a cell’s value using the PartLabel function. With the PartLabel function, you can specify t
labels that appear on each different part. When Informed Filler prints a completed form, it wil
automatically insert the correct label on each part. For more information about formulas, func
and the PartLabel function, please see Chapters 9 and 10 in your Informed Designer Forms Auto-
mation manual.

To set the number of parts for a page, first select the page using the page controls (see “Cha
pages”). Then choose Multipart Page... from the Layout menu. The Multipart Page dialog box 
appears:

Enter the number of parts (up to a maximum of 99) in the text box. Set the number of parts fo
current page or for all pages by clicking the corresponding radio button. Then click ‘OK’ to co
tinue. Click ‘Cancel’ to cancel the Multipart command and resume editing your form.

Note When you print your form while in test mode, Informed Designer prints all parts for each m
tipart page. When you’re in design mode, only a single copy of each page is printed. For m
information about test mode, see “Testing Your Form” in your Informed Designer Forms Auto-
mation manual.

A single page… …can have multiple parts.A single page...

Customer Copy
Merchant Copy

Accounting Copy

...can have multiple parts.
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Changing Pages

Use the page controls located near the bottom-left corner of the drawing window to change p
within a form.

The controls labelled ‘W’ and ‘M’ represent the work and master pages. The rightmost contro
resents the current numbered page of your form. When the numbered page control is selecte
number inside of it corresponds to the current numbered page in the drawing window.

There are two ways to change a page.

■   Click either arrow next to the page control to change pages in that direction. If you click a
hold either arrow, Informed Designer will continue changing pages in that direction until y
release the mouse button. If you’re on page 1, the left arrow disappears. If you’re on the 
numbered page of the form, the right arrow disappears.

■   Choose Go To Page... from the Layout menu. The Change Page dialog box appears.

Type the number of the page that you wish to move to, then click ‘OK’ or press the Return ke
Informed Designer will move directly to the requested page.

As a shortcut to choosing the Go To Page command, you can simply double-click the numbe
page control.

The Work Page
Every form contains one work page. Like the numbered pages of a form, the work page can c
graphics, text, and cells. The only difference between the work page and numbered pages is 
work page doesn’t print, and whatever you place on the work page doesn’t show on any othe
of your form.

There are two common uses of the work page.

■   As a place to put instructions or information useful to someone filling out your form.

The Work Page
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■   As a place to put cells that should not be printed with the rest of the form. If you need to e

or calculate the value of a cell that doesn’t appear on the form (but is required by other ca
lated cells), place it on the work page. When the form is filled out, the work page functions
any other numbered page. The user can tab to cells on the work page and change their v
But when the form is printed, the work page won’t print (unless the user selects the ‘Work
page’ option on the Print dialog box).

Display the work page by clicking the work page control near the lower-left corner of the draw
window.

When the work page is displayed, you can create and manipulate objects like on any other n
bered page of your form.

The Master Page
Every form has a master page. Like other pages of your form, the master page can contain gr
text, and cells. Objects drawn on the master page automatically appear on all numbered pag
your form. The master page, therefore, is useful for drawing elements such as company logo
page numbers that appear at the same position on all pages.

The master page is like an additional layer of objects that’s printed with each numbered page
terms of stacking order, objects on the master page are placed behind those on each of the 
bered pages. Therefore, an object on a numbered page that’s positioned over a master page
will cover, and perhaps hide, the master page object.

Display the master page by clicking the master page control near the lower-left corner of the
ing window.

The Master Page

Click the work page control to 
see the work page

Master page page 1 page 2 page 3

• • •

Anything that 
you draw here…

…automatically appears here.Anything that you 
draw here...

...automatically appears here.

Master Page page1 page 2 page 3
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When the master page is displayed, you can create and manipulate objects as you do on an
bered page of your form. You can’t print the master page alone.

Cells on the Master Page

When a form is filled out with Informed Filler (or Informed Designer’s Test mode), pressing th
Tab key moves from one cell to next. Each cell that you draw has a unique tab position which
mines the tabbing order. When filling out a form, the Informed Filler user will automatically st
on the page that contains the cell with tab position 1. If the user tabs from a cell on one page
cell on a different page, Informed will automatically change pages.

Cells on the master page are no different. However, unlike numbered pages, the master pag
doesn’t represent an actual page of a form. Therefore, instead of changing pages to the mast
the user simply remains on the current page when tabbing to a master page cell. For more in
tion, see “Master Page Cells” in Chapter 1 of your Informed Designer Forms Automation manual.

Click the master page control to 
see the master page.
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5Drawing Environment
This chapter presents information about Informed Designer’s drawing environment. You’ll lea
about the drawing window and its visual attributes, as well as the various drawing aids includ
rulers, the grid, guide lines, and the view scale.

The Drawing Window
You use the drawing window to create and edit the template of a form. When you open or cre
form template, a drawing window appears showing the template of the form.

The Drawing Window

Specs palette

Cell paletteCommand palettePage controlsInformation box

Grid lines

Guide lines RulersTool palette

Background

Print margins

Drawing area
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The elements of the Informed Designer drawing environment are briefly described below. For
information on these topics, please consult the indicated sections of this manual.

Drawing Environment Elements
Element Name Description

Drawing area

Rulers

Ruler crosshairs

Zero point marker

Grid lines

Guide lines

Page break

Print margins

Page controls

Tool palette

Specs palette

Command palette

Cell palette

The drawing area is where you draw your template. Use the Drawing 
Setup command to change the size and options of the drawing area. S
“Drawing Setup” in Chapter 3.

The rulers help you measure and position objects accurately on your te
plate.

The ruler crosshairs indicate the position of the mouse and objects relat
to the ruler.

Use the zero point marker to change the position of the ruler zero point. 
change the zero point, click and drag the zero point marker. To set the z
point to its home position, click and release the zero point marker.

Grid lines help you to accurately position and size objects on your tem-
plate.

The guide lines, like grid lines, help you position and size objects accu-
rately; use the guide lines to align objects to specific points on your tem
plate.

For forms that are larger than one page, page breaks indicate the positi
where the form crosses page boundaries. See “Page Size” in Chapter 3

Print margins show you the printable area of your template. Any object (
sections of an object) drawn outside the print margins will not print.

Use the page controls to view different pages of your template. See 
“Changing Pages” in Chapter 4.

The Tool palette contains the Pointer tool, the Tab tool, the Zoom tool, a
all drawing tools. See Chapter 6, “Drawing Tools.”

The Specs palette displays the current position and dimensions of a 
selected object on your template as well as the current position of the 
pointer. You can use the Specs palette to change the dimensions of any
object. See “Using the Specs Palette” in Chapter 8.

The Command palette provides shortcuts to many of Informed Designe
graphics commands and settings. Use the Command bar for tasks such
aligning text, duplicating objects, locking the position of objects, and so
on. See Chapter 8.

The Cell palette provides shortcuts to many of Informed Designer’s dat
intelligence commands. See “Using the Cell Palette” in Chapter 1 of yo
Informed Designer Forms Automation manual.
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Faster scrolling

If you are running Informed Designer or Informed Filler on a Mac OS compatible computer, y
can further increase the scrolling speed of forms in Informed Designer by taking advantage o
available memory.

The amount of memory required for fast scrolling depends on the dimensions of your templa
the monitor setting of your computer. The larger the form and the more grays or colors your m
tor is displaying, the more memory you will need. You can, however, minimize the amount of m
ory required for fast scrolling by selecting a display preference. 

To select the display preference, choose Preferences... from the Edit menu. The Preferences dia
log box appears.

With the ‘General’ preference panel selected, the dialog box contains two options. The first o
‘Display form in black and white,’ will display your form in black and white. If your monitor set
ting is set to multiple grays or colors, this option will significantly reduce the required memory
your monitor is set to ‘Black & White,’ selecting this option will have no effect on the memory 
required. 

The amount of memory available to Informed Designer depends on the size of the memory pa
in which the software is running. This size can be changed to increase Informed Designer’s a
able memory. For more information, please see your Informed Designer Getting Started Guide.

For information on ‘Fractional character widths’ please see Chapter 11, “Printing Forms.”
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Using Palettes
“The Drawing Window”, earlier in this chapter, pictures the drawing window and Informed 
Designer’s various palettes. The function of each palette is explained in other sections of this
ual, and in your Informed Designer Forms Automation manual.

You can show or hide any of the Tool, Specs, Cell, or Command palettes. To do so, choose t
responding item from the Show submenu under Informed Designer’s Layout menu.

You can also hide a palette by clicking its close box. While a palette is displayed, a checkma
appears next to its name in the Show submenu.

Like drawing windows, you can move a palette to any position on the screen. Simply position
pointer in palette’s title area, click the mouse button, drag to the new position, then release th
mouse button.

Layout Preferences
To give you more design flexibility, Informed Designer allows you to change the options for va
elements of the drawing environment by using the Preferences command. For example, if yo
fer to measure in points rather than inches, you can change the ruler units from inches to po

To set your preferences, choose Preferences... from the Edit menu. The Preferences dialog box 
appears. Click the ‘Layout’ icon in the scrolling list on the left.

Using Palettes

Layout Preferences

Close box
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Details about the individual Layout Preferences and how to change them are discussed in th
lowing sections. Once you’ve selected your preferred settings, click ‘OK’ to dismiss the Prefe
ences dialog box.

Rulers
The rulers are a drawing aid that help you measure and align objects on your form. Use the ru
draw, position, and resize objects accurately. When visible, the rulers appear on the top and 
edges of the drawing window.

To display the rulers, choose Show Ruler from the Layout menu. Alternately, when the rulers are
showing, this command becomes Hide Ruler. Choose this command to hide the rulers.

Rulers

Note Before you can create a new guide line, the rulers must be visible. For more information ab
guide lines, see “Guide lines.”
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On the ‘Layout’ panel of the Preferences dialog box you can select from four basic units of m
surement: inches, centimeters, picas, and points. To change the ruler units, choose a unit fro
‘Ruler’ drop-down list.

The ruler zero point represents the intersection of the zero mark on each of the horizontal an
cal rulers. By default, the zero point is set to the top left corner of the paper. You can change
zero point to align it to any position on the drawing area.

To change the zero point, click and drag the zero point marker—the small box at the upper-le
ner of the drawing window—then release the pointer at the new position.

If you release the mouse button in the content area of the drawing window, you’ll change the
point on each ruler. If you release the mouse in the content area of either ruler, the zero poin
changes for that ruler only.

If you want to reset the zero point to its default setting, click the zero point marker once.
 
To lock the zero point, select the ‘Lock zero point’ checkbox on the Layout panel of the Prefer
dialog box. Locking the zero point prevents you from changing it accidentally. When the zero 
is locked, the short gray lines on the zero point marker disappear.

Ruler crosshairs are visual aids that help you position the mouse and objects relative to part
points on the ruler. They appear as light gray lines on each ruler.

Click here

Release here New zero point

Drag

Ruler crosshairs
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With the ruler crosshairs, you can easily position objects on the drawing area. For example, 
want to position the mouse one inch down and to the right of the ruler zero point, simply drag
mouse until the ruler crosshairs are over the one inch marks on both rulers.

The ruler crosshairs appear whenever the pointer is positioned over the drawing area or whe
you draw, drag, or resize an object. When you move the pointer, a single crosshair on each r
shows the pointer’s current horizontal and vertical position. When you draw, drag, or resize a
object, the ruler crosshairs indicate the position of the object’s edges.

If the grid is turned on, the ruler crosshairs will also snap to the grid. Ruler crosshairs are the
an accurate indication of where drawing will start while positioning the pointer.

The Grid
The grid consists of imaginary lines that run vertically and horizontally across the drawing are
form. Use the grid as an aid to position and size objects on your form.

To display the grid, choose Grid from the Show submenu under Layout. When the grid is visible
checkmark is displayed next to the Grid command. Choose Grid again to turn the grid display off. 
Grid lines are always drawn according to the options you select on the Layout panel of the P
ences dialog box. For more information about changing the appearance of the grid lines, see
options” later in this chapter.

The Grid
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If you’re using a color monitor, grid lines will appear in light blue.

With the grid, you can align objects in one of two ways: visually or by using the Snap To Grid
ture. When used visually, you position and size objects by eye so that their boundaries lie alo
grid lines.

Using Snap To Grid

When drawing, dragging, or resizing, you can have Informed Designer automatically align—o
‘snap’—objects to the grid. You do this by choosing Snap To Grid from the Layout menu. While the 
Snap To Grid feature is on, a checkmark is displayed beside the menu item to indicate that t
ture is active. To turn the snapping feature off, choose Snap To Grid again.

With the Snap To Grid feature turned on, all objects that you manipulate (by drawing, draggin
resizing) will automatically align to the grid. When you draw or resize an object, its edges wil
constrained to lie on the nearest grid lines, whichever are active. When you drag an object, i
upper-left corner will be constrained to lie along the nearest grid lines.

When turned on, the Snap To Grid feature works regardless of whether the grid lines are vis
not.
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Grid Options

With the Preferences command, you control the spacing of the grid lines on your form. Inform
Designer gives you the ability to customize the grid for each form template you design.

To set the grid options, choose Preferences... from the Edit menu. When the Preferences dialog
box appears, click the ‘Layout’ icon in the scrolling list to display the grid options.

Grid separation—the distance between each grid line—can be specified in divisions per unit 
(inches, centimeters, picas, or points) or unit separation. Select the desired method by choo
option from the ‘Horizontal grid’ and ‘Vertical grid’ drop-down lists. The unit of measurement d
played in the grid drop-down lists (as in divisions/in, divisions/cm, and so on) is determined b
which unit of measurement you’ve chosen in the ‘Ruler’ drop-down list (see “Ruler Options”).

Regardless of how you measure grid separation, you can control the exact spacing of the gr
by typing a value in the appropriate text box. If you type ‘10’ into the ‘Horizontal grid’ text box
with the grid separation set to ‘divisions /in,’ the vertical grid lines will be spaced at ten lines p
inch. If you type ‘.125’ into the ‘Horizontal grid’ text box, with the grid separation set to ‘inche
the vertical grid lines will be spaced 1/8 of an inch apart.

Use the ‘Draw every’ text boxes to control the visual density of grid lines on your form templa
When you enter values into these text boxes, you specify how many grid lines are drawn acr
your form. For example, if the horizontal grid lines are spaced at five divisions per inch, and y
type ‘5’ into the ‘Draw every’ text box, then one vertical line will be drawn for every five vertica
lines on the grid (that is, one grid line every inch). 

Guide Lines
Guide lines run vertically and horizontally along the drawing area of your form. Like the grid, 
use guide lines as an alignment aid. However, they differ from grid lines because you create 
adjust each guide line independently—one line at a time. With the help of the rulers you can p
guide line at any position on the drawing area, allowing you to align objects to a specific pos
on your form.

To display the guide lines, choose Guides from the Show submenu under Layout. When you choo
Guides, a checkmark appears beside the Guides command to indicate that the feature is act
you’re using a color monitor, guide lines will appear in blue. To hide the guides, choose Guides 
again. 

Guide Lines



 

Drawing Environment 5-11

 .
 .

 .

 

rea of 
n when 

-

  

ly 

  

r 
 5 

  
.

Before creating a guide line, make sure that the rulers are visible. Then, click in the content a
either ruler and drag the mouse onto the drawing area of your form. Release the mouse butto
the new guide line is aligned at the desired position.

To remove a guide line, click and drag it back into the content area of the ruler, or drag it com
pletely off the top or left edge of the drawing window if the rulers aren’t displayed.

The Snap To Guides Feature
When drawing, dragging, or resizing an object, you can have Informed Designer automatical
snap the object to the guide lines on your form. You do this by choosing Snap To Guides from the 
Layout menu.

With the Snap To Guides feature on, any object that you manipulate (by drawing, dragging, o
resizing) will automatically align to the nearest guide line, provided that the object falls within
pixels, the guide line’s ‘sensitivity area.’

Note If you reduce the size of the drawing area (using the Drawing Setup command), Informed 
Designer will automatically remove any guide lines that no longer lie in the drawing area.

Click in the ruler’s
content area...

...drag... ...and release.

Click and drag the object to
the appropriate guide line.
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While the Snap To Guides feature is on, a check appears beside the corresponding menu ite
turn the snapping feature off, choose Snap To Guides again. The menu item will be unchecked, 
allowing you to manipulate objects on a pixel by pixel basis. The Snap To Guides feature wo
regardless of whether or not the guide lines are displayed.

If you want to lock the guide lines, select the ‘Lock guides’ option on the Preferences dialog b
This prevents you from accidentally moving the guide lines while you’re editing your form.

View Scale
While editing your form, you can change the view scale of the drawing window. Changing the
scale allows you to view more or less of the drawing area in the drawing window. By reducin
view scale you can see and work with a larger area of the form. By enlarging the view scale,
can work with your form close up for greater precision.

Changing the View Scale

You change the view scale of the drawing window by using the Zoom tool or by choosing a v
scale from the ‘View’ drop-down list. Informed Designer allows you to view a form at 25, 50, 1
200, 400, 800, and 1600 percent of its actual size.

When you change the view scale, the elements of your form are enlarged or reduced accord
However, Informed Designer’s drawing aids such as the rulers, grid lines, guide lines and ob
handles always remain the same size.

View Scale



 

Drawing Environment 5-13

 .
 .

 .

 

e the 
n the 
 100 
ow 

om 

 tool 

om 

s on 
t size 

ds 
xam-
would 

  

d-1 

 

.

The current view scale of the drawing window is displayed in the ‘View’ drop-down list in the 
lower-left corner of the drawing window.

To change the view scale using the ‘View’ drop-down list, simply click the drop-down list and 
choose a view scale from the options listed.

The Zoom tool (the ‘magnifying glass’) enlarges or reduces the view scale of your form. To us
Zoom tool, first select it from the tool palette and move the pointer to the position of interest o
drawing window. Click the mouse button once to bring your form to the next larger scale (from
to 200 percent, for example). The ‘View’ drop-down list in lower-left corner of the drawing wind
will change to indicate the current view scale.

When enlarging a drawing with the Zoom tool, the area on the drawing that lies under the Zo
tool will be centered in the drawing window when you click the mouse button.

Similarly, you can reduce the current view scale of the drawing window by clicking the Zoom
in the drawing window while holding down the Alt (Windows) or Option (Mac OS) key.

To change the view scale of the drawing window to its actual size, simply double-click the Zo
tool on the tool palette. This changes the drawing window’s view to 100% (actual size).

Drawing Accuracy
Drawing accuracy refers to the level of precision with which you can size and position object
your form. The higher the drawing accuracy, the more control you have over an object’s exac
and position.

Drawing accuracy is measured in dots per inch (dpi). The number of dots per inch correspon
directly to how accurately you can position or size an object within a one inch distance. For e
ple, if the drawing accuracy were 72 dpi, the smallest distance that you could move an object 
be 1/72nd of an inch.

Note You can also set the view scale to 100% by pressing the Control-1 (Windows) or Comman
(Mac OS) keystroke combination.

Drawing Accuracy

‘View’ drop-down list

72 dots
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The drawing accuracy of your computer screen—sometimes called screen resolution—is oft
dpi. This means that in any direction, there are 72 dots, or pixels, from one inch to the next. T
fore, when the view scale of the drawing window is 100% (actual size), moving an object from
pixel to the next will move the object a distance of 1/72nd of an inch. (You can change the vi
scale of the drawing window using either the Zoom tool or the ‘View’ drop-down list. See “Vie
Scale” for more information.)

If you change the view scale of the drawing window, you effectively change the drawing accu
as well. Each time you enlarge the view scale, the drawing accuracy doubles. This is becaus
although everything becomes twice as large, you can still move an object one screen pixel at
(which is now half the distance). If you enlarge the view scale from actual size to 200%, the d
ing accuracy changes from 72 to 144 dpi. The smallest distance that you can move or resize
object changes from 1/72nd to 1/144th of an inch.

Informed Designer allows a maximum drawing accuracy of 1152 dpi. This means that you ca
change the position or size of an object by a distance as small as 1/1152nd of an inch. In ord
obtain this level of precision, you have to change the view scale of the drawing window to 16

Limiting the Drawing Accuracy

Even though precise drawing accuracy is often necessary to position objects exactly on your
you should be aware of possible—and often unexpected—alignment problems that can resul
you manipulate objects at different view scales.

Suppose that you enlarge the view scale of the drawing window to 400% and draw a thin ver
line three pixels to the right of one inch. Since the drawing accuracy is 288 dpi at 400%, the 
tance of three screen pixels is 3/288ths of an inch.

After drawing the line, let’s say that you change the view scale back to actual size and draw a
line over top of the first one. Since the maximum drawing accuracy is only 72 dpi when the v

Note You can select a maximum drawing accuracy by choosing a setting from the ‘Drawing accu
racy’ drop-down list on the Layout panel of the Preferences dialog box. Informed Designer 
limit the drawing accuracy to this setting, even if you change the view to a larger scale. Se
“Limiting the Drawing Accuracy” below.

288 dots

2 dots past one inch
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scale is 100%, you wouldn’t be able to position the second line as accurately as the first. Eve
though the two lines would appear to be at the same position, their exact locations would be
ent. This would become apparent if you enlarged the view scale, or if you printed the form on
high resolution output device.

To avoid this problem, Informed Designer allows you to limit the drawing accuracy. You can s
maximum drawing accuracy by choosing a value from the ‘Drawing accuracy’ drop-down list 
the ‘Layout’ panel of the Preferences dialog box.

When you limit the drawing accuracy, Informed Designer restricts the placement of objects to
corresponding resolution. For example, if you choose a maximum drawing accuracy of 72 dp
Informed Designer won’t allow you to move an object less than 1/72nd of an inch, even if you
enlarge the view scale to 200% or more.

By restricting the drawing accuracy to 72 dpi, you could avoid the alignment problem discuss
above. When you’d try to draw the first line at three pixels to the right of one inch, Informed 
Designer would force the position of the line to 1 and 1/72nd of an inch—an even multiple of
drawing accuracy. At the 100% view scale, you could then draw the second line precisely on 
the first.
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Paper and Background Color
You can make your forms more visually appealing by changing the color of the paper and ba
ground that appear on the screen.

The controls for changing the paper and background color are found on the ‘Layout’ panel of
Preferences dialog box. Choose Preferences... from the Edit menu. When the Preferences dialo
box appears, click the ‘Layout’ icon in the scrolling list.

To change the paper and background color for your form, click the ‘Paper’ or ‘Background’ dr
down lists and select a color from the color palette displayed. Click ‘OK’ to save the changes
cancel the changes and dismiss the Preferences dialog box, click ‘Cancel.’

Paper and Background Color

background

paper
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In this chapter:

■   The Tool Palette   6-2

■   The Text Tool   6-3

■   The Line Tool   6-5

■   The Rectangle Tool   6-6

■   The Oval Tool   6-7

■   The Arc Tool   6-8

■   The Polygon Tool   6-9
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■   The Table Tool   6-16
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6Drawing Tools
This chapter describes Informed Designer’s drawing tools. You’ll learn about the different typ
objects and the options that control their appearance. You’ll also learn how to draw and mani
objects using the drawing tools.

This chapter provides information about object types and their appearance attributes. For inf
tion about changing an object’s appearance, see Chapter 7, “Changing an Object’s Appeara

The Tool Palette
The Tool palette provides access to Informed Designer’s drawing tools. In addition to the dra
tools, the Tool palette also contains the Pointer tool, the Button tool, the Tab tool, and the Zo
tool.

The Pointer tool selects, deselects, repositions, and resizes objects on your form. The Button
used to draw buttons and configure them to perform specific tasks. The Tab tool allows you t
change the tab order of the cells on your form by clicking and dragging the pointer from one c
another. The Zoom tool changes the view scale of the drawing window. For more information 
the Pointer tool, see “Selecting Objects” in Chapter 8. For information about the Zoom tool, s
“Changing the View Scale” in Chapter 5. For information about the Tab tool and Button tool, s
Chapters 1 and 4 of your Informed Designer Forms Automation manual.

The Tool Palette

Pointer tool

Drawing tools

Button tool

Tab tool

Zoom tool
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Like any palette, you can show or hide the Tool palette and drag it to a different position on y
screen. To show the Tool palette, choose Tools from the Show submenu under Layout. When the
Tool palette is displayed, a checkmark appears next to the Tools command. To hide the Tool p
choose Tools again. You can also hide the Tool palette by clicking its close box in the title bar.
move the Tool palette on your screen, click and drag its title bar to a new position.

You select a tool by clicking it on the Tool palette. When a tool is selected, its icon is highlighte
the Tool palette.

Since you use the Pointer tool often, Informed Designer offers two shortcuts for selecting it. F
pressing the key located at the top-left of your keyboard will toggle the current tool between 
Pointer tool and the last drawing tool used. Depending on which style of keyboard you’re usi
this key will be either the Escape key or the reverse quote (`) key.

You can also temporarily select the Pointer tool by pressing the Alt (Windows) or Option (Mac
key. As long as you hold down the Alt/Option key, the Pointer tool will remain in effect. When 
release the Alt/Option key, the current drawing tool becomes active again. This shortcut is us
you want to quickly move or resize an object while you’re using the drawing tools.

The Text Tool
Use the Text tool to draw text or edit text objects. You can also use the Text tool to edit the tit
fields and tables. Select the Text tool by clicking it on the Tool palette.

As a shortcut, you can select the Text tool by pressing the Tab key once. In addition to select
Text tool, pressing Tab will also select the characters of the first text, field, or table object on 
form (based on top-left to bottom-right position). If a text, field, or table object is selected, pre
Tab will select the characters of that object instead.

Drawing a Caption

To draw a caption (a title or heading), select the Text tool and position the pointer where you
the caption to start; the pointer changes to an I-beam. Then click the mouse and start typing

While you type, you can begin a new line by pressing the Enter (Windows) or Return (Mac O
key. If you try to type past the edge of the drawing area, your text will automatically wrap to t
next line. When you finish typing, press the Enter key on the numeric keypad, or select anothe
Informed Designer selects the text object as a whole (that is, the object will show handles at 
ners).

Unlike paragraphs of text (see next section), the dimensions of a caption automatically chan
when you edit it. For example, if you insert new words or change the object’s font size, Inform
Designer will automatically adjust the object’s width and height to fit tightly around the text. H

The Text Tool
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ever, once you’ve resized the object using the Pointer tool, its dimensions will no longer adju
automatically.

Drawing a Paragraph of Text

You can specify the margins of a text object by drawing a rectangle with the Text tool before 
begin typing. This is useful for drawing paragraphs of text.

To create a paragraph, select the Text tool and position the pointer where you want the top a
margins to be. Then click and drag to draw a rectangle. As you drag, a rectangular outline ap
shrinking and expanding to follow the movement of the mouse. Release the mouse button wh
outline is the right size. Then you can start typing your paragraph.
 

When text reaches the edge of the object’s rectangle, it will automatically wrap to the start of
next line. If you type past the bottom edge of the rectangle, Informed Designer will extend the
to accommodate any additional lines.

When you finish typing, press the Enter key on the numeric keypad or select another tool. Th
tom edge of the object’s rectangle will automatically snap up to the bottom edge of the last li
text and the object will be selected.

If you press F12 (Windows) or hold down the Option key while pressing Enter (Mac OS), the
object’s right edge will snap to fit tightly around the width of the longest line of text. This will h
pen if the initial width of the paragraph is wider than the longest line that you type.

Informed Designer makes it easy to draw text inside a box. Instead of drawing a rectangle w
Text tool (as described above), simply select a rectangle object with the Pointer tool and star
ing. The text you type will automatically align itself inside the rectangle.

Editing Text

Use the Text tool to edit the words or characters of an existing text object. Field, table, and c
titles are edited the same way.

To edit a text object or title, select the Text tool and click the text that you want to edit, then b
typing. As always, when you finish typing, press the Enter key on the numeric keypad or sele
another tool. Informed Designer will snap the bottom edge of the object’s rectangle to the bo

Click...

...drag

...release
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edge of the last line of text, then select the object as a whole. If you press F12 (Windows) or
Option-Enter (Mac OS), the right edge of the object will adjust automatically to fit around the 
est line of text.

Text Dimensions

The dimensions of a text object determine the maximum width of each line. When you draw a
graph of text or when you draw text in a box, the width of the text object is fixed. This means th
you type, the text automatically wraps to stay inside its preset width. There’s no need to pres
Enter (Windows) or Return (Mac OS) key at the end of each line. If you draw a caption by clic
and typing, the width of the text object is determined by the length of the longest line that you
You’ll start a new line only if you type past the end of the drawing area or if you press the En
(Windows) or Return (Mac OS) key.

Whenever you edit a caption, the width of the text object will change freely to fit around the lo
line. If you resize the text object with the Pointer tool, the object becomes a paragraph of tex
a fixed width. If you want to change a paragraph of text to a caption, simply press F12 (Wind
or Option-Enter (Mac OS) after editing the text. The object’s width will expand or contract to 
around the object’s longest line.

The Appearance of Text

The appearance of text is controlled by changing attributes such as the font, font size, type s
alignment, and leading. Some attributes apply to entire text objects, whereas others apply to
vidual characters. Individual characters each have the following attributes: font, font size, and
style. Each text object (as a whole) has these attributes: pen, leading, and horizontal alignme
a complete description of text attributes and how to set them, see “Type Settings” in Chapter 
“Paint Settings” in Chapter 7 for information about the pen attribute.

When you draw a new text object, its type attributes are initially set to the current default sett
for the Text tool. For example, if the default font is Times, each new text object that you draw
be Times. For instructions on changing the default text attributes, see “Changing Default Set
in Chapter 7.

The Line Tool
Use the Line tool to draw lines on your form. Select the Line tool by clicking it on the Tool pal
the pointer changes to a cross.

To draw a line, position the pointer where you want the line to start, then click and drag the p
to where you want the line to end, and release the mouse button. The new line is drawn and
selected.

The Line Tool
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If you hold down the Shift key while drawing, the new line will be constrained to the horizonta
vertical axis, or diagonally at 45, 135, 225, or 315 degrees.

The Appearance of Lines

The appearance of lines can be changed by changing attributes such as the pen and line widt
specifically, each line has the following attributes: pen, line width, and line style.
 
The pen determines the color of the line. Changing the line width changes the line’s thickness
styles include plain, dashed, double line, and arrowhead styles. For a complete description o
attributes and how to change them, see “Paint Settings” in Chapter 7.

When you draw a new line, its pen, line width, and line style attributes are initially set to the cu
default settings for the Line tool. For example, if the default line width for lines is 1 point, each
line that you draw will have a width of 1 point. For instructions on changing the default line 
attributes, see “Changing Default Settings” in Chapter 7.

The Rectangle Tool
Use the Rectangle tool to draw rectangles or boxes on your form. Select the Rectangle tool b
clicking it on the Tool palette; the pointer changes to a cross.

To draw a rectangle, position the pointer where you want a corner to start, then click and dra
pointer to the opposite corner and release the mouse button. While dragging, a gray frame fo
the movement of the mouse. When you release the mouse button the new rectangle is drawn
selected.

If you hold down the Shift key while drawing, the new rectangle will be constrained to a squar
sides equal length).

The Rectangle Tool

Click...

...drag

...release

The new line is automatically selected.

...drag

...release

Click...

The rectangle is automatically selected.
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The Appearance of Rectangles

The appearance of rectangles can be changed by changing attributes such as the pen, fill, a
width. More specifically, each rectangle has the following attributes: pen, fill, line width, line s
and corner rounding.

The pen determines the color of the rectangle’s frame. The rectangle’s interior is drawn with 
selected fill color. Changing the line width changes the frame’s thickness. Line styles (also u
draw the rectangle’s frame) include plain, dashed, and various double line styles. For a comp
description of the pen, fill, line width, and line style attributes and how to change them, see “
Settings” in Chapter 7. For more information about rounding corners, see “Rounded Corners
Chapter 7.

When you draw a new rectangle, its appearance attributes are initially set to the current defa
tings for the Rectangle tool. For example, if the default fill for rectangles is blue, each new re
gle that you draw will be automatically filled with blue. For instructions on changing the defau
rectangle attributes, see “Changing Default Settings” in Chapter 7.

The Oval Tool
Use the Oval tool to draw ovals and circles on your form. Select the Oval tool by clicking it on
Tool palette; the pointer changes to a cross.

To draw an oval, position the pointer where you want the oval to begin, then click and drag un
oval is the right size. An outline of the oval will appear and follow the movement of the mouse
When the oval is the right size, release the mouse button. The new oval is drawn and selecte

If you hold down the Shift key as you draw, the new oval will be constrained to a circle.

The Appearance of Ovals

All ovals have pen, fill, and line width attributes. You can change the appearance of an oval b
changing any of these attributes.

The pen determines the color of the oval’s frame. The oval’s interior is drawn with the selecte
color. Changing the line width changes the frame’s thickness. For a complete description of th
fill, and line width attributes and how to change them, see “Paint Settings” in Chapter 7.

The Oval Tool

Click...

...drag

...release

The new oval is automatically selected.
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As with lines and rectangles, newly drawn ovals inherit the default attributes of the Oval tool.
example, if the default line width of the Oval tool is 2 points, each new oval that you draw will h
a frame that’s 2 points thick. For instructions on changing the default oval attributes, see “Cha
Default Settings” in Chapter 7.

The Arc Tool
Use the Arc tool to draw arcs on your form. Select the arc tool by clicking it on the Tool palette
pointer changes to a cross.

To draw an arc, position the pointer where you want the arc to begin. Click and drag to the op
end of the object. An outline of the arc will appear and follow the movement of the mouse. W
the arc is the right size, release the mouse button. The new arc is drawn and selected.

The initial motion of the mouse determines the direction and curvature of the arc. For examp
dragging the mouse up and to the right creates an arc that slopes upward along the horizont
while dragging the mouse to the right and then up creates an arc that slopes upward along th
cal axis. This is illustrated below.

The Appearance of Arcs

The appearance of arcs can be changed by changing the pen, fill, and line width attributes.
 
The pen determines the color of the arc. The arc’s interior (a quarter oval), is filled with the se
fill color. Changing the line width changes the arc’s thickness. For a complete description of t
pen, fill, and line width attributes and how to change them, see “Paint Settings” in Chapter 7.

The Arc Tool

Click...

...drag

...release

The new arc is automatically selected.

You get this when 
you drag up and 
to the right.

You get this when 
you drag to the 
right and then up.
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When you draw a new arc, its pen, fill, and line width attributes are initially set to the current 
default settings for the Arc tool. For example, if the default line width for arcs is 2 points, each
arc that you draw will be 2 points thick. For instructions on changing the default arc attributes
“Changing Default Settings” in Chapter 7.

The Polygon Tool
Use the Polygon tool to draw polygons on your form. Select the polygon tool by clicking it on
Tool palette; the pointer changes to a cross.

To draw a polygon, move the pointer to where you want the first side to start, then click and re
the mouse button. Move the pointer to the end of the first line segment and click the mouse b
to create the first side of the polygon. Create the remaining sides of the polygon by alternatel
tioning the pointer and clicking until the polygon has the shape that you want.

When creating the last side of the polygon, you can either join it with the first side, or leave th
polygon open. To join the last side with the first, simply click once near the first end point of t
polygon’s first side. Informed Designer will automatically close and select the polygon. To lea
the polygon open, position the pointer where you want the last side to end, then double-click
mouse button.

If you hold down the Shift key while positioning the pointer to create a side, Informed Design
will constrain the side to lie on either of the horizontal or vertical axes, or diagonally at 45, 13
225, or 315 degrees.

The Polygon Tool

Click...

...position to the end of
the first line segment...

...alternate clicking and
positioning to create the sides...

...drag and click near the starting
point to close the polygon...

...the new polygon is
automatically selected.
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The Appearance of Polygons

The appearance of polygons can be changed by changing attributes such as the pen and lin
More specifically, each polygon has the following attributes: pen, fill, and line width.

The pen determines the color of the polygon’s sides. The fill color is used to draw the interior 
polygon. Changing the line width changes the width of the sides. For a complete description 
these attributes and how to change them, see “Paint Settings” in Chapter 7.

When you draw a new polygon, its pen, fill, and line width attributes are initially set to the cur
default settings for the Polygon tool. For example, if the default line width for polygons is 1 p
the sides of each new polygon that you draw will be 1 point wide. For instructions on changin
default polygon attributes, see “Changing default Settings” in Chapter 7.

Reshaping a Polygon

As with all objects, you can select, reposition, and resize a polygon using the Pointer tool. H
ever, when you resize a polygon, the relative position of each vertex (the joining of two sides
always remains the same. Handles appear only on the corners of the smallest rectangle that
around the polygon.

To change the position of a particular vertex, use the Reshape Polygon command. First sele
polygon with the Pointer tool, then choose Reshape Polygon from the Arrange menu. Handles will
appear at each vertex of the polygon.

Again using the Pointer tool, click and drag any vertex. The polygon will remain in reshape m
until you deselect it.

The Field Tool
Fields are graphic objects that hold information. Each field contains a cell—a holding place f
data. When you fill out a form, you enter information into each cell.

Unlike other graphic objects such as lines, rectangles, and ovals, fields are composed of vari
ments or parts. These parts automatically appear when you draw a field, making it easy for y
draw the graphics that commonly surround a cell.

The Field Tool

Click...

...release

...drag
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There are a variety of options that you can use to change the general appearance of a field. 
example, you can show a field’s title on any side of its cell, or you can hide the title altogethe
can turn the rule lines and combs on or off, and you can change their appearance too.

This section discusses the graphic attributes of fields. You’ll learn how to draw a field and cha
its appearance. As well, you’ll learn how to select and manipulate the parts of a field. For info
tion about setting up a cell’s data intelligence attributes, see Chapter 1, “Adding Intelligence to
Forms” in your Informed Designer Forms Automation manual.

Drawing a Field

To draw a field, select the Field tool by clicking it on the Tool palette. Position the pointer on 
drawing area; the pointer changes to a cross. Click where you want a corner to start and dra
opposite corner. When you release the mouse button, the field is drawn and selected.

If you hold down the Shift key while drawing, the dimensions of the new field will be constrain
to a square (all sides will be of equal length).

Title section

Title divider

Rule lines

Comb lines

Cell section

Click...

...drag

...release

 The new field is automatically selected.
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Selecting Parts of a Field

Clicking a field once with the Pointer tool selects the whole object. Clicking a second time sel
part of the field. For example, click a field on your form using the Pointer tool, and handles a
on the corners to indicate that the whole field is selected. Next, click in the title section of the
A shimmering frame appears inside the title section, indicating that it is selected.

The Appearance of Fields

As already mentioned, a field consists of various parts that are automatically drawn, positione
resized as the field is manipulated. You can change the appearance of a field by changing th
tion, size, or visual attributes of each of its parts. You use the Pointer tool to select a part, or c
the dimensions of a part by dragging. The Field command allows you to control the options a
ated with each part.

When you draw a field, its initial appearance is determined by the current default settings for
Field tool. For example, if the default position of the title section is on the left, each new field 
you draw will have its title on the left. For instructions on changing the Field tool defaults, see
ting Field and Table Defaults” in Chapter 7

Although the Field command is referred to throughout this section, a complete description of i
is not covered here. For more information, see “Field Settings” in Chapter 7.



 

Drawing Tools 6-13

 .
 .

 .

  

d the 
 tool. 

e the 

n by 
ows) 
ee 

t 
e the 
 See 

e pen 
unt of 
ection 
 fill, 
rners, 

  

et-
.

The Title Section
The title section commonly describes the information in a field’s cell. It consists of a frame an
accompanying title text. To select the title section, click it (twice if necessary) with the Pointer
An inset frame in the title section will shimmer.

You can position the title section on any side of a field’s cell, or you can hide it altogether. Us
Field command to choose an orientation for the title section.

You can change the height or width of a field’s title without affecting the size of the cell sectio
clicking and dragging the outer edge of the title section while holding down the Control (Wind
or Command (Mac OS) key. You can also resize the title section by moving the title divider (s
“The Title Divider” below).

To edit the title text, use the Text tool and the appropriate text editing techniques. Like all tex
objects, the title text has font, font size, type style, leading, alignment, and pen attributes. Us
Type command in the Style menu or the various Style submenus to change these attributes.
“Type Settings” in Chapter 7 for more information.

The title section has many of a rectangle’s visual attributes. For example, you can change th
and fill colors and adjust the thickness of the title section’s frame; or you can change the amo
rounding on each corner. Before choosing a setting, make sure that you first select the title s
by clicking it (twice if necessary) with the Pointer tool. For a complete description of the pen,
and line width attributes, see “Paint Settings” in Chapter 7. For information about rounding co
see “Rounded Corners” in Chapter 7.

Note Unlike text objects, field titles can be vertically aligned within the title section. See “Type S
tings” in Chapter 7 for more information.

Title on top Title on the bottom

Title to the right Title to the left

No title
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The Title Divider
If a field’s title section is on, the field will also have a title divider. The title divider divides the fi
into two sections: the title section and the cell section.

Like other parts of a field, you can select the title divider by clicking it (twice if necessary) with
Pointer tool; the line will shimmer. Once you select the title divider, you can change its appea
by changing the pen color or line width. If you want to hide the line altogether, change its pen
none. For information about the pen and line width attributes, see “Paint Settings” in Chapter

To change the height or width of the title section, use the Pointer tool to drag the title divider 
appropriate direction (up/down or left/right, depending on position of the field’s title). You can 
change the height or width by clicking and dragging the appropriate edge of the title section 
pressing the Control (Windows) or Command (Mac OS) key. See “The Title Section” for more
information.

The Cell Section
The cell section represents the area of a field where you enter information. It consists of a ce
frame, and optional rule lines and combs. To select the cell section, click it (twice if necessary
the Pointer tool. An inset frame in the cell will shimmer.

You can change the height or width of the cell section by clicking and dragging any outer edg
the cell section with the Pointer tool. If the ‘Rule lines’ option is turned on for a cell, Informed
Designer will constrain the cell’s size to increments that equal the height of the space betwee
rule lines. Holding down the Control (Windows) or Command (Mac OS) key while dragging th
cell section’s edge overrides this feature.

If the ‘Rule lines’ option is turned off for a cell, you can click and drag the cell’s bottom edge fr
to change its height. If you hold down the Control (Windows) or Command (Mac OS) key wh
dragging, Informed Designer will constrain the cell’s size to increments that equal the height 
font size selected for that cell. For more information on rule lines, see “Rule Lines” below.

Even though you can’t see a cell’s text until you actually fill out the form, Informed Designer 
allows you to specify the cell’s type characteristics during the design process. When you fill o
form, each cell value will be displayed with its preset type settings.

Like the title section, you can choose the font, font size, type style, leading, and alignment fo
cell in each field. To change the type attributes of a cell, first select it with the Field tool, then
the Type command or the Style submenus to choose a different setting. For a description of 
type attribute, see “Type Settings” in Chapter 7.
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You can also set the color with which a cell value displays. For more information, see “Data C
in Chapter 1 of your Informed Designer Forms Automation manual.

Informed Designer allows you to show or hide the cells in fields and tables. Choose Cell Names 
from the Show submenu under Layout to display the cell names and their tab positions. Whe
they’re showing, the menu command becomes Hide Cell Names. Choose this command to h
cell names and tab positions.

When visible, a cell’s name and tab order are displayed using the current type attributes of th
If you change a type attribute (for example, choose a different font or font size), the cell’s nam
tab position will change to reflect the new setting.

You can also use Informed Designer’s Test mode to enter sample cell values. This allows you
what a filled in cell will look like and to ensure that you’ve chosen the correct type settings. F
information about Informed Designer’s Test mode, see “Testing Your Form” in Chapter 1 of y
Informed Designer Forms Automation manual.

A field’s cell section also has many of the visual attributes of a rectangle. You can change the
and fill colors, and you can adjust the thickness of the cell’s frame. You can also change the a
of rounding on each corner. Before choosing a setting, make sure that you select the cell sec
first. For a complete description of pen, fill, and line width attributes, see “Paint Settings” in C
ter 7. For information about rounding corners, see “Rounded Corners” in Chapter 7.

You can add scroll bars to the fields on your form. This allows the Informed Filler user to ente
more data than will fit in the cell area. For more information, see “Field Settings” in Chapter 7
“Changing an Object’s Appearance.” 

The Rule Lines
Each field cell can use optional rule lines; these control the vertical spacing and provide a vis
guide for the information in a cell. You turn rule lines on and off using the Field command (se
“Field Settings” in Chapter 7).

Tab position Cell name
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When rule lines are on, you can select them by clicking any rule line with the Pointer tool. The
will shimmer when they’re selected. You can set the rule lines’ spacing by using the Field com
or by clicking and dragging any rule line with the Pointer tool.

You can also change the appearance of the rule lines by changing their pen and line width attr
To do this, select the rule lines, then use the Paint command or the Pen and Line Width subm
choose a different setting. For more information, see “Paint Settings” in Chapter 7.

Combs and Checkboxes
Informed Designer has comb and checkbox features that can be applied to field cells. Comb
divider lines that divide a cell into equally spaced sections. Checkbox cells use check symbo
instead of text to indicate a cell’s value. For more information, see “Combs” and “Checkboxe
Chapter 7, “Changing an Object’s Appearance.” 

The Table Tool
Like fields, tables are graphic objects that hold information. Each table contains one or more
umns and each column contains a cell—a holding place for data. When you fill out a form, yo
enter information into each cell.

Unlike other graphic objects such as lines, rectangles, and ovals, tables are composed of va
elements—or parts—that automatically appear when you draw a table. This makes it easy to 
table without having to draw the individual lines and titles that give a table its appearance. Th
structure of a table is shown below.

Note When rule lines are on, the leading of a cell’s information is controlled by the rule line spac
and not by the leading type attribute.

The Table Tool

Click and
drag...

...release
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There are a variety of options that allow you to change the general appearance of any table.
example, you can show or hide the table title or column titles, or fill the alternating column ro
with a color.
 

In this section you’ll learn about the graphical aspect of tables; that is, you’ll learn how to dra
tables and how to change their appearance. For information about the data intelligence attrib
table cells, see Chapter 1 of your Informed Designer Forms Automation manual.

Drawing a Table

To draw a table, select the Table tool by clicking it on the Tool palette. Then position the poin
the drawing area; the pointer changes to a cross. Click where you want a corner of the table 
and drag to the opposite corner. If you hold down the Shift key, the new table’s dimensions w
constrained to a square (all sides will be of equal length). When you release the mouse butto
table is drawn, and the Add Columns dialog box appears.

Table title section Column title section

Column section

Row lines

Title dividers

Rows
alternately
filled Single

column

Table title
hidden
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Type the number of columns that you want and click ‘OK.’ Informed Designer inserts the colu
into the table and distributes them evenly. If the columns in the table need to be different wid
you can change them individually to suit your needs (see “Changing a Column’s Width”).

Once you’ve drawn a table, you can add and delete columns and change their widths and or
These features are described in the following sections.

When you draw a new table, its initial appearance is determined by the current default settin
the Table tool. For example, if the default font for the Table tool is Helvetica, then the font use
any subsequently drawn tables will be Helvetica. For instructions on changing the Table tool 
defaults, see “Setting Field and Table Defaults” in Chapter 7.

Selecting Parts of a Table

Clicking a table once selects the whole object. Clicking a second time selects a part of the tab
example, click a table on your form using the Pointer tool, and handles appear on the corner
indicate that the whole table is selected. Next, click in the cell section of one of the columns.
shimmering frame appears inside the cell section, indicating that it is selected.

Changing a Column’s Width

You can change the width of a column by clicking and dragging either of its sides with the Po
tool. If you drag the left side of the leftmost column or the right side of the rightmost column, y
change the width of the table too.

...drag

...release

Click...
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If you change a column’s width by dragging a side that lies between two columns, the widths
both columns will change. As you drag, Informed Designer will display the width of the affect
columns below the bottom edge of the table. The measurements are shown using the curren
units. Informed Designer will constrain the pointer so that you don’t make a column too narro

If you hold down the Control (Windows) or Command (Mac OS) key while dragging a column
side, only the width of the column to the left (if there is one) will change. This allows you to s
columns in either direction. You can use this option to move columns to the left in a full table 
make room for new columns.

Adding New Columns to an Existing Table

You can add additional columns to an existing table in one of three ways:

■   by using the Add Columns command

■   by first making room in the table, then clicking with the Pointer tool

■   by splitting one column into two

To add additional columns by using the Add Columns command, first select the table by click
once with the Pointer tool, then choose Add Columns... from the Table Columns submenu under 
Arrange. When the Add Columns dialog box appears, type the number of new columns that 
want to add and click ‘OK.’ If the existing table has a gray space at the right side, the new co
will fill that space. If there is no gray space, the last column will be divided to accommodate t
number of new columns. If the gray space or the last column is not wide enough to fit in the nu
of new columns, Informed Designer will alert you with a message. If this occurs, simply make
room in the table and try adding the columns again.
 
You can make room for a new column either by extending the right edge of the table or by m
the width of an existing column smaller. Extending the right edge of a table by default extend
right edge of the last column as well. However, if you hold down the Control (Windows) or Co
mand (Mac OS) key while extending a table’s right edge, the size of the last column doesn’t 
change.

Click... ...drag
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Similarly, if you press the Control (Windows) or Command (Mac OS) key while shrinking the 
width of an existing column, only the width of the column to the left (if there is one) will chang
The columns on the right will slide to make more room in the table. The table will then contai
gray area in which you can create a new column. With empty space in a table, you can add a
column by simply clicking in the gray area with the Pointer tool.

You can also create a new column by splitting an existing column into two. Select the column
clicking it (twice if necessary) with the Pointer tool, then choose Split Column from the Table Col-
umns submenu under Arrange.

If the existing column is too narrow to be split, Informed Designer will sound a beep.

Hold down the Ctrl/Cmd key
as you click and drag...

...to create room for
more columns.

Select a column, then choose
the Split Columns command...

...a new column is inserted
to the right of the last column.
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Changing a Column’s Position

Informed Designer allows you to change the ordering of columns in a table. To move a column
click it or click its title with the Pointer tool, then choose Move Left or Move Right from the Table 
Columns submenu under the Arrange menu. The column is swapped with the one to its imm
right or left.

Once a column reaches either end of the table, choosing a command to move it further in tha
tion does nothing.

Distributing Columns

Often you might want to make the width of all or some of the columns in a table the same. 
Although you can do this manually by adjusting the size of each column, Informed Designer 
vides a command to distribute columns automatically.

To evenly distribute all the columns in a table, select the table by clicking it with the Pointer to
then choose Distribute Columns from the Arrange menu.

If there’s only one column in your table, the Distribute Columns command makes the column
wide as the entire table.

If you select Cell2 and
choose Move Left...

...it will change positions
with Cell1

Before distributing columns...

...after distributing columns
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Removing a Column

You can remove a column the same way you remove any object on your form: select it, then c
Clear from the Edit menu or press either of the Delete or Backspace keys. The table is selecte
you remove the column. Any columns to the right of the deleted column are moved left to tak
the space originally occupied by the deleted column.

The Appearance of Tables

A table consists of various parts that are automatically drawn, positioned, and resized as the 
manipulated. The appearance of a table can be changed by changing the position, size, or v
attributes of each part. The Pointer tool is used to select a part or change the dimensions of a
dragging. The Table command allows you to control the options associated with each part.

Although the Table command is referred to throughout this section, a complete description o
use is not covered here. See “Table Settings” in Chapter 7 instead.

The Title Sections
Each table has a table title and a column title for each column. A title section commonly cont
descriptive identifier of the information stored in the table or column. A title section consists o
frame and the title’s text. To select a title section, click it (twice if necessary) with the Pointer 
An inset frame in the section will shimmer.

The title sections of a table can be turned on or off using the Table command.
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To edit the text of a table title, use the Text tool and the appropriate text editing techniques (s
“The Text Tool” earlier in this chapter for more information). Like all text objects, the title sect
has font, font size, type style, leading, and alignment attributes. Use the Type command or th
submenus to change these attributes.

A table’s title section has many of the visual attributes of a rectangle. You can change the pe
fill colors, and you can adjust the thickness of the title’s frame. You can also change the amo
rounding on each corner. For a complete description of the pen, fill, and line width attributes,
“Paint Settings” in Chapter 7. For information about rounding corners, see “Rounded Corner
Chapter 7

The Title Dividers
If any of the title sections are on, the table will also have title dividers. These are the lines tha
divide either the table title from the column titles, or the column titles from the column cells.

Like other parts of a table, you can select a title divider by clicking it with the Pointer tool; the
will shimmer. Once you’ve select a title divider, you can change its pen or line width. If you wa
hide the line altogether, change its pen to none.

To change a title section’s height, use the Pointer tool to drag the title divider up or down. If y
drag a column’s title divider, Informed Designer will automatically adjust the dividers of all oth
columns as well. You can also click and drag the top edge of the table’s title section while ho
down the Control (Windows) or Command (Mac OS) key to change the title section’s height.

The Column Sections
Like blanks on a form, the column sections are the parts of a table where you enter informat
Each column section has a column cell (which is divided into rows) and a frame. To select a c
section, click it with the Pointer tool. An inset frame in the column section will shimmer.

Note Unlike text objects, title sections can also be vertically aligned. For more information, see 
“Type Settings” in Chapter 7.

Table title and column
titles showing

Table title showing No title sections
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You can change the height of a column by clicking and dragging its bottom edge with the Po
tool. As you do this, Informed Designer constrains the increase or decrease of the column he
increments that equal the height of the rows in the table. This ensures that you don’t end up 
partial rows in your table. Holding down the Control (Windows) or Command (Mac OS) key w
clicking and dragging the column’s edge overrides this feature.

Even though you can’t see a column’s text until you fill out the form, Informed Designer allows
to specify a column’s type characteristics as you design your form. When you fill out your form
values in any column will appear with the type settings that you chose for that column.

Like the title sections of a table, you can choose the font, font size, type style, leading, and a
ment for each column in a table. To change the type attributes of a column, first select the co
with the Pointer tool, then use either the Type command or the Style submenus to choose a d
setting. When you choose a different setting, the type style of the cell’s name and tab order i
selected column will change to reflect the new setting. For a complete description of each typ
attribute, see “Type Settings” in Chapter 7.

You can also set the color with which a cell value displays. For more information, see “Data C
in Chapter 1 of your Informed Designer Forms Automation manual.

A column section also has many of the visual attributes of a rectangle. You can change the p
fill, and you can adjust the thickness of the column’s frame. You can also change the amount
rounding on each corner. Before choosing a setting, make sure that you select the column se
first. For a complete description of the pen, fill, and line width attributes, see “Paint Settings” 
Chapter 7. For information about rounding corners, see “Rounded Corners” in Chapter 7.

Shimmering frame
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The Row Lines
The row lines in a table determine the vertical spacing of the data in each column. You can s
the row lines by clicking any of them with the Pointer tool. The lines will shimmer when they’r
selected.

You can change the spacing of the row lines by using the Table command or by clicking and
ging any row line with the Pointer tool. Informed Designer will make sure that you don’t make
row height too small.
 

Informed Designer provides a feature that allows the spacing of the row lines to expand auto
cally when the Informed Filler user enters more data than the chosen row spacing can displa
can also include scroll bars on the tables on your form. When a table is ‘scrollable’ Informed 
automatically adds new rows when the Informed Filler user enters more data than the table c
play. For more information on these features, see “Table Settings” in Chapter 7, “Changing a
Object’s Appearance.”

You can change the appearance of the row lines by changing their pen and line width attribu
do this, select the row lines and then use the Paint command or the Pen and Line Width sub
to choose a different setting. You can also change the appearance of each alternating row by
them with a color. To do this, click the ‘Fill alternating rows with’ drop-down list on the Table S
tings dialog box, and choose an appropriate fill color from the color palette.

For more information about pen, fill, and line width attributes, see “Paint Settings” in Chapter

Click and drag up
or down to change
the row spacing.
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Combs and Checkboxes

Informed Designer has comb and checkbox features that can be applied to table cells. Comb
divider lines that divide a cell into equally spaced sections. Checkbox cells use check symbo
instead of text to indicate a cell’s value. For more information, see “Combs” and “Checkboxe
Chapter 7, “Changing an Object’s Appearance.”
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7Changing an Object’s Appearance
After drawing an object, you can change its appearance by changing any of its visual attribut
visual attribute is a setting that controls a particular characteristic of an object. Each different
of object has a different set of visual attributes. For example, line objects have pen, line width
line style attributes. Changing any of these attributes changes a line’s appearance.

In this chapter you’ll learn how to change an object’s visual attributes by using a variety of 
Informed Designer’s commands. You’ll also learn how to change the settings for new objects
more information about objects and how to draw them, see Chapter 6, “Drawing Tools.”

Overview
You change an object by selecting it and choosing a different setting from either a settings di
box or a submenu. The following table summarizes the commands that are used to control th
ous attributes of an object.

When you choose any of the above commands, a dialog box appears showing the current set
any selected object. For example, choosing the Paint command displays the Paint Settings d
box.

Overview

Menu Command Description

Style

Settings

Paint
Type
Corners

Combs

Checkbox
Field

Table

Object

Controls paint attributes such as pen, fill, line width, and line style
Controls type attributes such as font, font size, and type style
Controls the roundness of corners

Controls the number and height of comb dividers in a field or table 
cell
Controls the style and dimensions of checkboxes
Controls field attributes such as title position and size, rule lines, an
scroll bars
Controls table attributes such as titles, row separation, tabbing, and
scroll bars
Used to lock an object’s settings and position
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You can choose a different setting by clicking the various controls on the dialog box or by ent
new values in the text entry box. Clicking ‘OK’ dismisses the dialog box and changes the sele
object. You can cancel the dialog box by clicking ‘Cancel’ instead.

When you choose a settings command, Informed Designer enables only the controls that co
spond to the attributes that apply to the selected object (or objects). For example, if you selec
and choose the Paint command, the fill and graduation controls are unavailable because line
have these attributes. When a control is unavailable, it appears gray and is unavailable.

Using Submenus

In addition to the various settings dialog boxes, you can also choose new settings using the 
menus found in the Style menu. Each submenu contains settings for a particular attribute. N
attributes are available in the submenus and, for some attributes, you can choose from only 
standard settings.

It’s often more convenient to use a submenu when you want to change only one attribute of a
object. For example, rather than using the Paint command to choose a different pen color, you
select a new setting from the Pen submenu instead.

To use a submenu, first choose it by clicking and dragging with the mouse until the item nam
selected. A submenu will appear to the right of the item name. While still holding down the m
button, drag the pointer over the desired setting and release the mouse button.
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When you release the mouse button, the new setting is chosen and the selected object is cha
check appears next to the current setting.

Using Pop-up Menus

Throughout this chapter you’ll learn about many of Informed Designer’s settings commands. T
commands are available in menus and are selected in the normal way: by using the mouse, 
typing keyboard equivalents where they exist.

On both Windows and Mac OS compatible computers, clicking the mouse button provides a 
cut to selecting various commands. With any tool selected, position the pointer over an objec
click the right mouse button (Windows) or click the mouse button while pressing the Ctrl key (
OS) to display a pop-up menu. The pop-up menu contains the settings commands that are a
ble to the type of object. For example, if you position the pointer over a text object and click t
right mouse button/Ctrl-mouse button, you’ll see a pop-up menu containing the Type, Paint, C
Copy, Clear, and Object commands.

To select a command, drag the pointer to highlight the command, then click or release the m
button.
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Changing Multiple Objects

Informed Designer allows you to change more than one object at a time. Simply select the o
that you want to change and use a command or submenu as described above. For informatio
selecting more than one object, see “Selecting Multiple Objects” in Chapter 8.

If you choose a command while two or more objects are selected, Informed Designer will sho
only the current settings that are common to all of the selected objects. If an attribute is set d
ently among the selected objects, the controls that you use to set the attribute will show a bla
value. For example, suppose that you select three lines, two of which have a line width of 1/2
and the other has a line width of 1 point. Suppose also that the pen and line style attributes a
same for all three lines. If you choose the Paint command, this dialog box will appear:

The line width drop-down list and text box are blank. This indicates that the line width setting
different among the selected objects. To choose a new setting, type a value in the text box, o
choose a value from the drop-down list, then click ‘OK’ to dismiss the dialog box. The attribut
changed to the new setting for each of the selected objects. If you leave the setting blank, Inf
Designer won’t change the attribute.

Dialog boxes use a variety of controls to present different attributes. These include text boxe
checkboxes, radio buttons, drop-down lists, and scrolling lists. The following figure illustrates
a blank or empty value is shown using various types of controls.
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Once you select a new setting (by clicking a control or entering a value in a text box), there’s
way to change the setting back to the blank value. If you want to avoid changing the attribute
must cancel the command by clicking ‘Cancel’ instead of ‘OK.’

Like the settings commands, the Style submenus also show the current settings of any selec
objects. If a checkmark appears in a submenu, you know that the corresponding attribute ha
same setting for each selected object. If a setting isn’t common to all the selected objects, no
mark will appear in the attribute’s submenu. To choose a new setting, simply make your choi
from the submenu.

Changing Default Settings

When you draw a new object, Informed Designer sets its visual attributes to the current default set-
tings. A default setting is automatically selected when a new object is drawn. For example, if
default line width attribute for lines is set to 1 point, each new line that you draw will (by defa
be 1 point wide.

When you create a new form, Informed Designer assigns it a predefined list of default setting
These settings are listed in Appendix A. You can change the default settings so that new obje
automatically appear with your preferred settings. For example, suppose that before drawing 
you know that the font of all text objects will be Times. Rather than changing the font each tim
you draw a new text object, simply change the default font for the Text tool to Times before y
start drawing. Each subsequent text object that you draw will be Times.

To change a default setting, first deselect all objects on your form, then choose a different set
the normal way—by using the commands or submenus in the Style or Settings menus. With 
Pointer tool selected, default settings are changed for all drawing tools. If a particular drawin
is selected, the default settings are changed for that tool only.

Text boxes don’t
show any values.

Radio buttons don’t
show any choices.

Drop-down lists don’t
show any values. 

Checkmarks in checkboxes
appear gray instead of black.
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When you use a command, the fact that you’re changing the default settings will be noted in
dialog box title. The figure below shows the Type command being used to change the defaul
tings for the Text tool.

You can also use the Style submenus to change default settings. If no objects are selected, 
submenus will show the current default settings for all tools if the Pointer tool is selected, or fo
currently selected drawing tool. Choosing a different setting changes the current default.

Setting Field and Table Defaults

There’s a second way to change the default settings for the Field and Table tools. If you dou
click either of these tools on the tool palette, Informed Designer will present a list of default s
to choose from.
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Choose a style by clicking the radio button next to your choice. After you make your selection
click ‘OK’ to change the default settings. To cancel the command, click ‘Cancel’ instead.

Locking an Object’s Settings

You can prevent the settings of an object from being accidentally changed by locking the set
You lock an object’s settings using the Object command. Select the object whose settings you
to lock, then choose Object... from the Settings menu. The Object dialog box appears.

Click the ‘Settings’ checkbox below the Lock heading, then click ‘OK’ to dismiss the Object dia
box. To cancel the Object command, click ‘Cancel’ instead.

When an object’s settings are locked, Informed Designer ignores any requests to change the
object’s appearance. When you choose a different attribute setting—for example, a new pen
color—only those selected object’s whose settings are not locked are affected.

For information about the other settings available on the Object dialog box, see “Locking an 
Object’s Position” and “Objects and Printing” in Chapter 8.
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Paint Settings
All objects have paint attributes which determine their color and the appearance of their lines
filled areas. This section describes paint attributes and how to select them. For information a
drawing objects, see Chapter 6, “Drawing Tools”.

Informed Designer offers two methods for changing paint attributes: the Paint command, and
Pen, Fill, Line Width, and Line Style submenus under Style. To use the Paint command, sele
object or part that you want to change, then choose Paint... from the Style menu. The Paint Setting
dialog box appears.

Choose a setting by clicking a control or entering a new value, then click ‘OK’ to commit the 
change and dismiss the dialog box. To cancel the command, click ‘Cancel’ instead.

In the Style menu, the Pen, Fill, Line Width, and Line Style submenus offer a convenient met
for changing a single paint attribute. To choose an attribute, select the object or part that you
to change, then make your selection from the appropriate submenu.

Colors

The pen and fill attributes for an object are set by choosing colors from the color palettes fou
either on the Paint Settings dialog box, or in the Pen and Fill submenus under Style. The num
colors available on these color palettes depends on the number of colors your computer is c
of displaying. The following table shows how many colors will be available for computers tha
capable of less than 16 colors, between 16 and 255 colors, and 256 or more colors.

Paint Settings
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Number of Colors on the Color Palette

Pen

The pen determines the color of lines, text, and the frames of enclosed objects. All types of ob
have a pen attribute. You can set the pen to ‘none’ or any one of a variety of colors. The ‘none
is invisible and transparent.

To choose a pen color for an object, first select the object, then choose Paint... from the Style 
menu. When the Paint Settings dialog box appears, click the pen drop-down list and choose 
from the color palette.

Another convenient way to set the pen color is to choose the Pen submenu under Style, and
a color from the color palette. The number of colors available on the color palette depends o
number of colors your computer is capable of displaying. See “Colors” for more information.

Though it is uncommon, you can also set a pen pattern by choosing a pattern from the drop-
list on the Paint Settings dialog box. The pattern options are not available in the Pen submen

You can also set the pen attribute for multiple objects at once, and for each new object that y
draw. For more information, see “Changing Multiple Objects” and “Changing Default Settings

Color Capability The Color Palette Displays

less than 16 colors

16 to 255 colors

256 or more colors

Shades of grey (10, 25, 40, 50, 60, 75, 90, 100) and the standard colo
red, green, blue, magenta, yellow, and cyan. The ‘none’ color is also 
included.

15 colors (combination of grays and colors) and ‘none.’

87 colors and ‘none.’

Note Since the standard colors cannot be represented accurately for the ‘less than 16 colors’ gr
(especially for black and white displays), the color palette shows textual labels of the color
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Fill

The fill  determines the appearance of a shape’s interior. You can fill any enclosed object with
choice of fill color, pattern, and graduation.

Fill Color
To choose a fill color for an object, first select the object, then choose Paint... from the Style menu. 
When the Paint Settings dialog box appears, click the fill color drop-down list, and choose a 
from the color palette. Another convenient way to set the fill color is to choose the Fill subme
under Style, and choose a color from the color palette. The number of colors available on the
palette depends on the number of colors your computer is capable of displaying. See “Color
more information.

You can also set the fill color for multiple objects at once, and for each new object that you d
For more information, see “Changing Multiple Objects” and “Changing Default Settings”.

Fill Patterns
In addition to the fill color, objects can also have a fill pattern. This is useful for covering area
form where typing must be hidden. There are 40 different fill patterns to choose from. The fig
below shows several sample fill patterns.

To choose a fill pattern for an object, choose Paint... from the Style menu. When the Paint Setting
dialog box appears, click the fill pattern drop-down list and choose a pattern.

The fill pattern option is not available in the Fill submenu under the Style menu.

Graduated Fills
The fill colors of rectangles, fields, and tables can be graduated. A color that’s graduated blends 
from one color to another.
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To create a graduated fill color for an object, first select the object, then choose Paint... from the 
Style menu. The Paint Settings dialog box contains the controls for specifying both the color 
direction of the graduation. Using the object’s fill color as the starting point, click the ‘Graduat
checkbox, and then click the drop-down list and choose a color to graduate to. Next, click eith
horizontal (left to right) or vertical (top to bottom) controls to specify the direction in which the
will graduate.

The graduated fill option is not available in the Fill submenu under Style.

Line Width

Each line and enclosed shape has a line width. The line width determines the thickness of a line or 
shape’s boundary. When setting the line width attribute for an object, you can choose one of

Field with cell graduated
from top to bottom

Table columns graduated
from left to right

Rectangle
graduated from
right to left

Rectangle
graduated from
bottom to top

Select a starting value here.

Select an ending value here.

Choose the graduation
direction here
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Informed Designer’s standard line widths or you can create a custom line width by entering a
on the Paint Settings dialog box.

To choose a line width for an object, first select the object, then choose Paint... from the Style 
menu. When the Paint Settings dialog box appears, click the line width drop-down list and cho
line width. You can also type a value in the text box provided.

Another convenient way to set the line width is to make a selection from the Line Width subm
list under the Style menu.

Line Style

Lines and rectangle frames can be drawn using a variety of line styles. Line styles are group
three types: solid or dashed, single or double, and arrowhead. Different line styles are shown

To select a line style, choose Paint... from the Style menu and make your selection by clicking 
either of the two line style drop-down lists. Another convenient way to select a line style is to m
a selection from the Line Style submenu under Style. The Line Style submenu is divided into

6 point 4 point 2 point 1 point

To change the line width, select
a value from the drop-down list...

...or type a value
into the text box

Dashed ArrowheadDouble
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sections. The top section contains the solid and dashed styles, and the bottom section conta
single, double, and arrowhead styles.

You can combine different line styles with other attributes such as pen colors and line widths
example, you could choose a double-dashed line style with a red pen.

Type Settings
You change the appearance of text by changing attributes such as the font, font size, and typ
In addition to text objects, field and table titles also have type attributes. For information abou
drawing and editing text, fields, and tables, see Chapter 6, “Drawing Tools”.

Informed Designer offers two methods for changing type attributes: the Type command, and 
Font, Size, Type Style, Alignment, and Leading submenus under Style. To use the Type com
select the object or characters that you want to change, then choose Type... from the Style menu. 
The Type Settings dialog box appears:

Choose a setting by clicking a control or entering a new value in a text box. Click ‘OK’ to dism
the dialog box. To cancel the command, click ‘Cancel’ instead.

The Font, Size, Type Style, Alignment, and Leading submenus offer a convenient method for
changing a single type attribute. To choose an attribute, select the object or characters that yo
to change, then make your selection from the appropriate submenu.

The Command Palette provides shortcuts to some of Informed Designer’s type settings. By cl
the appropriate icon on the Command Palette, you can change a text object’s style to ‘Bold’ a
alignment to ‘Left,’ ‘Center,’ ‘Right,’ or ‘Justify.’

Type Settings
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For more information on the Command Palette, see “Using Palettes” in Chapter 5.

Font

Each font is identified by its name and a unique typeface. Only fonts that are installed on your
puter will appear both in the Type Settings dialog box drop-down list and in the Font submen

To choose a font, select it from the drop-down list on the Type Settings dialog box, or from the
submenu.

Font Size

Font sizes range anywhere from 1 through 999 points. To choose a font size, select your choi
from the ‘Size’ drop-down list on the Type Settings dialog box or type a value in the text box.
can also choose a size from the Size submenu under Style.

Type Style

Type style refers to the style of a font. You can vary the appearance of each font by choosing 
up to eight different type styles. However, not all type styles are supported on both the Windo
and Mac OS platforms. The following table shows which type styles are supported on each p
form.

Type Styles for Windows and Mac OS

Each type style can be used individually or combined with others. For example, you could m
heading bold and then underline it for emphasis.

Note Certain fonts that are available on Windows may not be available on Mac OS (and vice ver
When designing form templates for cross-platform use, make sure you use fonts that have
tical names on both platforms.

Type Style Supported On

Plain
Bold
Italic
Underline
Condensed
Outline
Extended
Shadow

Windows and Mac OS
Windows and Mac OS
Windows and Mac OS
Windows and Mac OS
Mac OS
Mac OS
Mac OS
Mac OS
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To change the type style, choose Type... from the Style menu, then click the corresponding chec
boxes on the Type Settings dialog box. You can also choose a style from the Type Style subm
under Style. If you choose the Plain type style, all other type styles are turned off.

The Command Palette provides a shortcut for the bold type style only. To change an object’s
style to bold, select the object, then click the bold icon on the Command Palette.

Leading

Leading refers to the amount of space between lines of text. By default, Informed Designer a
matically separates one line from the next by enough space to hold the largest font size used
line.

To choose automatic leading, click the radio button labelled ‘Automatic’ on the Type Settings 
log box or select Auto in the Leading submenu under Style.

Alternately, you can enter a specific leading value if you want line spacing to be consistent. W
you use a fixed amount of leading, all lines are spaced equally.

When you use the Type Settings dialog box, click the ‘Leading by’ radio button, then enter (in
points) the leading amount in the text box. You can also choose a leading value from the Lea
submenu. The Leading submenu lists only a few common choices.

Alignment 

Alignment refers to the relative positioning of lines within a text object or title section. You can
align text along its left or right edge, or along its center. You can also justify text so that both th
and right edges align.

When you choose automatic
leading, each line is spaced
according to the largest
font size used in that
line of text

This is a sample
of twelve point leading.
All the lines are spaced
equally apart.

This is a sample

of eighteen point 

leading

You can left
align a text
object.

You can right
align a text

object.

You can align a
text object on

its center.

Or you can justify a
text object so both
sides align.
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Unlike text objects, the titles and cells of field and table objects can also be aligned vertically

Alignment is controlled by clicking the appropriate drop-down list in the ‘Alignment’ section on
the Type Settings dialog box, or by selecting a choice from the Alignment submenu under St

As a shortcut, you can change the horizontal alignment of text objects and field and table titl
clicking one of the alignment icons on the Command Palette.

Rounded Corners
You can round the corners of rectangles, buttons, and the rectangular parts of fields and tab
Informed Designer allows you to round corners individually. This means that each corner can
a different amount of rounding.

A corner can have up to 2 inches of rounding. The amount of rounding corresponds to the di
between the rectangle’s edge and the end of the arc that forms the corner. The corner shown
has 0.5 inches of rounding.

To round an object’s corners, first select the object or part that you want to change. Then cho 
Corners... from the Style menu. The Rounded Corners dialog box appears:

Rounded Corners

0.5 "

0.5 "
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To round all of an object’s corners, click the ‘All corners’ radio button and enter a value in the
responding text box. To round individual corners, click the ‘Individual corners’ button and ente
values in the text boxes at each corner of the sample rectangle. After entering your choice, c
‘OK.’ To cancel the Corners command, click ‘Cancel’ instead.

The rounding values are always displayed in the current ruler units. However, you can enter t
ues in any units you like; Informed Designer will automatically convert the value for you. For 
example, if the current ruler unit is ‘inches’, you can enter ‘2.54 cm.’ After you press the Tab k
Informed Designer will convert that value to 1 inch and display it as such in the text box.

Field Settings
You can change the appearance of fields with the Field command and the Pointer tool. Use th
tool to draw a field and the Pointer tool to select and manipulate its parts. You use the Field c
mand to control the options associated with fields. This section describes the Field command
information about drawing fields and the parts of fields, see “The Field Tool” in Chapter 6.

To use the Field command, select the field that you want to change, then choose Field... from the 
Settings menu. The Field Settings dialog box appears.

Field Settings
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The Field Settings dialog box is divided into four sections: Title, Rule lines, Scrolling, and Sam
The Sample section displays the results of the choices that you make. After changing the se
click ‘OK.’ To dismiss the dialog box and cancel the Field command, click ‘Cancel.’ The contr
on the Field Settings dialog box are described in the following sections.

Title

Click the ‘Title’ checkbox to turn the field title on or off. When the title is on, you can choose i
position by clicking any of the ‘Top,’ ‘Left,’ ‘Bottom,’ or ‘Right’ radio buttons. You can set the 
height of the title section by typing a value in the ‘Height’ text box. (You can also change the h
of a field’s title section by using the Pointer tool to move the title divider or to drag the title se
tion’s edge. See “The Field Tool” in Chapter 6 for more information.)

Rule lines

You can divide a field into lines using the rule lines option. Click the ‘Rule lines’ checkbox to 
this option on or off. When rule lines are on, you can specify the line spacing using the contro
the Field Settings dialog box, or by clicking and dragging any line using the Pointer tool. See
Field Tool” in Chapter 6 for information about manipulating rule lines by dragging.

You can enter the rule line spacing using one of four methods. Choose a method by clicking 
‘Line separation’, ‘Lines per inch’, ‘Lines in field’, or ‘Match font size’ options, then enter a va
in the text box below the radio buttons. When you use the ‘Line separation’ option, enter the 
distance that you want between each rule line. Enter either the number of lines per inch or th
ber of lines in the field, respectively, when you use either of those two options. Values are disp
in the current ruler units, but you can enter values in any units you like; Informed Designer wi
form the conversion for you.
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If you use the ‘Match font size’ option, Informed Designer will set the rule line spacing to mat
the height of the font size that you’ve chosen for the cell section in the field. If you change the
size for that cell, Informed Designer will automatically adjust the rule line spacing to match th
new font size.

Scroll Bar

You can include scroll bars on the fields on your form. This allows the Informed Filler user to 
more data than will fit in the visible area of the cell section.

To include a scroll bar on a field, click the ‘Include scroll bar’ option on the Field Settings dial
box. A scroll bar is attached to right edge of the field.

If you include a scroll bar on a field, Informed Designer allows you to decide whether the scro
will be displayed always, or only when the Informed Filler user tabs into that field. Seeing a s
bar on a field is an indication to the person filling out the form that the field can contain more
than will fit in the cell. Furthermore, an active scroll bar indicates that the field actually does c
tain more data. To make a scroll bar always visible, click the ‘Show always’ checkbox on the 
Settings dialog box.

In some cases, it might not be appropriate to have scroll bars visible at all times. For exampl
forms that must match a pre-defined layout (such as a government form) might not have roo
visible scroll bars. For these instances, you can set the scroll bar on a field to display only wh
user tabs into that field. This allows you to design your form without having to leave space fo
scroll bars that you include. When the person filling out the form tabs into a field that include
scroll bar, the scroll bar appears to the right of the field and overlaps any objects that are alig
next to it. As soon as the user tabs out of the field, the scroll bar disappears, leaving the layou
form unchanged. To choose this option, turn the ‘Show always’ checkbox off.

When a form that contains scrolling fields is filled out and printed, Informed Filler repeats the 
ing of the page or pages that contain the scrolling fields, until all the data in those fields has 
printed. For example, if page 2 of a two page form contains one scrolling field, Informed Filler
print page 1, then page 2, then page 2 again until all the data in the scrolling field has been p
The extra copies of page 2 will contain only the data in the scrolling field; all other fields and t
will print blank.

Scroll bar
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Table Settings
You can change the appearance of tables using either the Table command or the Pointer too
the Table tool to draw a table and the Pointer tool to select and manipulate its parts. You use
Table command to control the options associated with tables. This section describes the Tab
mand. For information about drawing tables and the parts of tables, see “The Table Tool” in C
ter 6.

To use the Table command, select the table that you want to change, then choose Table... from the 
Settings menu. The Table Settings dialog box appears.

The Table Settings dialog box contains the options for a table’s titles, rows, and tabbing orde
sample table illustrates the results of the choices that you make. After changing the settings,
‘OK’ to change the selected table. To cancel the Table command, click ‘Cancel’ instead. The 
trols on the Table Settings dialog box (with the exception of the tabbing options) are describe
below. For information about the tabbing options, see “Tabbing in Tables” in Chapter 1 of you
Informed Designer Forms Automation manual.

Titles

You can show or hide the title of a table or its columns. Click either of the ‘Show table title’ or
‘Show column titles’ checkboxes to turn the corresponding sections on or off. The sample tab
changes to show your choices. You can set the height of the table or column titles by typing a
in the appropriate checkbox on the Table Settings dialog box. Values are displayed in the cur
ruler units, but you can enter values in any units you like; Informed Designer will perform the
version for you. You can also change the height of the title sections by using the Pointer tool 

Table Settings
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move the title divider, or to drag the title section’s edge. See “The Table Tool” in Chapter 6 for 
information.

Rows

Each table is divided into rows. You can change the distance between each row by clicking a
dragging any row line with the Pointer tool, or by entering a value on the Table Settings dialo

You can enter the row spacing using one of three methods. Choose a method by clicking the
separation’, ‘Rows per inch’, or ‘Rows in table’ options, then enter a value in the text box below
radio buttons. When using the ‘Row separation’ option, enter the actual distance that you wa
between each row line. When you use the other two options, enter either the number of rows
inch, or the number of rows in the table, respectively. Values are displayed with the current ru
units, but you can enter values in any units you like; Informed Designer will perform the conve
for you.

You can also change the color of each alternating row on a table. For more information, see 
Appearance of Tables” in Chapter 6, “Drawing Tools.”

Expandable Rows
Informed Designer also provides a feature that allows the spacing of the row lines to expand
matically when the Informed Filler user enters more data than the chosen row spacing can d
To make your table rows ‘expandable’, click the ‘Expandable rows’ option on the Table Settin
dialog box. Choosing this option makes all the rows in a table expandable, but only the rows
contain extra data are affected. For example, if only one row in a table contains more informa
than it could normally display, only that row will expand. The other rows will retain their origin
spacing.

If all the rows in a table already contain data, Informed Filler will not allow the person filling o
the form to expand any rows in the table, since doing so would cause the last row of the table
appear. The Informed Filler user will be alerted with a message.

The row containing extra data
expands, while the other rows
retain their original spacing.
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Scroll Bar
You can include scroll bars on the tables on your form. When a table is ‘scrollable’ Informed F
automatically adds new rows to the table as the Informed Filler user enters more data than th
can display.

To include a scroll bar on a table, click the ‘Include scroll bar’ option on the Table Settings dia
box. A scroll bar is attached to the right edge of the table.

If you include a scroll bar on a table, Informed Designer allows you to decide whether the scro
will be displayed always, or only when the Informed Filler user tabs into that table. Seeing a 
bar on a table is an indication to the person filling out the form that the table can contain mor
than will fit in the column sections. Furthermore, an active scroll bar indicates that the table a
ally does contain more data. To make a scroll bar always visible, click the ‘Show always’ chec
on the Table Settings dialog box.

In some cases, it might not be appropriate to have scroll bars visible at all times. For exampl
forms that must match a pre-defined layout (such as a government form) might not have roo
visible scroll bars. For these instances, you can set the scroll bar on a table to display only wh
user tabs into that table. This allows you to design your form without having to leave space fo
scroll bars that you include. When the person filling out the form tabs into a table that include
scroll bar, the scroll bar appears to the right of the table and overlaps any objects that are ali
next to it. As soon as the user tabs out of the table, the scroll bar disappears, leaving the lay
the form unchanged. To choose this option, turn the ‘Show always’ checkbox off.

When a form that contains scrolling tables is filled out and printed, Informed Filler repeats th
printing of the page or pages that contain the scrolling tables, until all the data in those table
been printed. For example, if page 2 of a two page form contains one scrolling table, Informe
Filler will print page 1, then page 2, then page 2 again until all the data in the scrolling table h
been printed. The extra copies of page 2 will only contain the data in the scrolling table; all o
fields and tables will print blank.

Scroll bar
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Combs
Combs are lines that divide the character spacing of fields and tables into equally spaced se
Use the Combs command to specify the number and height of combs in a field or table cell.

To add combs, first select the cell in the field or table, then choose Combs... from the Settings 
menu. The Comb Settings dialog box appears:

Click the ‘Combs’ checkbox to turn comb lines on or off. When combs are on, you can enter 
number of divisions in the text box provided. Furthermore, you can adjust the height of each 
line individually. To do this, click the ‘Set Heights’ button. The Comb Heights dialog box appe

Using this dialog box, you can click and select each comb divider in the scrolling list, then en
different value in the text box below the list. To change more than one divider line at a time, s
each one while holding down the Control (Windows) or Command (Mac OS) key, then enter 
new value.

You can measure comb heights in either percentage of cell height, or points. If you use the p
age of cell height option, the comb heights will automatically adjust when you resize the field
cell. Set the comb height by clicking either the ‘%’ or ‘Points’ radio button, then enter a value i

Combs



Changing an Object’s Appearance 7-25

 .
 .

 .

om-

of a tex-
.

se 

x 
f the 
t 
mes-

n click 

e 
bout 
.

text box. Click ‘OK’ when you’re finished changing the comb heights. To cancel the Combs c
mand, click ‘Cancel.’

Checkboxes
Fields and table columns that are configured as checkboxes display a check symbol instead 
tual value. Use the Checkbox command to configure a field or a table column as a checkbox

To configure a checkbox, select the field or table column that you want to change, then choo
Checkbox... from the Settings menu. The Checkbox Settings dialog box appears.

Click the ‘Checkbox’ option to turn the checkbox setting on or off. After you turn the checkbo
option on, choose a checkbox style from the ‘Style’ drop-down list. Specify the dimensions o
checkbox by typing values in the ‘Height’ and ‘Width’ text boxes. If you enter a dimension tha
exceeds the size of the cell that holds the checkbox, Informed Designer will alert you with a 
sage.

As a shortcut to the Checkbox command, you can also select a field or table column, and the
the checkbox button on the Cell palette.

The selected field will display a checkbox with the default style and size; that is, a plain fram
measuring 0.1667 inches by 0.1667 inches, with an ‘X’ check symbol. For more information a
the Cell palette, see “Using the Cell Palette” in Chapter 1 of your Informed Designer Forms 
Automation manual .

Checkboxes

Checkbox button
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Informed Filler stores a different value for each of the checked and unchecked settings of a c
box cell. The values that correspond to checked and unchecked depend on the cell’s type. T
lowing table lists each cell type and the corresponding checked and unchecked values. Note
checkboxes do not work with picture and signature cells.

Checked and Unchecked Values

If checkboxes are used in a table column, the checkbox frame does not appear until the pers
ing out the form tabs into that cell. After a value is entered and the users tabs out of the cell, 
checkbox frame disappears again, but the checkmark remains visible.

Clustering Checkboxes

Checkboxes often appear grouped to offer a variety of choices. For example, you might show
ferent payment methods on a sales slip using a group of checkbox cells.

Only one option can be checked. Normally, to change the payment method from one choice 
another, you’d have to uncheck the current setting and then check the new method.

You can use the Cluster command to group a set of checkbox cells in this manner. This is dif
from grouping objects with the Group command. When you cluster two or more checkbox ce
Informed Filler will automatically uncheck the currently checked cell when the user selects a d
ent cell in the cluster.

To cluster a set of checkboxes, select the cells you want clustered, then choose Cluster from the 
Arrange menu. You can view which cells participate in a cluster by clicking any cell with the 
Pointer tool and choosing the Cluster Information... command. A dialog box appears listing all 
cells that are currently clustered with the selected cell.

Cell Type Checked Value Unchecked Value

Text
Character
Number
Name
Date
Time
Boolean
Picture
Signature

“True”
“True”
1
“True”
“Current Date”
“Current Time”
True
n/a
n/a

“False”
“False”
0
“False”
No Value
No Value
False
n/a
n/a
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To remove a cell from a cluster, select it in the list, then click the ‘Uncluster’ button.
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8Manipulating Objects
Informed Designer provides a variety of commands and features that allow you to manipulate
objects. This chapter describes how to select, reposition, and resize objects with the Pointer
You’ll also learn how to manipulate objects using the commands in Informed Designer’s Arra
menu, and how to use the Specs palette and the Clipboard.

Selecting Objects
Before you can manipulate an object on your template, you must select it first. With Informed
Designer, you can select objects in one of two ways: by using the Pointer tool, or by using th
object selection commands (Select All and Select Same) in the Edit menu.

Using the Pointer Tool 

The Pointer tool selects objects in a variety of ways. Before you can use the Pointer tool, you
first select it on the tool palette. Since the Pointer tool is used regularly, Informed Designer of
shortcut for selecting it. In addition to clicking it on the tool palette, you can select the Pointer
by pressing the key located at the top-left corner of your keyboard (either Escape or ‘`’). You 
also select it temporarily by holding down the Alt (Windows) or Option (Mac OS) key. See “Th
Tool Palette” in Chapter 6 for more information.

Selecting a Single Object 

You can select a single object either by clicking it with the Pointer tool, or by drawing a selec
rectangle around it.

To select an object by clicking, position the pointer over the object and click the mouse butto
Handles appear on the object’s corners to indicate that it’s selected.

Selecting Objects

Note When more than one object on your drawing is selected, all subsequent object manipulatio
that you perform are applied to all of those objects. Make sure that you select the right obj
before you choose a command.
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To select an object by drawing a selection rectangle, position the pointer outside of the objec
click and drag the mouse to surround the object with a selection rectangle. When the object is com-
pletely enclosed, release the mouse button.

Selecting Multiple Objects

You can select multiple objects by Shift-clicking the individual objects, or by drawing a select
rectangle around them.

To select objects by Shift-clicking, hold down the Shift key as you click the individual objects.
Holding down the Shift key causes any previously selected objects to remain selected.

To select objects using a selection rectangle, position the pointer outside of the objects that 
want to select, then click and drag the mouse to completely enclose them. This technique is 
when the objects you want to select are positioned near each other on your template.

Forcing a Selection Rectangle

Often you might want to draw a selection rectangle to select one or more objects that are pos
in front of other objects on your template. If the objects behind those that you want to select 
other areas of your template, you might unintentionally select and drag one of them when yo
attempt to draw the selection rectangle.

To prevent this from happening, hold down the Alt (Windows) or Option (Mac OS) key while d
ing the selection rectangle. The Pointer tool will act as though there are no objects under the
tion where you click to begin drawing the selection rectangle.

If you hold down the Alt (Windows) or Option (Mac OS) key to force a selection rectangle, all
objects that are completely enclosed within the rectangle will be selected when you release 
mouse button. If you hold down the Alt and Control (Windows) or Option and Command (Mac
keys instead, all objects that intersect the drawn rectangle will be selected. 

Selecting Through Objects

When you click the pointer to select an object, the front most object that lies below the pointe
selected. Often you might want to select an object that is obscured by other objects. Instead 
ing these objects to reveal the object that you want to select, use the Control (Windows) or C
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mand (Mac OS) key to select through an object. Each time you select while pressing the Con
Command key, the object immediately behind the one currently selected is chosen.

For example, if you draw an oval over top of a rectangle and select the oval, clicking the oval 
while holding down the Control/Command key causes the rectangle to be selected instead.

When selecting through an object, the pointer must be positioned over the region where the 
overlapping objects intersect.

The Select All and Select Same Commands

Use the Select All and Select Same commands to select objects on the current page of your
plate.

Select All
The Select All command selects all the objects on the current page of your template. Functio
this command is equivalent to selecting all objects with the Pointer tool. To use this comman
choose Select All from the Edit menu.

Select Same
The Select Same command selects all objects of given type. For example, if a rectangle and
are currently selected, then the Select Same command will select all other rectangles and lin
the current page of your template.

To use the Select Same command, first select one or more objects on your template, then ch
Select Same from the Edit menu. Informed Designer will select all remaining objects on the c
rent page of your template that are of the same type as the ones you originally chose.

The Select Same command works differently when you work with fields or tables. If you’re ed
a field or a table, and a part of that object is selected (such as a cell or dividing line), then the

Clicking a selected object while holding
down the Control/Command key...

...selects the object behind it.
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Same command will select the same parts in all other fields or tables on the current page of 
template.

Deselecting Objects

To deselect all currently selected objects on your template, click on an area of your template
contains no objects, or double-click the Pointer tool on the tool palette.

To deselect a particular object on your template, click the object with the Pointer tool while ho
down the Shift key. All other currently selected objects will remain selected.

Clearing Objects
To clear an object from your template, first select it. Then clear it by using one of these meth

■   press the Backspace or Delete key

■   choose Clear from the Edit menu

■   choose Cut from the Edit menu

The Cut command places the selected object on the Clipboard and then clears it from your t
plate.

Clearing Objects

Choose the Select Same command...

Selected title section

...to select the same components on all other fields.
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Repositioning Objects
After drawing an object, you may want to reposition it to a different location on the page. An o
is repositioned by dragging it with the Pointer tool. Informed Designer gives you the choice of
the object is displayed as you drag. 

If you click and drag an object immediately, an outline of the object appears and follows the m
ment of the mouse as you drag. When you release the mouse button, the object is drawn at 
position.

Alternately, if you pause briefly before dragging the mouse, the pointer and all handles will d
pear and the object will be drawn in detail as you drag. This method is particularly useful for 
sitioning text because the text itself remains visible as you drag the mouse.

You can constrain the direction of dragging by holding down the Shift key. The object’s motion
be constrained in either the horizontal or vertical direction depending on the initial motion of 
mouse.

Object Guides

Informed Designer’s Object Guides feature makes it easy for you to align one object with ano
when dragging. To use this feature, click the object that you want to move, and drag it toward
object that you want to align it with. Drag the selected object until the pointer is over top of the
ond object and hold it there for a few seconds. Object guides appear around the second obje
remain there until you release the mouse button. As you position the selected object, it will s
the object guides to ensure perfect alignment with any edge of the second object.

Repositioning Objects

Click and drag...

...release
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Moving Objects Between Pages

Earlier in this chapter, you learned how to reposition objects by simply clicking and dragging 
from one position to another on a single page. Informed Designer provides a similar feature 
makes it just as easy to move objects from one page of your template to another.

To move an object from it’s current page to a different page, simply click and drag the object 
one of the page controls at the bottom of the drawing window. When a highlighted frame app
inside the page control, release the mouse button.

Note The Align and Distribute commands, as well as the Arrow keys, can be used to reposition 
objects. For more information, see “Aligning Objects”, “Distributing Objects”, and “Nudging
Objects” later in this chapter. 

Click and drag over
...hold it there for a few seconds
and the object guides appear.

top of the second
object...

Highlighted frame

Click and drag the object
onto a page control.
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If you drag an object onto the work or master page controls, Informed Designer moves the ob
the same position on that page and automatically displays the page. If your template has mo
two numbered pages, Informed Designer will display the Change Page dialog box when you
an object onto the numbered page control.

Enter the number of the page that you want to move the object to and click ‘OK.’ Informed 
Designer moves the object to the same position on that page and automatically displays the 

If your template only has two numbered pages, you won’t see the Change Page dialog box w
dragging an object between those pages. Instead, Informed Designer will automatically mov
object to the “other” page of your template. For example, if you drag an object from page 2 on
numbered page control, the object will be moved to page 1, and that page will be displayed. 
larly, when moving objects from the work or master page to a numbered page, the Change Pa
log box will only appear if there is more than one numbered page on your template.

This feature is particularly useful for moving a cell between pages, because you can do so w
deleting the cell as you would when using the Cut and Paste commands. Since Informed De
will not allow you to ‘Cut’ a cell that’s used in the formulas of other cells, you would have to 
remove formulas before cutting, and add them back after pasting. This is unnecessary when
the click and drag method.

For information about moving objects from one place to another using the Copy, Cut, and Pa
commands, see “Using the Clipboard”, later in this chapter.

Locking an Object’s Position

You can lock an object’s position to prevent it from being moved or resized accidentally. To loc
object’s position, select the object, then choose Object... from the Settings menu. The Object Set-
tings dialog box appears.



 

Manipulating Objects 8-9

 .
 .

 .

 

s 

ject 

ed 
t be 
ked are 

king 

       
.

Click the ‘Position’ checkbox under the Lock heading. Click ‘OK’ to dismiss the Object Setting
dialog box.

As a shortcut to using the Object command to lock an object’s position, you can select the ob
and click the lock button on the Command palette.

If you attempt to reposition or resize a locked object by dragging with the Pointer tool, Inform
Designer will change the pointer to a lock. This indicates that the object is locked and canno
dragged. When you use commands that reposition or resize objects, any objects that are loc
not affected.

For information about the other settings available on the Object Settings dialog box, see “Loc
an Object’s Settings” in Chapter 7, and “Objects and Printing” later in this chapter.

Resizing Objects
A selected object can be resized by using any of the following three methods:

■   Pointer tool

■   Resize command

■   Specs palette

This section describes how to resize objects using all three of these methods.

Resizing Objects

Locks objects Unlocks objects
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Resizing with the Pointer Tool

You resize a selected object by clicking and dragging any of its handles with the Pointer tool.
you drag, Informed Designer draws a gray outline of the object, which shrinks and expands w
the movement of the mouse to indicate the object’s changing size. If you pause briefly after cl
a handle, Informed Designer will hide the pointer as you drag.

Resizing Lines
You resize a line by selecting it, then clicking and dragging one of its end point handles.

If you hold down the Shift key while resizing a line, the line will be constrained along the vert
horizontal, or diagonal (45°) directions, depending on the position of the mouse as dragging oc

Resizing Boxes, Ovals, Arcs, and Polygons
You resize boxes, ovals, arcs, and polygons by clicking and dragging any corner handle of th
object.

If you hold down the Shift key while dragging, resizing is constrained along the horizontal, ver
or diagonal axes depending on the movement of the mouse. Resizing horizontally or vertical
scales the object in that direction only. If you hold down the Shift key while resizing diagonally
new object is scaled equally in both directions, resulting in a new size that’s proportional to th
original. As you drag while holding down the Shift key, the information box displays the curre
scaling percentage.

Click and drag...

...release

Click...
drag...

...release
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When resizing a polygon with the Pointer tool, Informed Designer scales the object in the sa
way as described above. More specifically, Informed Designer resizes the smallest possible 
gle that completely encloses the selected polygon. You can resize a polygon in any direction,
you hold down the Shift key, the operation is constrained to the horizontal or vertical axis, or 
portionally. To reposition individual vertices of a polygon, use the Reshape Polygon comman
the Arrange menu. For more information see “Reshaping a Polygon” in Chapter 6.

Resizing Text
You resize text objects the same way that you resize boxes, ovals, rectangles, and polygons
clicking and dragging a handle.
 

When you resize a text object, Informed Designer automatically reformats the type inside the 
to fit the object’s new size.

If you resize a text object too small, Informed Designer will automatically extend its bottom e
so that all text in the object is visible. Likewise, if you make a text object too long, Informed 
Designer will snap its bottom edge up to the last line of text.

Resizing Fields and Tables
When you resize a field or table using the Pointer tool, Informed Designer adjusts the size of
object while preserving the spacing of the title sections. An example is shown on the next pa
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When you drag the edge of a field or table, any title sections move as well. If you hold down 
Control (Windows) or Command (Mac OS) key while dragging the edge of a title section, the
of that section changes. You can also change the size of a title section by clicking and dragg
section’s dividing line with the Pointer tool. 

Holding down the Shift key while resizing a field or table constrains the motion of the resize o
tion to the vertical, horizontal, or diagonal axes, depending on the motion of the mouse. Scal
diagonally results in an object that is resized proportionally to the original. As you hold down 
Shift key and drag, the Information box displays the current scaling percentage. For more inf
tion on resizing parts of fields and tables, please see “The Field Tool” and “The Table Tool” in
Chapter 6.

Resizing Multiple Objects
Often you will want to resize more than one object by the same amount. For example, you m
want to change the height of three adjacent fields. Informed Designer allows you to select m
than one object, and then resize them all with one motion. Simply select each object, then re
one of them to the desired size. All selected objects will be resized by the same amount.

Click and drag

Resizing a field or table with the Pointer tool...

...doesn’t change the spacing of the title sections
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As multiple objects are resized, Informed Designer will constrain the new size to ensure that
object doesn’t become too small or too large.

Resizing with the Resize Command

The Resize command resizes one or more selected objects. 

You resize an object in one of three ways:

■   explicitly (by specifying the object’s new dimensions)

■   by percentage (by specifying a percentage to enlarge or reduce)

■   by example (by clicking another object of the desired size)

■   to its original size (available for imported graphic objects)

To resize an object, first select it and then choose Resize... from the Arrange menu. The Resize 
Objects dialog box appears.

The width and height of the selected object can be resized independently. Do this by clicking
of the ‘Resize width’ or ‘Resize height’ checkboxes.

If you select the ‘By value’ radio button, you can specify the new width or height of the select
object by typing values in the text boxes. For example, you might enter a value of 5 inches fo
height and 3 inches for the width of a selected object. The unit of measurement corresponds
current ruler setting. However, you can enter the value in any units you like; Informed Design
does the conversion for you.

The spacing of the title section remains the same...

...and all selected objects are resized equally.

Select the objects, then click and drag to resize.
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Similarly, if you select the ‘By percentage’ option, the selected object is resized to a percenta
ative to its current size. For example, you might want to scale an object to half its present size
ply enter ‘50’ into each text box. Click ‘OK’ to perform the resize.

The resize ‘By example’ option allows you to change the size of an object to the size of a diff
object on your template. To use this method, follow the instructions below.

1. Select the object that you want to resize.

2. Choose Resize... from the Arrange menu, select the ‘By example’ option, then click ‘OK.’

3. With the pointing hand, click the object that’s the correct size. The size of the selected obje
change to match the size of the object you click.

The resize ‘To original size’ option is available only if you’ve selected at least one object that c
sponds to an imported graphic such as a Mac OS picture. This option resizes the object to it
nal pasted or imported size. (You can also double-click the object with the Pointer tool to resiz
its original size.

When using the Resize command, Informed Designer won’t allow you to reduce the size of a
object below its minimum size (for example, setting the width of a box to zero inches), or enl
an object larger than the size of the drawing area. If you try, Informed Designer will alert you
an error message and cancel the Resize command.

Resizing with the Specs Palette

The Specs (specifications) palette is a drawing aid that helps you resize and reposition objec
your template. Use the specs palette to position or resize an object if you know its exact dim
sions.

Current pointer position

Specifications of the currently
selected object
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The Specs palette displays coordinate information pertaining to the pointer and any currently
selected objects. Like the Tool palette, the Specs palette can be displayed, hidden, or dragg
not resized. When visible, the Specs palette always displays the pointer’s current position, un
the pointer is over the Specs palette or outside of the drawing window.

When the Specs palette is displayed, the units of measurement correspond to those currentl
the ruler.

Using the Specs Palette

To use the Specs palette, first display it by choosing Specs from the Show submenu under Layout
When the Specs palette is visible, a checkmark appears next to the Specs item in the Show 
menu. To hide the Specs palette, choose Specs again or click its close box.

You can resize an object by changing any of the parameters displayed in the text boxes on th
palette.

To change an object’s parameters, type a new value in the appropriate text box, then press T
the Enter (Windows) or Return (Mac OS) key. The new value will be applied to the selected ob
Pressing Tab or Enter/Return moves to the next text box. Pressing Shift-Tab moves to the pr
text box, and pressing Enter on the numeric keypad leaves the Specs palette.

When you alter any of the Top, Left, Bottom, or Right parameters, the object’s corresponding
always reflects the change. If you change the Height or Width parameters, the change alway
affects the bottom or right edge. For example, if the width of a table is five inches, and you ty
into the Width text box on the Specs palette, the right edge of the table will be extended by o
inch.

If more than one object is selected, the Specs palette shows only the values that are commo
objects. This means that a text box will be blank if its value is different for each of the selecte
objects. For example, if two objects of the same width are selected, the specs palette will sh
corresponding width. However, only if their edges are aligned exactly will values appear in the
left, right and bottom text boxes.

The figures below show the Specs palette and three selected objects. Since the dimensions a
tions of each object are different, all text boxes in the first figure show blank values. When a 
of ‘2.0’ is entered in the ‘Left’ text box, the left edge of each selected object is moved to the 2
mark on the horizontal ruler.

Click and type here
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As with all other resizing operations, you can’t enter values that would reduce the size of an 
below its minimum, or enlarge an object so that it lies off the drawing area. If you try to enter
value that is too large or too small, Informed Designer will warn you (with a beep) and leave 
original value unchanged.

Duplicating Objects
Often you’ll want to create new objects that are similar, if not identical, to other objects on yo
template. Rather than redrawing an object by hand, you can use the Duplicate and Replicate
mands to create one or more duplicates of an existing object.

Duplicating Objects

When you type on the Specs palette...

...the change is applied to all selected objects.
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Duplicate

The Duplicate command duplicates one or more selected objects. It’s useful for making a sin
copy of an object.

To duplicate an object, first select it and then choose Duplicate from the Arrange menu. For each 
selected object, Informed Designer places a copy directly to the right of the original. The orig
object is deselected and the new object is selected.

If you hold down the Alt (Windows) or Option (Mac OS) key while choosing the Duplicate com
mand, the duplicate object will be placed directly below the original. If you reposition a duplic
object and immediately duplicate it again, Informed Designer uses the distance between the
and the original as the offset for the next copy.

As a shortcut to choosing the Duplicate command, you can select an object and click either 
‘Duplicate horizontal’ or ‘Duplicate vertical’ buttons on the Command palette.

Replicate

The Replicate command duplicates one or more selected objects an arbitrary number of time
licated objects are created at evenly spaced intervals that you can set.

To replicate an object, first select it and then choose Replicate... from the Arrange menu. The Rep
licate dialog box appears.

Duplicate horizontal Duplicate vertical
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Use the ‘Number of duplicates’ text box to specify the number of copies that you want to mak
then enter the horizontal and vertical offsets in the ‘Offset by’ text boxes. These values indica
distance between each subsequent duplicate.

You can enter negative offsets as well. A negative offset causes a new object to be placed in
opposite direction of a positive offset. This means that positive horizontal and vertical offsets
place a duplicate object below and to the right of the original, whereas corresponding negativ
sets will place a duplicate above and to the left instead.

After you enter the appropriate values, click ‘OK.’ To cancel the Replicate command, click ‘C
cel’ instead.

Duplicating Cells

When you duplicate cells on a template (either field cells or table cells), you should be aware
following situations and how Informed Designer handles each one.

If you duplicate a cell, the new cell can’t have the same name as the original (all cell names m
unique). Informed Designer will adjust the new cell name to ensure that it’s unique.

Each newly duplicated cell receives the next available tab position. For example, if there are 
cells on your template with tab positions 1 through 15, and two of those cells are duplicated,
two new cells will have tab positions 16 and 17.

If you’re duplicating a cell that has a calculation, check, or tab formula, and that formula refe
cells that are also being duplicated (remember their names will change), then when you perfo
duplication, the formula will be adjusted so that all cell references refer to the duplicate cells r
than the originals.

For example, suppose that your template has two cells, cell1 and cell2, and that the value of
takes the value of cell1 (cell2 = cell1). If you duplicate the two cells together, then you’ll get c
and cell4 where the value of cell4 is calculated as the value of cell3 and not the value of cell1
= cell3).
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Aligning Objects
You can align objects on your template to each other, to the drawing, or along the lines of the
ing grid by using the Align command.

To align a set of objects, first select them and then choose Align... from the Arrange menu. The 
Align Objects dialog box appears.

Aligning Objects to Each Other

To align a set of objects to each other, click the ‘To each other’ radio button. Choose the axes
which the alignment will occur by clicking the ‘Align horizontal’ and ‘Align vertical’ checkboxes
You can align objects along one or both axes. 

If you check the ‘Align horizontal’ checkbox, then the alignment will take place along the hori
tal axis—that is, in the left-to-right direction. Click the ‘Left’ radio button to align the objects alo
the left side of the leftmost selected object. Click the ‘Right’ radio button to align the objects a
the right side of the rightmost selected object. If you click the ‘Center’ radio button, the objec
centers will be aligned along a path that lies roughly halfway between the leftmost and rightm
selected objects.

Aligning Objects
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Similarly, you can click the ‘Align vertical’ checkbox to perform the alignment along the vertic
axis. The ‘Top’ radio button aligns the objects along the top edge of the topmost selected obj
The ‘Bottom’ radio button aligns the objects along the bottom edge of the lowest selected ob
The ‘Center’ radio button aligns the objects’ centers along a path that lies roughly halfway bet
the uppermost and lowest selected objects.

As a shortcut to using the Align command, you can quickly align a set of objects by clicking t
alignment buttons on the Command palette. Clicking the ‘Align horizontal’ button aligns the 
objects along the left edge of the leftmost selected object. Clicking the ‘Align vertical’ button a
the objects along the top edge of the topmost selected object.

Aligning an Object to the Drawing Area

The align ‘To each other’ option is available if you’ve selected more than one object to align. 
only a single object selected, the ‘To each other’ option changes to ‘To drawing.’ Use this opt
align an object to the edge or center of the drawing area. Click the ‘Align Horizontal’ or ‘Align 
tical’ checkbox (or both) to choose which direction to align in. Then choose the edge or cente
align to by clicking the appropriate radio button (Left/Center/Right, or Top/Center/Bottom).

Moving Objects on Your Template

When aligning objects to each other, you can optionally move the selected objects to a spec
position on the drawing area by checking the ‘Move to’ checkbox and entering the desired co
nates. Enter the coordinates in any units that you like; Informed Designer performs the appro
unit conversion for you.

Informed Designer combines the ‘Move to’ coordinates with the options that you’ve selected i
‘Align horizontal’ and ‘Align vertical’ sections of the Align Objects dialog box. For example, if y
click the ‘Left’ radio button and enter ‘2.5’ in the ‘Move to’ horizontal text box, Informed Design
will align the left edge of the selected objects with the 2.5 inch mark on the horizontal ruler. If

Align horizontal Align vertical
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click the ‘Center’ radio button and enter the same coordinate, Informed Designer will try to al
the center of the selected objects with the 2.5 inch mark on the horizontal ruler. 

Aligning Objects to the Grid

To align a set of objects along the drawing grid, select the ‘To grid’ radio button. The upper le
ner of all selected objects will ‘snap’ to the nearest grid lines, whichever are active.

You can also align and move objects by dragging them with the Pointer tool. For more inform
see “Repositioning Objects” earlier in this chapter.

Distributing Objects
Often you’ll need to evenly space a set of objects across an area of your template. You might 
arating related fields of information, or you might be redistributing a set of newly replicated 
objects. Rather than tediously placing each object by hand, Informed Designer provides a si
and efficient way to do this. 

The Distribute command evenly distributes a set of selected objects along an arbitrary path. 
path is determined by you and may be specified in one of two ways: visually (with the help o
mouse), or by a specified value. 

To distribute a set of objects, first select them and then choose Distribute... from the Arrange 
menu. The Distribute Objects dialog box appears.

Distributing Objects

Note While editing a table, you can use the Distribute command to evenly distribute the table’s c
umns. For more information, see “Distributing Columns” in Chapter 6.
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Distributing Objects Visually

When you distribute a set of objects visually, you align them along a path that’s drawn with th
Pointer tool.

To distribute a set of objects visually, select the ‘Visually’ radio button and click ‘OK’ to contin
You’ll see the drawing window again with the selected objects in distribute mode. The selected 
objects will assume an initial distribution path where they are offset (in both directions) from e
other by a fixed amount. The line of distribution depends on the initial placement of the selec
objects. All objects remain selected, but on the upper-left corners of the topmost and lowest o
you’ll see a circular handle. 

Using the mouse, click and drag either of the circular handles. While you drag, an outline of 
selected objects appears, indicating the position of the objects as the mouse is moved. Whe
achieve the desired distribution, release the mouse button. The objects remain selected and
distributed along their new path.

If you hold down the Shift key while adjusting the path, the resulting path will be constrained t
horizontal, vertical, or diagonal (45°) axes.

While the objects are in distribute mode, you can move or resize the objects normally using t
Pointer tool. The selected objects will remain in distribute mode until they’re deselected.

Select the objects and choose
the Distribute command.

After you click ‘OK’, the
selected objects assume
an initial distribution.

Click and drag a
circular handle toDrag

When you release the mouse, the
objects assume their final position.

distribute.
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Distribute by Value

If you know exactly how far apart you want to distribute a set of selected objects, use the ‘By v
option. If you check this option, you can specify the vertical and horizontal offsets with which
distribute the objects. Select either of the ‘Horizontal’ or ‘Vertical’ checkboxes (or both) and ty
the desired values into the associated text boxes.

When performing the distribution, Informed Designer will separate all objects along their upp
left corners by the given offsets. Positive vertical and horizontal offsets place each subseque
object down and to the right. The same negative offsets place each object above and to the l

As a shortcut to choosing the Distribute command, you can quickly distribute a set of selecte
objects by clicking the ‘Distribute’ icon on the Command palette.

Rotating Objects
Use the Rotate command to rotate one or more selected objects. Objects can be rotated 360
in 90 degree increments.

All object types can be rotated with the exception of fields and tables. If you select a field or a
or if a set of selected objects contains a field or a table, the Rotate command will be unavaila

To rotate an object, first select it then, choose Rotate from the Arrange menu. The selected object 
rotated 90 degrees.

The Rotate command is useful for placing vertical text on your template. To rotate a text obje
select it with the Pointer tool, then choose Rotate from the Arrange menu.

A rotated text object can be edited in the usual manner. When you click the object with the T
tool, Informed Designer will rotate the text upright (back to zero degrees), and allow you to ed
text. When you press Enter on the numeric keypad, or deselect the object, it will return to its r
orientation.

Rotating Objects

Distribute objects
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Grouping and Ungrouping Objects
There may be times when you want the ability to treat a set of objects as a single object. For
ple, suppose that you’ve drawn a logo on your template, and the logo consists of a collection
individual lines, rectangles, and text objects. Grouping these objects together allows you to tre
logo as if it were a single object. Informed Designer gives you this ability with the Group and
Ungroup commands.

Grouping Objects

The Group command forms a single object that’s composed of a set of selected objects.

To group a set of objects, first select them and then choose Group from the Arrange menu. Informed
Designer surrounds the objects with handles at each corner of the group’s smallest enclosin
angle.

Since a grouped set of objects is treated as a single object, it’s manipulated accordingly. This
that you can perform any operation on a grouped object (such as selecting, moving, or resizin
can be performed on an individual object.

All commands to manipulate a group, with the exception of resizing and rotating, function ex
as though the objects in the group were selected individually. For example, changing the fon
selected group will set the font for all text, field, and table objects in the group.

When you resize a grouped object, Informed Designer ensures that the size and relative spa
the individual objects that make up the group remain unchanged. This is unlike resizing mult
selected objects where each object is resized by the same amount and the position of each 
doesn’t change. The figure below illustrates how a grouped and ungrouped set of objects are
resized.

Grouping and Ungrouping Objects

Note If a group contains a locked object, then the group itself behaves as if it were locked. For m
information about locking objects, see “Locking an Object’s Position” earlier in this chapter
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When you rotate a grouped object, rather than rotating each object in the group about its cen
(without moving its position), the group as a single object is rotated about its center.

To manipulate a single object within a group, first ungroup the group (see next section), chan
object, then regroup the objects.

Ungrouping Objects

The Ungroup command separates a grouped object into the individual objects that comprise
Ungroup is the opposite of the Group command.

To ungroup a grouped object, first select it and then choose Ungroup from the Arrange menu. All 
objects that comprised the group will be individually selected.

The Ungroup command is useful when you need to work with a single object within a groupe
object. For example, you might want to edit a text object that’s part of a grouped object. Use 
Ungroup command to ungroup the object. After editing the text, use the Group command to 
regroup the objects.

Resizing four selected objects

Resizing a grouped object

Rotating three selected objects

Rotating a grouped object
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Moving Objects Through the Drawing Plane
Each object on your template resides in its own layer on the drawing plane. This means that
objects have a relative front to back ordering—or stacking order—on your drawing. 

Often while editing a template, you might need to change an object’s stacking order. For exa
some objects might be partially obscured by others or you might want to bring an object to the
of a drawing so you can edit it. With the object layering commands (Bring Forward, Bring To F
Send Backward, and Send To Back), Informed Designer gives you the ability to easily manip
an object’s front-to-back ordering.

Bring Forward

The Bring Forward command moves one or more selected objects closer to the front of the dr
plane.

To move an object closer in the drawing plane, first select it and then choose Bring Forward from 
the Arrange menu. The selected object is moved in front of the object immediately above it. T
object remains selected.

If you apply the Bring Forward command to a set of objects, then each object in the set is mo
front of the object that lies immediately above it. However, the relative stacking order of the 
selected objects doesn’t change.

As a shortcut to choosing the Bring Forward command, you can click the ‘Bring Forward’ but
on the Command palette.

Moving Objects Through the Drawing Plane

Bring Forward
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Bring To Front

The Bring To Front command moves an object directly to the front of the drawing.

To bring an object to the front of the drawing, first select it and then choose Bring To Front from the 
Arrange menu.

If two or more objects are selected, they are moved as a group to the front of the drawing. Th
ative stacking order is not changed.

Send Backward

The Send Backward command moves one or more selected objects farther back in the draw
plane.

To move an object backward in the drawing plane, first select it and then choose Send Backward 
from the Arrange menu. The selected object is moved behind the object immediately below i
object remains selected. 

If you apply the Send Backward command to a set of objects, each object in the set is moved 
the object that lies immediately below it. The relative front-to-back order of the selected objec
left unchanged.

As a shortcut to choosing the Send Backward command, you can click the ‘Send Backward’ b
on the Command palette.

Send Backward
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Send To Back

The Send To Back command moves one or more selected objects to the back of the drawing

To send an object to the back of the drawing, first select it and then choose Send To Back from the 
Arrange menu.

If you select two or more objects, they’re moved to the back of the drawing as a group. Their
tive stacking order, however, is always preserved.

Nudging Objects
As in all drawing, it’s important to position objects accurately on your template. Although the 
mouse is often accurate enough, there are times when you might like greater precision over 
placement combined with greater ease of manipulation. 

With the Arrow keys, Informed Designer allows you to move and resize objects precisely with
using the mouse. Use the Arrow keys whenever you’re doing detailed work or whenever you 
maximum control over object sizing and placement.

Nudging an Object’s Position

To nudge an object, first select it and then press the appropriate Arrow key (up, down, left, or
arrow). You can nudge more than one object at a time by first selecting all objects and then pr
the key.

When you nudge an object, you move it by a distance of 1 pixel at the current view of the dra
window. If the current view is set to 100%, this means that each time you nudge an object, it
tion changes by a distance of 1/72nd of an inch (because most monitors have a resolution o
dots—or pixels—per inch). Similarly, if the current view is set to 200%, nudging an object mov
1/144th of an inch. At the largest possible view (1600%), nudging an object repositions it by 
tance of 1/1152nd of an inch.

Nudging Objects
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Nudging an Object’s Size

You can also nudge the size of an object. First select the object and then press the desired A
key (up, down, left, or right arrow) while holding down the Shift key. Instead of moving the ob
the object’s bottom or right edge will resize one pixel in the corresponding direction.

You can resize more than one object at a time by first selecting all objects and then pressing
Arrow key while holding down the Shift key.

As with all resizing commands, you can’t nudge the size of an object below its minimum size
larger than its maximum size.

Objects and Printing
In Chapter 11, you’ll learn about printing templates and Informed Designer’s print options. W
the Informed Filler user prints a completed form, options are provided to hide the template o
data. The template refers to the graphical objects such as lines, boxes, and text labels. The for
data refers to the information that’s entered in each cell to complete the form. For information
about Informed Designer’s print options, see Chapter 11, “Printing Forms”.

By using the Object command, you can set additional print options for any object. You can ch
to hide an object so that it doesn’t print. This is useful if you want an object to appear on the s
but not on the printed template. For example, you might want to label the different parts of yo
template to help the person who fills it out.

Alternately, you can choose to always print an object, even if the Informed Filler user prints a
with its layout hidden. This option is useful when using preprinted forms. For example, you m
want a graphical object—such as your company logo—to print in addition to the form’s data.

To change the print options of an object, choose Object... from the Settings menu. The Object Se
tings dialog box appears.

Click either of the ‘Always print’ or ‘Never print’ checkboxes. You can’t use both options at the
same time. After making your selection, click ‘OK.’ To cancel the Object command, click ‘Can
instead.

Objects and Printing



8-30 Manipulating Objects

 .
 .

 .

king 

per-

 com-
tents of 

 con-
s 

y 
x or 

l also 
.

For information about the other settings available on the Object Settings dialog box, see “Loc
an Object’s Settings” in Chapter 7, and “Locking an Object’s Position” earlier in this chapter.

Using the Clipboard
The Clipboard is a temporary holding place for graphics and text. Commonly, you’ll use it to 
form one of these functions:

■   move objects from one area of a template to another

■   move objects from one page of a template to another

■   move objects from one template to another

■   to transfer artwork and text from other applications into Informed Designer

■   to transfer artwork created with Informed Designer into other applications

You can use three commands to transfer objects to or from the Clipboard. The Cut and Copy
mands place the selected objects onto the Clipboard. The Paste command transfers the con
the Clipboard onto your template. These commands are described below.

If you are running Informed Designer on a Mac OS compatible computer, you can display the
tents of the Clipboard by choosing Show Clipboard from the Edit menu. Informed Designer show
the Clipboard content in a window.

Like any Mac OS window, you can position the Clipboard window anywhere on your screen b
clicking and dragging its title bar. You can hide the Clipboard by clicking the window’s close bo
by choosing the Close command while the window is active.

Moving Objects Onto the Clipboard

Use the Cut or Copy commands to move objects onto the Clipboard.

To move an object onto the Clipboard, select it and choose either Cut or Copy from the Edit menu. 
Your selection will be transferred to the Clipboard. If you choose Cut, the selected objects wil
be removed from your template.

Using the Clipboard
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The Copy command is more commonly used to transfer objects to the Clipboard. When you w
remove an object from your drawing, use the Clear command instead. See “Clearing Objects

Pasting Objects From the Clipboard

To paste the contents of the Clipboard onto your drawing, choose the Paste command from the 
Edit menu. A copy of the Clipboard’s contents will be positioned at the center of the drawing 
dow.

If you hold the Alt (Windows) or Option (Mac OS) key down while choosing the Paste comma
Informed Designer will place the objects at their original positions (that is, the position they w
when you cut or copied them). This feature is useful for copying objects from one page of a t
plate to another. After copying an object on one page, pasting it on another page while holdin
down the Alt/Option key will ensure that it’s positioned at the same location as the original.

Pasting Informed Objects
When pasting objects created with Informed Designer, you should be aware of the following 
tions and how Informed Designer handles each one:

■   If the Clipboard contains Informed objects that are larger than the drawing area, Informed
Designer won’t paste those objects onto your template. Instead, you’ll be alerted with a w
ing message. If you click ‘OK’ on the message dialog box, the paste operation will contin
but only those objects that fit entirely on the drawing area will be pasted. If you click ‘Can
the paste command will be cancelled.

■   To prevent duplicate cell names from occurring on your template, cells on the Clipboard a
renamed (if necessary) before they’re pasted. The naming conventions used to name the
cells are the same as those used for duplicating or replicating existing cells. Likewise, a n
pasted cell receives the next available tab position (see “Duplicating Cells” earlier in this 
ter). If a cell being pasted contains a formula that references a nonexistent cell (a cell wh
was not copied from the original template), Informed Designer will alert you with a messa

When you click ‘OK’, Informed Designer will clear the invalid formula before pasting the cell.
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Pasting Graphic Objects
A graphic object is treated as a single object and is pasted in the usual manner. However, if th
board contains a graphic object that’s larger than the drawing area (in either direction), you’ll
warning.

 
If you click ‘OK’, the large graphic object will be reduced proportionally and pasted onto your 
plate. If you click the ‘Cancel’ button, the paste operation will be canceled.

Pasting Text
You can paste text in two different ways: as a new text object, and as text inserted into an ex
text object.

If you’re not editing a text object when you choose the Paste command, the text on the Clipb
will be pasted as a new object, and centered on the drawing window. If the text is pasted whi
are editing a text object, the text on the Clipboard will be inserted at the current insertion poin
the selected text object.

Using Drag and Drop
“Using the Clipboard” earlier in this chapter, explains how you can use various commands an
Clipboard to transfer material between different templates and different applications. If you’re
using a Mac OS compatible computer with System 7.5 or later installed, the “drag and drop” 
method provides an even easier way to do this.

As its name implies, the drag and drop feature consists of selecting an item, “dragging” it wit
mouse, and “dropping” it at another place.

Although this section only describes the manipulation of objects from one template to anothe
can also use drag and drop to perform other tasks such as:

■   moving files from other applications onto your template

■   moving material created with Informed Designer to other places

For a detailed description of using drag and drop for these tasks, see Chapter 9, “Using Grap

Using Drag and Drop
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To use drag and drop to copy objects from one template to another, the drawing windows for
templates should be visible on your screen. Select the object that you want to copy from the
template, then drag it onto the drawing window of the second template. When a highlighted b
appears around the edge of the second template’s drawing area, release the mouse button. 
selected object remains at it’s original location, and a copy is placed at the current mouse po
on the second template.

Click and drag the
original object.

Release the mouse button
when a highlighted border
appears around the window.

A copy of the object is
placed in the second location.

First template Second template
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9Using Graphics
Although Informed Designer provides you with a comprehensive set of drawing tools, you mi
want to read in or import artwork originally created with another application. To support the in
gration of different applications, various standard formats for storing graphical information ha
evolved. Informed Designer supports Windows Bitmap (.BMP), Windows MetaFile (.WMF), M
intosh PICT (.PCT), and Encapsulated PostScript (.EPS). Informed Designer also allows you
import text files.

Windows Metafile (.WMF) is not supported on the Mac OS.

In addition to the Import features, Informed Designer also supports the publish and subscribe
tures that are available on Mac OS compatible computers.

This chapter describes the import, publish and subscribe, and drag and drop features of Info
Designer.

The Import Command
The most common method of importing artwork from another application into Informed Desig
is to use the Import command. You can import any artwork, as long as its format is of a type 
ported by Informed Designer (either through built-in support or through an Informed plug-in).

To import artwork or text, choose Import... from the File menu. If your computer uses Windows
you’ll see the standard Open dialog box.

The dialog displays the names of all available files. The ‘List file of type’ drop-down list allows 
to select particular types of files displayed in the dialog box.

The Import Command
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To select a file to import, click it in the ‘File Name’ scrolling list, then click ‘OK.’ Informed 
Designer reads the graphics or text from the file, creates a new object to hold it, and centers
object in the drawing window.

If you’re using a Mac OS compatible computer, you’ll see the Import dialog box.

The Import dialog box displays the names of all files that are stored in the supported graphic
formats. The ‘Graphic Type’ drop-down list allows you to select the types of graphic files displ
in the dialog box. Select the file that you want to import and click ‘Import,’ or simply double-cl
the file’s name. Informed Designer reads the graphics or text from the file, creates a new obj
hold it, and centers that object in the drawing window.

Once imported, you can manipulate the object (resize, reposition, and so on) just as any othe
created with Informed Designer. See Chapter 8, “Manipulating Objects” for more information

As a shortcut to using the Import command, you can drag a file from another place and drop
the drawing window. Providing the file contains text or graphics in one of the supported forma
Informed Designer will read the file and place the text or image at specified location.
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In addition to importing files of text or graphics, on computers using Mac OS version 7.5 or la
you can also drag objects from one drawing window to another, or from a drawing window to a
For more information, see “Using Drag and Drop” later in this chapter.

Errors When Importing

If the size of the graphic you’re importing is larger than the current drawing area in either direc
Informed Designer will warn you with the following message dialog:

If you click ‘OK’ to continue, the graphic will be imported, reduced proportionally in size, and c
tered in the drawing window. To cancel the Import command, click ‘Cancel’ instead.

Informed Designer reads the file and
places the image at the specified location.

Drag a file onto the
drawing window.
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If you are importing a text file that contains more text than will fit on the drawing area, Inform
Designer will warn you with this dialog:

If you click ‘OK,’ the text will be imported, but some text may be lost. To cancel the Import co
mand, click ‘Cancel’ instead.

Importing Scanned Forms

Instead of redrawing an existing paper form from scratch, Informed Designer allows you to im
the form’s scanned image. When you scan your form, make sure that you save the image in 
the graphic formats supported by Informed Designer. You can then use the Import command
described in the previous section to import the scanned image and place it on the drawing are
the Field and Table tools to draw cells on top of the blanks on the form.

Although scanning technology has evolved considerably over the past few years, there are s
drawbacks in using the actual scanned image of a form. For example, the readability of sma
sizes is often inadequate making it hard to read text on the screen.

Printing a scanned form also deserves careful consideration. If you print a completed templat
its scanned layout onto blank paper, you’ll find that a scanned image can be unclear, even o
dpi laser printers.

A scanned image is most useful as a tracing aid. After you import a scanned image, you can
Informed Designer’s drawing tools to accurately place the graphics and text on your template

Using Drag and Drop
If you’re using a Mac OS compatible computer with System 7.5 or later installed, the “drag a
drop” method provides a convenient way to transfer graphics and text between Informed Des
and another location. For example, you can move objects between one template and anothe
between templates and files, or between templates and other applications.

Using Drag and Drop
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As its name implies, the drag and drop feature consists of selecting an object, “dragging” it wi
mouse, and “dropping” it at another place. When you drag and drop a text or graphic object, y
basically performing the same operation as copying and pasting using the Clipboard.

When you drag an object from a template to another location, Informed Designer makes the 
rial available in both the Informed format and a format appropriate to the type of object being
dragged. For example, if you drag a table, Informed Designer makes the object available as 
Informed and as a PICT. The template or application that you are dragging to uses the most 
priate format. If you drag and drop between templates, the Informed format is always used.

To drag and drop a graphic or text object between templates, or from a template to a differen
cation, both windows should be visible on your screen. Select the object on your template, th
drag it with the mouse onto the window of the other template or application. When a highligh
border appears inside the second window, release the mouse button. The selected object rem
your template, and a copy is placed in the second location.

You can also use drag and drop to transfer text or graphic objects between your template an
For example, you can drag an object from your template to another folder on your hard drive
you can drag a file from the desktop to your template. When you drag graphics or text from y
template to the desktop, the Mac OS creates either a “picture clipping” or “text clipping” and 
plays a corresponding icon when you release the mouse button.

As mentioned previously, Informed makes the material available in the appropriate formats—
PICT and Informed, or text and Informed (or sometimes all three). The file can then be dragg
another template or another application.

Click and drag the
original object.

Release the mouse button
when a highlighted border
appears around the window.

A copy of the object is
placed in the second location.

First template Second template
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Publish and Subscribe
If you’re running Informed Designer on a Mac OS compatible computer using System 7 or la
you can automate the process of updating artwork in one or more documents. By using the p
and subscribe features, Informed Designer can automatically update artwork on your templa
whenever the original changes.

Publishing and subscribing to information is a two step process. First you select the material
you want to make available in other documents—called a publisher—and publish it. The material is 
saved in a file called an edition. You then open a document and indicate where you want the ma
rial to be placed. The placed material is called a subscriber. You can subscribe to the material as 
many times as you like. Once you’ve subscribed to the material, each subscriber will automa
update when the original changes.

Like Informed Designer, applications that offer this capability have commands like ‘Create Pu
lisher’ and ‘Subscribe to’ in the Publishing submenu under Edit.

With Informed Designer, automatic updating is most often used for company logos and artwo
that’s common to several forms. When you change the original logo or artwork, the changes 
automatically reflected in each of the forms. You can use Informed Designer—or any other dr
program that offers publish and subscribe capabilities—to draw and publish the logo or artwo
Then using Informed Designer, you can subscribe to the material and position it appropriatel

Publish and Subscribe

Original artwork

Form template

Edition file
documents
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any form template. The commands that you use to publish and subscribe are described in th
lowing sections.

Creating a Publisher

In order to make text and graphics in an Informed document available for automatic updating
other documents and applications, you have to create a publisher using Informed Designer. W
document containing the original material open, select the objects that you want to publish, t
choose Create Publisher... from the Publishing submenu under Edit. The dialog box for publis
ing appears.

The Publishing dialog box shows you a preview of the material that you’re publishing. Type a 
for the new edition, specify where to store it, then click the ‘Publish’ button. The selected obje
become a publisher and the edition file is saved.

A publisher is identified by a light gray, highlighted border that encloses the published object
the drawing window, you can show and hide these borders by choosing Show Borders and Hide 
Borders from the Publishing submenu under Edit. You can select, move, and resize a publishe
any other object. If a publisher only partially encloses an object, the object will appear cut off 
the edition is subscribed to.

Note When you publish objects using Informed Designer, a pictorial—or PICT—version of the 
material is stored in the edition file. The cells of field and table objects are ignored.
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Once you’ve created a publisher, you can subscribe to the material in other documents and o
applications. By default, whenever you save a document, any changes made to a publisher o
objects it encloses are updated in the edition file. Subsequently, the next time you open a do
containing a subscriber of that edition, the subscriber is automatically updated. Publisher an
scriber options allow you to turn the automatic updating feature off.

Publisher Options

Publishers have certain options that you can control such as automatic or manual updating o
tion files. To view or change a publisher’s options, select the publisher, then choose Publisher 
Options... from the Publishing submenu under Edit. (This command changes to Subscriber 
Options... when you select a subscriber.)

The ‘Publisher to’ drop-down list shows the name and location of the edition file. Other contro
you cancel the publisher or change when the edition file is updated.

Although automatic updating is an important convenience that publish and subscribe offers, 
may want to turn this feature off occasionally. For example, suppose that you’re about to mak
eral changes to your company logo (which has been published and subscribed to in several 
ments). Since you’ll be saving the logo document periodically during the revision process, yo
might want to turn off automatic updating until the final change is made.

To turn automatic updating off, click the ‘Manually’ option on the publisher options dialog box
With this option selected, the edition file is updated only by clicking the ‘Send Edition Now’ bu

If the publisher cuts off the logo... ...the subscriber will be cut off too.
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ton. With the ‘On Save’ option selected instead, the edition file is updated each time you save
document.

If you want to permanently cancel a publisher, click ‘Cancel Publisher.’ Canceling a publisher
removes the associated edition file. You can also cancel a publisher by clearing the publisher
the drawing window (select the publisher then choose Clear from the Edit menu or press the Delete
key).

Creating a Subscriber

Once you’ve created an edition by publishing material, you can place it on any document at a
position and at any size. With the document that you want to place the material on open, cho 
Subscribe To... from the Publishing submenu under Edit. The dialog box for subscribing appe

The dialog box shows a scrolling list of files and folders with the last edition file that you crea
selected. A preview of the edition is shown on the left. Select the edition that you’d like to subs
to, then click ‘Subscribe.’ A subscriber is created and the material in the edition is placed on 
template.

A subscriber is identified by a dark gray, highlighted border around its frame. In the drawing 
dow, you can show and hide these borders by choosing Show Borders and Hide Borders from the 

Note Informed Filler DOES NOT automatically update subscribers, even if automatic updating is
turned on. Only Informed Designer offers automatic updating.



 

Using Graphics 9-11

 .
 .

 .

 

er by 
 you 
cate, 
t 

he 
to-

  

 Nor-
. 
for-
read-
at the 

n the 
g that 

ange 
ing the 

  

.”

w ver-
en the 
.

Publishing submenu under Edit. Like any object on your template, you can select a subscrib
clicking it with the Pointer tool. You can change the size and position of a subscriber the way
normally do. You can also use commands that manipulate objects—such as Duplicate, Repli
and Align—to change the position, size, and orientation of a subscriber. For information abou
manipulating objects, please see Chapter 8, “Manipulating Objects.”

Once you’ve created a subscriber, Informed Designer will automatically update it whenever t
material in the edition file changes. Publisher and subscriber options allow you to turn the au
matic updating feature off.

Subscriber Types

Different applications publish material using different standard formats for text and graphics.
mally, if the material consists of graphics and text (or graphics only), the PICT format is used
(PICT is the standard format for Macintosh graphics.) The TEXT format is used for textual in
mation. Some programs publish material in both PICT and TEXT formats. For example, a sp
sheet might publish a picture of a color graph in PICT format along with the numerical data th
graph is based on in TEXT format.

When you create a subscriber, Informed Designer determines which formats are contained i
selected edition file. If both PICT and TEXT formats are available, a dialog appears requestin
you select which format you’d like to subscribe to.

Unlike pictures, textual subscribers have their own font, size, and style information. You can ch
these attributes by selecting the subscriber with the Pointer tool and choosing a different sett
way you normally do. This is often referred to as adorning the subscriber. For information about 
the characteristics of text, please see “The Appearance of Text” in Chapter 6, “Drawing Tools

The effect of changing an attribute of text is not lost when the subscriber is updated with a ne
sion of the edition. For example, if you subscribe to some text and change its style to bold, wh
subscriber is later updated, the new text will remain bold.

Select the subscriber... ...then choose a style.
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Subscriber Options

Like publishers, subscribers have various options that you can control. To view or change a s
scriber’s options, select the subscriber, then choose Subscriber Options from the Publishing sub-
menu under Edit.

With automatic updating on, a subscriber is updated whenever the material in the edition file
changes. You can turn automatic updating off by selecting the ‘Manually’ option. With this opt
selected, a subscriber is updated only by clicking the ‘Get Edition Now’ button. If you want to o
the document that contains the original material, click the ‘Open Publisher’ button. Your Mac 
compatible computer will run the application that was used to create the original material and
the appropriate document.

If you want to cancel a subscriber permanently, click the ‘Cancel Subscriber’ button. Cancelin
subscriber detaches the artwork (a PICT object) from the associated edition file. The remain
object acts as though it was originally copied and pasted from the original document.
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10Spell Checking
This chapter describes how to check spelling on form templates with Informed Designer. You
ensure the accuracy of text objects and the title sections of fields and tables by checking for s
mistakes on either the entire template or on particular selections of text.

Informed Designer relies on the spell checking services available via Informed spell checking
ins. Because Informed was developed with an “open” architecture, Shana can easily support
spell checking services by developing new plug-ins. For spell checking to be available, you m
have the Spelling plug-in installed in your plug-ins folder. You must also have the spelling dic
naries installed.

Informed Designer comes with a built-in spell checker and the spell checking plug-in needed 
it. These items are automatically installed when you install Informed Designer. For installatio
instructions, see your Informed Designer Getting Started Guide.

Spelling Preferences
By setting Informed Designer’s spelling preferences, you can specify certain criteria used wh
spell checking is performed. 

To set Informed Designer’s spelling preferences, choose Preferences... from the Edit menu, then 
click the Spelling icon in the scrolling list. The Preferences dialog box changes to show the S
ing preferences panel.

Spelling Preferences



 

Spell Checking 10-3

 .
 .

 .

 

 sev-
 a 

u per-
 

tton. 
e dia-
the 

  

lds 
e not 
k 

  

k 

 

.

The language dictionaries that are built into Informed Designer allow you to check spelling in
eral different languages. To select a dictionary, click the ‘Language’ drop-down list and make
selection from the available choices.

By default, Informed Designer provides alternative spellings for questionable words when yo
form spell checking. If you don’t want to see alternative spellings, turn off the ‘Always provide
alternative spellings’ checkbox.

You can set various options for each of the dictionaries by clicking the ‘Language Options’ bu
The Language Options dialog box appears. Depending on which language you’ve chosen, th
log box will display different options. The following illustration shows the options available for 
English dictionary.

To set your options, click the appropriate radio buttons or checkboxes, then click ‘OK.’

Spell Checking your Template
Informed Designer allows you to check the spelling of text objects and the title sections of fie
and tables on your template. Any questionable words on your template (that is, words that ar
found in the spell checking dictionary you’ve chosen) are flagged and displayed on the Chec
Spelling dialog box.

Note The options you select on the Language Options dialog box do not take effect until you clic
the ‘OK’ button on the Spelling Preferences panel.

Spell Checking Your Template
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To spell check your template, choose Check Template... from the Spelling submenu under Edit. If
you want to check the spelling of only a particular section of your template, select the text tha
want to check, then choose the Check Selection... command instead. The Check Spelling dialog 
box appears and Informed Designer begins checking for errors.

Informed Designer begins checking the entire template, page by page, starting with the work
If no questionable words are found, the text boxes and scrolling list on the Check Spelling di
box are blank, and only the ‘Done’ button is available. Click ‘Done’ to return to the drawing w
dow.

If a questionable word is found, Informed Designer flags it and displays it in the ‘Word’ text bo
the ‘Always provide alternative spellings’ preference is turned on, Informed Designer will displ
list of possible replacement words in the ‘Suggestions’ scrolling list. Below the list of suggest
is a status line that describes the type of questionable word. Informed Designer’s spell check
detect misspelled words, double words, and other questionable occurrences. The ‘Context’ b
the bottom of the dialog displays the questionable word in context. That is, if the word is part
sentence, the full sentence is shown. If the word is a single word (such as a title), it is display
itself.
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When a questionable word is found, you can replace it with a word from the ‘Suggestions’ scr
list, you can skip the word, you can add the word to the dictionary, or you can type a different
in the ‘Word’ text box.

To replace a questionable word with one of the alternative spellings, select the alternative in 
‘Suggestions’ scrolling list, then click ‘Replace’ or simply double-click the alternative word in t
list. Informed Designer replaces the word and continues checking the template. 

You can skip a questionable word by clicking the ‘Skip’ button. Clicking ‘Skip’ passes over the
word during the current spell check. The next time you spell check the template (without cha
the questionable word), Informed Designer will flag and display the word again.

To add a word to the dictionary, click the ‘Add’ button. This feature can be very helpful if you u
lot of unusual words or abbreviations on your templates. For example, you might often use th
abbreviation “Qty” instead of the word “Quantity” in the title section of a cell. Normally, the wo
“Qty” would be questioned when you spell check the template. By adding the word to the dic
nary, Informed Designer accepts it as a valid word.

As mentioned previously, when a questionable word is found, Informed Designer provides a 
alternative spellings in the ‘Suggestions’ scrolling list. If the word you are looking for is not in
list, you can check the dictionary for other alternatives. For example, if the word “surreal” was
spelled as “cureal,” the scrolling list might show the following alternatives: cruel, cure-all, and
churl. Since none of these are the correct word, you can try to find other alternatives by chan
the spelling in the ‘Word’ text box and clicking the ‘Check’ button. If you change the spelling t
“sureal” and click ‘Check,’ the ‘Suggestions’ scrolling list will show the correct spelling of “sur
real” as an alternative.

Once Informed Designer has checked all pages or all selected text, and you’ve dealt with an
tionable words, the Check Spelling dialog changes to show the ‘Done’ button. Click ‘Done’ to
return to the drawing area.
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Printing Forms

       
In this chapter:

■   Printing Preferences   11-4

■   Printing Your Form Template   11-5

■   Fractional Character Widths   11-7
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This chapter describes printing with Informed Designer. You can print your form templates on
printer that works with Windows and Mac OS compatible computers.

To print your template, choose Print... from the File menu. The Print Job dialog box appears.

If you’re using an HP LaserJet (or compatible) printer, you’ll see a dialog box similar to the o
below.

If you’re using an Apple LaserWriter printer (or any printer that uses the Apple LaserWriter dr
you’ll see a dialog box similar to this:
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The above dialog box shows the ‘General’ print options available. These options vary depend
which printer you’re using. You can display the print options specific to Informed Designer by
choosing ‘Informed Designer®’ from the drop-down list.

The Informed Designer specific options are described later in this chapter.

After you select your printing options, click ‘Print’ to print your template. Informed Designer w
display the Print Progress dialog:

You can cancel printing at any time by clicking ‘Cancel.’
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Printing Preferences
By setting Informed Designer’s printing preferences, you can determine how a form will print w
it’s filled out and printed by the Informed Filler user. 

By default, both the template and the data for a form will be printed. This is useful for forms t
are printed onto blank paper. When the form is to be printed onto pre-printed paper forms, yo
set the print preference so that only the form data will print.

To set this option, choose Preferences... from the Edit menu and click the ‘Printing’ icon in the 
scrolling list. The Preferences dialog box changes to show the Printing preferences panel.

To print the data without the template, click the ‘Print data only’ checkbox.

The Printing preferences panel also contains two text boxes in which you can specify an offs
adjustment for printing. This feature allows you to adjust the position of the form on the printe
page.

When printing data onto pre-printed forms, the offset adjustment feature is useful for accurat
aligning the data with the blanks on the pre-printed form. The entire form is shifted by the dis
specified in the ‘Offset Adjustment’ text boxes. Positive values shift the form down and to the 
Negative values have the opposite effect.

The amount of offset is displayed in the currently chosen ruler units (see Chapter 5, “The Dra
Environment”). You can override this setting by typing the abbreviation for the units you’d like
enter. For example, typing ‘1.0 pt’ will enter a value of 1 point.

Printing Preferences
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Although available in Informed Designer, it’s more common that the Informed Filler user will 
adjust these settings to account for the particular characteristics of the paper and printer bein

Printing Your Form Template
When printing from design mode, you can print the grid, the guide lines, and the cells by clic
any of the corresponding checkboxes on the Print Job dialog box.

Informed Designer overlays the grid and the guide lines as they appear in the drawing windo
your screen. If you choose the ‘Print Cells’ option, the name and tab position of each cell will
appear in the fields and tables on your template.

Tiling

When a template’s drawing area is larger than the selected paper size, Informed Designer wtile 
the template onto multiple sheets of paper. For example, suppose that you’re printing a tablo
form (11" by 17") on standard US letter sheets (8.5" by 11"). Informed Designer produces fou
sheets of paper for each copy of the form that you print.

Printing Your Form Template

Tabloid drawing area 
(11” by 17”)

Four 8.5” by 11” sheets
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When you set up your form’s drawing area, Informed Designer indicates how tiling will occur
drawing gray ‘page break’ indicators on the Drawing Setup dialog box. Page break indicators
appear on the drawing window. See “Page Size” in Chapter 3 for more information.

If you select the ‘Manual tile’ print option, Informed Designer prints a single sheet containing 
area of your form that’s immediately below and to the right of the zero point. (The zero point i
position where the zero mark on the horizontal and vertical rulers intersect.) For forms templ
that are larger than the selected paper size, the manual tile option allows you to print a partic
area of the form without having to print the entire form on multiple sheets.

To use the manual tile option, position the zero point just above and to the left of the area on
form that you want to print. When you choose the Print command, click the ‘Manual Tile’ che
box on the Print Job dialog box. The following figure illustrates manual tiling.

If you printed the form above without the manual tile option, Informed Designer would print fo
sheets instead of one. For information about changing the zero point, see “Rulers” in Chapte

Crop Marks

When a commercial printer prints your form template, the size of the paper stock used is ofte
larger than the size of the form itself. To indicate where to trim a printed form, crop marks are
printed at each corner.

Drawing window

Printed page
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Informed Designer can print crop marks for you automatically. Simply click the ‘Crop marks’ 
checkbox on the Print Job dialog box.

Since crop marks appear outside the edge of a form, you must allow enough space between
drawing area and the page edge when you set up your template. Otherwise, crop marks won
For more information, see “Crop Marks” in Chapter 3, “Setting up a Form.”

Fractional Character Widths
On occasion, the inaccuracies between the resolution of your computer screen and many of
laser printers will result in inconsistent type spacing. You can correct this problem by selectin
‘Fractional character widths’ option from the General panel of the Preferences dialog box. 
Informed Designer will then adjust the spacing of text on the screen and on the printed form.
should use this option if you’re printing on a laser printer.

To turn fractional character widths on or off, choose Preferences... from the Edit menu. When the
Preferences dialog box appears, click the ‘General’ icon in the scrolling list, then select the ‘F
tional character widths’ checkbox.

Fractional Character Widths

Note When designing forms for use on both the Windows and Mac OS platforms, it is very impor
to turn on the ‘Fractional character widths’ option. This ensures that the form will display an
print properly on both platforms.

ABC Company Crop marks
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For information on the other option on this dialog box, please see “Faster Scrolling” in Chapt
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Mailing Forms

     
In this chapter:

■   Choosing Your Mail System   12-2

■   The Send Command   12-3
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12Mailing Forms
An electronic mail system provides services for sending and receiving information electronic
making it an effective tool for moving information throughout an organization. Although this c
bility is most valuable for routing completed forms for approval purposes (using Informed Fill
the occasional need to send a form template to another colleague makes e-mail a useful too
form designers as well.

In this chapter you’ll learn how to send form templates with Informed Designer. In particular, 
you’ll learn about the Mail panel of the Preferences dialog box, and how to use the Send com
in Informed Designer’s File menu. The remaining sections of this chapter assume that you’re
iar with the electronic mail system used in your organization.

In addition to mailing form templates, you can also specify suggested routes using Informed 
Designer’s Routing command. Suggested routes aid the Informed Filler user in addressing a
mailing completed forms. For more information, see Chapter 5, “Routing,” in your Informed 
Designer Forms Automation manual.

Choosing Your Mail System
Informed Designer accesses your e-mail system through an Informed mail plug-in. By using 
ins, Shana can easily support new e-mail systems by simply implementing new mail plug-ins

Using Informed Designer’s Preferences command, you can specify your preferred mail syste
doing so, you will avoid being asked to select a mail system each time you send a form temp

To specify your preferred mail system, choose Preferences... from the Edit menu and click the 
Mail icon in the scrolling list. The dialog box changes to show the Mail preferences panel.

Choosing Your Mail System
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Click the ‘Mail service’ drop-down list and make a selection from the available choices. The 
choices in the ‘Mail Service’ drop-down list correspond to the Informed mail plug-ins you hav
installed in your plug-ins folder.

For details of the specific e-mail systems supported by Informed Designer, see the on-line do
ment “DGRPLG.PDF” (Windows) or “Informed Designer Plug-ins” (Mac OS). This document 
automatically installed when you install Informed Designer and is viewed using Acrobat Read
(also included with Informed Designer).

For information about the ‘Always mail data as’ option, see Chapter 5, “Routing,” in your Informed 
Designer Forms Automation manual.

The Send Command
To mail a form template, choose Send... from the File menu. If your template is a new untitled tem
plate, or a template to which changes have been made but not saved, you’ll be warned that t
plate will be saved before continuing.

Click ‘Save’ to save the template and continue, or click ‘Cancel’ to cancel the Send command

If your plug-ins folder contains more than one mail plug-in and you have not previously spec
your preferred mail system, you’ll be asked to select a mail system to use.

Click the ‘Send using’ drop-down list and make a selection from the available choices, then c
‘OK.’

When the addressing dialog appears for your selected mail system, specify the subject, the 
in which to send the template, and one of more recipients. The addressing dialog and the me

The Send Command
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selecting recipients varies depending on which mail system you use. These details can be fo
the on-line document “DGRPLG.PDF” (Windows) or “Informed Designer Plug-ins” (Mac OS).
This document is automatically installed when you install Informed Designer and is viewed u
Acrobat Reader (also included with Informed Designer).

Below is the Send dialog box that you’ll see if you’re using the Eudora Pro mail system.

For most mail systems, the only available format under ‘Send as’ is ‘Informed template.’ Som
port additional formats. Click ‘Send’ to send the template.
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AAppendix A - Default Settings
As described in Chapter 7, “Changing an Object’s Appearance,” Informed Designer remembe
default settings for each of the drawing tools. A default setting is a setting that’s automatically
selected for new objects. For more information, see “Changing Default Settings” in Chapter 7

When you create a new template, Informed Designer automatically selects a standard set of 
settings for each drawing tool. These settings are listed in the following table.

Default Settings
Tool Attribute Default Setting

Text

Line

Rectangle

Oval

Arc

Polygon

font
font size
type style
alignment
leading
pen color

line width
pen color
line style

line width
pen color
fill color
fill pattern
line style
corners

line width
pen color
fill color
fill pattern

line width
pen color
fill color
fill pattern

line width
pen color
fill color
fill pattern

Arial (Windows), Helvetica (Mac OS)
10
plain
left
automatic
black

1/4 point
black
plain

1/4 point
black
white
solid
plain
square

1/4 point
black
white
solid

1/4 point
black
white
solid

1/4 point
black
white
solid
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Default Settings (continued)
Tool Attribute Default Setting

Field

Table

title font
title font size
title type style
title alignment horizontal
title alignment vertical
title leading
cell font
cell font size
cell type style
cell alignment horizontal
cell alignment vertical
cell leading
pen color
fill color
line width
line style
title
title position
corners
data color

title font
title font size
title type style
title alignment horizontal
title alignment vertical
title leading
cell font
cell font size
cell type style
cell alignment horizontal
cell alignment vertical
cell leading
pen color
fill color
line width
line style
title
column titles
corners
cell type
color

Arial (Windows), Helvetica (Mac OS)
10
plain
center
center
automatic
Arial (Windows), Helvetica (Mac OS)
10
plain
left
top
automatic
black
white
1/4 point
plain
on
top
square
black

Arial (Windows), Helvetica (Mac OS)
10
plain
center
center
automatic
Arial (Windows), Helvetica (Mac OS)
10
plain
left
center
automatic
black
white
1/4 point
plain
off
on
square
character (no options)
black
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BAppendix B - Entering Measurements
To use many of Informed Designer’s object manipulation commands, you’re often requested 
enter measurements for parameters such as the size or position of an object. For example, w
duplicate objects using the Replicate command, you specify the distance between each dupli
typing measurements in the ‘Offset’ text boxes on the Replicate dialog box.

Informed Designer makes it easy to enter measurements. Although measurements are displ
using your choice of ruler units, you can enter measurements in any units you like. You can a
type fractional values such as ‘1/2’ or ‘3/8.’ The remaining sections of this appendix describe 
features of Informed Designer.

Accuracy
When you draw a form template with Informed Designer, you can size and position objects w
maximum precision of 1/1152 of an inch. Measurements are displayed using four decimal pla
precision. The ‘Drawing accuracy’ setting on the Layout panel of the Preferences dialog box 
you change the maximum precision (see “Drawing Accuracy” in Chapter 5 for more informati

Whenever you enter a measurement, Informed Designer rounds the value to the closest mul
the current drawing accuracy setting. For example, if the drawing accuracy is set to 1/1152 d
(dots per inch) and you type the value 1.0010, Informed Designer will round the value to 1.00
This is because 1.0009 is the closest multiple of 1/1152.

Measurement Units
Informed Designer displays measurements using your choice of ruler units. For example, if y
set the rulers to display picas, all measurements will display in picas. You can change the rule
by selecting a different setting from the ‘Ruler units’ drop-down list on the Layout panel of the
Preferences dialog box. For more information about ruler options, please see “Rulers” in Cha

Accuracy

Measurement Units
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When you enter a measurement, you can specify the unit of measure by appending an abbr
suffix to the value you type. For example, if the current ruler unit setting is inches and you wa
enter a value in points, simply append a space and the letters ‘pt’ to the numeric value that yo
Informed Designer will automatically convert the value to inches when you press the Tab key

The complete list of unit abbreviations is shown in the following table.

Unit Abbreviations

 Fractions
Although fractional numbers are displayed in floating point form (1.5, for example), you can a
enter fractions by typing the numerator and denominator separated by the slash symbol (/). F
example, instead of typing ‘5.375’, you could also enter ‘5 3/8.’ Informed Designer will autom
cally convert the value to its decimal form when you press the Tab key.

Unit Abbreviation

inches
centimeters
picas
points

in
cm
pc
pt

Entering Fractions
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CAppendix C - Shortcuts
This section contains a list of shortcuts and convenience features. Many of these shortcuts a
tures are performed by pressing either a single key or a combination of keys. Since some of 
keys are different on Windows and Macintosh keyboards, this section is divided into two table
one for Windows shortcuts, and one for Mac OS.

Windows Shortcuts
Category Key/Feature Description

Startup

Tool palette

Pointer tool

hold down Alt key after dou-
ble-clicking application icon

Escape/reverse quote key
Alt key
Tab key

double-click tool
Shift-click object
Ctrl-click
Alt-click

Ctrl-Alt-click

click and drag any object
click, pause and drag
double-click text object
double-click line object
double-click rectangle object
double-click oval object
double-click arc object
double-click polygon object
double-click button object
double-click cell section of 
field or table
double-click title section of 
field or table
double-click title divider of 
field or table
Ctrl-drag bottom edge of field

Ctrl-drag bottom edge of table
click in gray area of table

opens a document during startup

toggles between Pointer tool and drawing tool
selects Pointer tool while pressed
selects Text tool and first selected text object or
title

deselects all objects
selects multiple objects
selects object behind
forces selection rectangle
selects objects completely enclosed
forces selection rectangle
selects intersecting objects
drags outline of object(s) with pointer
drags object detail with pointer
Type command
Paint command
Paint command
Paint command
Paint command
Paint command
Button command
Format command

Type command

Paint command

overrides ‘snap to rule lines’ (if rule lines on)
snaps height to font size (if rule lines off)
overrides ‘snap to row lines’
creates new column
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Windows Shortcuts (continued)
Category Key/Feature Description

Pointer tool

Text tool

Line tool

Rectangle 
tool

Oval tool

Arc tool

Polygon tool

Field tool

Table tool

Button tool

Ctrl-drag column divider
Ctrl-drag right edge of table

Shift-resize

double-click tool
Shift-draw
Tab key
Enter key on numeric keypad
F12 key

Alt key

double-click tool
Shift-draw

Alt key

double-click tool
Shift-draw
Alt key

double-click tool
Shift-draw
Alt key

double-click tool
Shift-draw
Alt key

double-click tool
Shift-draw

Alt key

double-click tool
Shift-draw
Alt key

double-click tool
Shift-draw
Alt key

double-click tool
Shift-draw
Alt key

moves table columns on right
extends right edge without changing width of last
column
constrains horizontally, vertically, proportion-
ally, or diagonally at 45, 135, 225, or 315 degree

default type settings for text
constrains dimensions to a square
selects first text object or title
accepts text editing
accepts text editing and adjusts object width to fit
text
selects Pointer tool while pressed

default paint settings for lines
constrains horizontally, vertically, proportion-
ally, or diagonally at 45, 135, 225, or 315 degree
selects Pointer tool while pressed

default paint settings for rectangles
constrains to a square
selects Pointer tool while pressed

default paint settings for ovals
constrains to a circle
selects Pointer tool while pressed

default paint settings for arcs
constrains to a quarter circle
selects Pointer tool while pressed

default paint settings for polygons
constrains edge horizontally, vertically, or diago-
nally at 45, 135, 225, or 315 degrees
selects Pointer tool while pressed

default field styles
constrains to a square
selects Pointer tool while pressed

default table styles
constrains to a square
selects Pointer tool while pressed

default button settings
constrains to a square
selects Pointer tool while pressed
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Windows Shortcuts (continued)

Mac OS Shortcuts

Category Key/Feature Description

Tab tool

Zoom tool

any tool

Imported pictures

Paste command

Changing pages

double-click tool
click & drag between cells
Alt key

click
Alt-click
double-click tool

click right mouse button

double-click

Alt-paste

double-click numbered 
page

Change Tab Order dialog box
changes tab order from one cell to another
selects Pointer tool while pressed

enlarge view scale
reduce view scale
actual size

pop-up menu containing commands that cor-
respond to the type of object clicked

reverts to original size

positions pasted objects at original location

Change Page dialog box

Category Key/Feature Description

Startup

Tool palette

Pointer tool

hold down Option key after 
double-clicking application icon

Escape/reverse quote key
Option key
Tab key

double-click tool
Shift-click object
Cmd-click
Option-click

Option-Cmd-click

click and drag any object
click, pause and drag
double-click text object
double-click line object
double-click rectangle object
double-click oval object
double-click arc object
double-click polygon object

opens a document during startup

toggles between Pointer tool and drawing tool
selects Pointer tool while pressed
selects Text tool and first selected text object 
or title

deselects all objects
selects multiple objects
selects object behind
forces selection rectangle
selects objects completely enclosed
forces selection rectangle
selects intersecting objects
drags outline of object(s) with pointer
drags object detail with pointer
Type command
Paint command
Paint command
Paint command
Paint command
Paint command
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Mac OS Shortcuts (continued)
Category Key/Feature Description

Pointer tool

Text tool

Line tool

Rectangle 
tool

Oval tool

Arc tool

double-click button object
double-click cell section of 
field or table
double-click title section 
of field or table
double-click title divider of 
field or table
Cmd-drag bottom edge of 
field
Cmd-drag bottom edge of 
table
click in gray area of table
Cmd-drag column divider
Cmd-drag right edge of 
table
Shift-resize

double-click tool
Shift-draw
Tab key
Enter key
Option-Enter key

Option key

double-click tool
Shift-draw

Option key

double-click tool
Shift-draw
Option key

double-click tool
Shift-draw
Option key

double-click tool
Shift-draw
Option key

Button command
Format command

Type command

Paint command

overrides ‘snap to rule lines’ feature (if rule lines on)
snaps height to font size (if rule lines off)
overrides ‘snap to row lines’ feature

creates new column
moves table columns on right
extends right edge without changing width of last 
column
constrains horizontally, vertically, proportionally, or 
diagonally at 45, 135, 225, or 315 degrees

default type settings for text
constrains dimensions to a square
selects first text object or title
accepts text editing
accepts text editing and adjusts object width to fit 
text
selects Pointer tool while pressed

default paint settings for lines
constrains horizontally, vertically, proportionally, or 
diagonally at 45, 135, 225, or 315 degrees
selects Pointer tool while pressed

default paint settings for rectangles
constrains to a square
selects Pointer tool while pressed

default paint settings for ovals
constrains to a circle
selects Pointer tool while pressed

default paint settings for arcs
constrains to a quarter circle
selects Pointer tool while pressed
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Mac OS Shortcuts (continued)
Category Key/Feature Description

Polygon tool

Field tool

Table tool

Button tool

Tab tool

Zoom tool

any tool

Imported pic-
tures

Paste command

Changing 
pages

double-click tool
Shift-draw

Option key

double-click tool
Shift-draw
Option key

double-click tool
Shift-draw
Option key

double-click tool
Shift-draw
Option key

double-click tool
click and drag between 
cells
Option key

click
Option-click
double-click tool

click mouse button while 
holding the Ctrl key

double-click

Option-paste

double-click numbered 
page

default paint settings for polygons
constrains edge horizontally, vertically, or diago-
nally at 45, 135, 225, or 315 degrees
selects Pointer tool while pressed

default field styles
constrains to a square
selects Pointer tool while pressed

default table styles
constrains to a square
selects Pointer tool while pressed

default button settings
constrains to a square
selects Pointer tool while pressed

Change Tab Order dialog box
changes tab order from one cell to another

selects Pointer tool while pressed

enlarge view scale
reduce view scale
actual size

pop-up menu containing commands that corre-
spond to the type of object clicked

reverts to original size

positions pasted objects at original location

Change Page dialog box
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